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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer
“Documentation” means information published by Avaya in varying
mediums which may include product information, operating
instructions and performance specifications that Avaya may generally
make available to users of its products and Hosted Services.
Documentation does not include marketing materials. Avaya shall not
be responsible for any modifications, additions, or deletions to the
original published version of documentation unless such
modifications, additions, or deletions were performed by Avaya. End
User agrees to indemnify and hold harmless Avaya, Avaya's agents,
servants and employees against all claims, lawsuits, demands and
judgments arising out of, or in connection with, subsequent
modifications, additions or deletions to this documentation, to the
extent made by End User.

Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.

“Hosted Service” means a hosted service subscription that You
acquire from either Avaya or an authorized Avaya Channel Partner
(as applicable) and which is described further in Hosted SAS or other
service description documentation regarding the applicable hosted
service. If You purchase a Hosted Service subscription, the foregoing
limited warranty may not apply but You may be entitled to support
services in connection with the Hosted Service as described further
in your service description documents for the applicable Hosted
Service. Contact Avaya or Avaya Channel Partner (as applicable) for
more information.

Hosted Service
THE FOLLOWING APPLIES IF YOU PURCHASE A HOSTED
SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO
UNDER THE LINK “Avaya Terms of Use for Hosted Services” OR
SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE

TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR
IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE. YOUR USE OF THE HOSTED SERVICE SHALL BE
LIMITED BY THE NUMBER AND TYPE OF LICENSES
PURCHASED UNDER YOUR CONTRACT FOR THE HOSTED
SERVICE, PROVIDED, HOWEVER, THAT FOR CERTAIN HOSTED
SERVICES IF APPLICABLE, YOU MAY HAVE THE OPPORTUNITY
TO USE FLEX LICENSES, WHICH WILL BE INVOICED
ACCORDING TO ACTUAL USAGE ABOVE THE CONTRACT
LICENSE LEVEL. CONTACT AVAYA OR AVAYA’S CHANNEL
PARTNER FOR MORE INFORMATION ABOUT THE LICENSES
FOR THE APPLICABLE HOSTED SERVICE, THE AVAILABILITY
OF ANY FLEX LICENSES (IF APPLICABLE), PRICING AND
BILLING INFORMATION, AND OTHER IMPORTANT
INFORMATION REGARDING THE HOSTED SERVICE.

Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN
AVAYA AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License. The
applicable number of licenses and units of capacity for which the
license is granted will be one (1), unless a different number of
licenses or units of capacity is specified in the documentation or other
materials available to You. “Software” means computer programs in
object code, provided by Avaya or an Avaya Channel Partner,
whether as stand-alone products, pre-installed on hardware products,
and any upgrades, updates, patches, bug fixes, or modified versions
thereto. “Designated Processor” means a single stand-alone
computing device. “Server” means a Designated Processor that
hosts a software application to be accessed by multiple users.
“Instance” means a single copy of the Software executing at a
particular time: (i) on one physical machine; or (ii) on one deployed
software virtual machine (“VM”) or similar deployment.

License type(s)
Designated System(s) License (DS). End User may install and use
each copy or an Instance of the Software only on a number of
Designated Processors up to the number indicated in the order.
Avaya may require the Designated Processor(s) to be identified in
the order by type, serial number, feature key, Instance, location or
other specific designation, or to be provided by End User to Avaya
through electronic means established by Avaya specifically for this
purpose.

Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which
Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail
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account in the name of a person or corporate function (e.g.,
webmaster or helpdesk), or a directory entry in the administrative
database utilized by the Software that permits one user to interface
with the Software. Units may be linked to a specific, identified Server
or an Instance of the Software.

Database License (DL). End User may install and use each copy or
an Instance of the Software on one Server or on multiple Servers
provided that each of the Servers on which the Software is installed
communicates with no more than one Instance of the same
database.

CPU License (CP). End User may install and use each copy or
Instance of the Software on a number of Servers up to the number
indicated in the order provided that the performance capacity of the
Server(s) does not exceed the performance capacity specified for the
Software. End User may not re-install or operate the Software on
Server(s) with a larger performance capacity without Avaya’s prior
consent and payment of an upgrade fee.

Named User License (NU). You may: (i) install and use each copy or
Instance of the Software on a single Designated Processor or Server
per authorized Named User (defined below); or (ii) install and use
each copy or Instance of the Software on a Server so long as only
authorized Named Users access and use the Software. “Named
User”, means a user or device that has been expressly authorized by
Avaya to access and use the Software. At Avaya’s sole discretion, a
“Named User” may be, without limitation, designated by name,
corporate function (e.g., webmaster or helpdesk), an e-mail or voice
mail account in the name of a person or corporate function, or a
directory entry in the administrative database utilized by the Software
that permits one user to interface with the Software.

Shrinkwrap License (SR). You may install and use the Software in
accordance with the terms and conditions of the applicable license
agreements, such as “shrinkwrap” or “clickthrough” license
accompanying or applicable to the Software (“Shrinkwrap License”).

Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.

Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Note that
each Instance of a product must be separately licensed and ordered.
For example, if the end user customer or Avaya Channel Partner
would like to install two Instances of the same type of products, then
two products of that type must be ordered.

Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may

contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.

The following applies if the H.264 (AVC) codec is distributed with the
product. THIS PRODUCT IS LICENSED UNDER THE AVC PATENT
PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG
LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.

Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY
FROM THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL
PARTNER’S HOSTING OF AVAYA PRODUCTS MUST BE
AUTHORIZED IN WRITING BY AVAYA AND IF THOSE HOSTED
PRODUCTS USE OR EMBED CERTAIN THIRD PARTY
SOFTWARE, INCLUDING BUT NOT LIMITED TO MICROSOFT
SOFTWARE OR CODECS, THE AVAYA CHANNEL PARTNER IS
REQUIRED TO INDEPENDENTLY OBTAIN ANY APPLICABLE
LICENSE AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S
EXPENSE, DIRECTLY FROM THE APPLICABLE THIRD PARTY
SUPPLIER.

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE G.729 CODEC, H.264 CODEC, OR H.265 CODEC, THE
AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES
THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY
AND ALL RELATED FEES AND/OR ROYALTIES. THE G.729
CODEC IS LICENSED BY SIPRO LAB TELECOM INC. SEE 
WWW.SIPRO.COM/CONTACT.HTML. THE H.264 (AVC) CODEC IS
LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR
THE PERSONAL USE OF A CONSUMER OR OTHER USES IN
WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I)
ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD
(“AVC VIDEO”) AND/OR (II) DECODE AVC VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED
OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS
MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.

Compliance with Laws
Customer acknowledges and agrees that it is responsible for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.
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Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.

Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.

Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.

Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).

Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.

Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.

Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, or other third parties. Users are not permitted to use such
Marks without prior written consent from Avaya or such third party
which may own the Mark. Nothing contained in this site, the
Documentation, Hosted Service(s) and product(s) should be
construed as granting, by implication, estoppel, or otherwise, any
license or right in and to the Marks without the express written
permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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https://support.avaya.com/security
https://support.avaya.com/security
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Chapter 1: Introduction

Purpose
This document contains all necessary information and prerequisites on how to use the IP Office
Contact Center User Interface for Windows application. This document also enables you to
configure and manage different areas and modules of the IP Office Contact Center User Interface
for Windows application based on your needs.

Intended audience
This document is intended for people who work with the IP Office Contact Center User Interface for
Windows application and want to learn about the features of the user interface.

Related resources

Documentation
See the following related documents at the Avaya Support website at http://support.avaya.com.

Note:

Some documents on the Avaya Support website are restricted, and might not be available to all
users.

Document title Use this document to: Audience
Overview
Avaya IP Office Contact Center
Feature Description

Understand IP Office Contact Center
features and capabilities.

All users

Avaya IP Office Contact Center
Documentation Catalog

Understand the structure of IP Office
Contact Center documentation, and
determine which document you should

All users

Table continues…
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Document title Use this document to: Audience
reference to obtain information on a
specific topic.

Planning
Avaya IP Office Contact Center
Reference Configuration

Understand IP Office Contact Center
deployment topologies, network
architecture, system capacities, product
interoperability, and functional limitations
of specific configurations.

• Sales and support
personnel

• Architects

• Implementation engineers
Deploying
Avaya IP Office Contact Center
Installation

Install IP Office Contact Center software. • Support personnel

• Implementation engineers
Avaya IP Office Contact Center
Telephony User Interface
Configuration

Configure IP Office Contact Center
telephony.

• Support personnel

• Implementation engineers

Avaya IP Office Contact Center
Contact Recorder Configuration

Configure interoperability between IP
Office Contact Center and Avaya Contact
Recorder.

• Support personnel

• Implementation engineers

Avaya IP Office Contact Center
Dialer

Configure IP Office Contact Center dialer
functionality.

• Support personnel

• Implementation engineers
Avaya IP Office Contact Center
Task Flow Editor Telephony

Configure the Task Flow Editor module for
IP Office Contact Center telephony.

• Support personnel

• Implementation engineers
Avaya IP Office Contact Center
IVR Scenarios

Configure the IVR Editor module. This
document also describes IVR editor script
options and how to configure each option.

• Support personnel

• Implementation engineers

Avaya IP Office Contact Center
Email and Chat Services

Configure email and chat services. You
must complete this configuration before
you can use email and IM functionality on
the IP Office Contact Center user
interface.

• Support personnel

• Implementation engineers

Avaya IP Office Contact Center
Reporting

Configure the IP Office Contact Center
Reporting module.

• Support personnel

• Implementation engineers
Administering
Using Avaya IP Office Contact
Center Web Administration
Portal Quick Start

Use the web-based administration portal
to set up and administer IP Office Contact
Center.

• Support personnel

• Administrators

Avaya IP Office Contact Center
Task Tag Reference

Understand task tags and their meanings. • Support personnel

• Implementation engineers
Avaya IP Office Contact Center
Statistics Counter Reference

Understand the statistics counters. • Support personnel

• Implementation engineers

Table continues…
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Document title Use this document to: Audience
Administering Avaya IP Office
Contact Center Configuration
Module

Perform administration tasks on the
Configuration module. With the
Configuration module, you can update
information for agents, teams,
announcements, voice units, customers,
destinations, and devices in the IP Office
Contact Center interface. You can also
assign privileges to agents and agent
groups.

Note:

This document is also available as a
help system through the product
interface.

Administrators

Administering Avaya IP Office
Contact Center Dialer

Administer and use the Dialer module in
the IP Office Contact Center interface.

Note:

This document is also available as a
help system through the product
interface.

Administrators

Administering Avaya IP Office
Contact Center Task Flow Editor

Create and edit task flow editor scripts.

Note:

This document is also available as a
help system through the product
interface.

Administrators

Administering Avaya IP Office
Contact Center IVR Editor

Create and edit IVR editor scripts.

Note:

This document is also available as a
help system through the product
interface.

Administrators

Administering Avaya IP Office
Contact Center Text Blocks

Create, edit, and administer text blocks for
the IP Office Contact Center email
feature.

Note:

This document is also available as a
help system through the product
interface.

Administrators

Administering Avaya IP Office
Contact Center Address Book

Administer address books in the IP Office
Contact Center interface. The address
book feature simplifies agent tasks such
as making calls and sending emails.

Administrators

Table continues…
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Document title Use this document to: Audience
Note:

This document is also available as a
help system through the product
interface.

Supporting
Avaya IP Office Contact Center
Maintenance

Perform maintenance and upgrade tasks. • Support personnel

• Implementation engineers

• Administrators
Avaya IP Office Contact Center
Error Reference

Understand error codes and their
meanings.

• Support personnel

• Implementation engineers

• Administrators
Using
Using Avaya IP Office Contact
Center for Windows

Use the IP Office Contact Center User
Interface for Windows.

Note:

This document is also available as a
help system through the product
interface.

All interface users, including
agents, supervisors, and
administrators.

Using Avaya Agent for Chrome
on IP Office Contact Center

Use the Avaya Agent for Chrome – IP
Office Contact Center User Interface.

Agents and supervisors.

Using Avaya IP Office Contact
Center Wallboard

Use Wallboard functionality. All interface users, including
agents, supervisors, and
administrators.

Related links
Finding documents on the Avaya Support website on page 17

Finding documents on the Avaya Support website
About this task
Use this procedure to find product documentation on the Avaya Support website.

Procedure
1. Use a browser to navigate to the Avaya Support website at http://support.avaya.com/.

2. At the top of the screen, enter your username and password and click Login.

3. Click Documents.

4. In the Enter Your Product Here search box, type the product name and then select the
product from the drop-down list.

5. If there is more than one release, select the appropriate release number from the Choose
Release drop-down list.

Related resources
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6. Use the Content Type filter on the left to select the type of document you are looking for, or
click Select All to see a list of all available documents.

For example, if you are looking for user guides, select User Guides in the Content Type
filter. Only documents in the selected category will appear in the list of documents.

7. Click Enter.

Related links
Documentation on page 14

Training
You can access training courses and credentials at http://www.avaya-learning.com. To search for a
course, after logging in to the website, enter the course code or the course title in the Search field
and press Enter or click >.

The following table lists key IP Office Contact Center courses and certification credentials.

Course code Course title
ASPS-5001 ASPS — IP Office Contact Center credential
AIPS-4000 AIPS — IP Office credential
ACSS-3000 ACSS — SME Communications credential
8S00010E Knowledge Access: ASPS - IP Office Contact Center
5001 IP Office Contact Center Implementation and Maintenance Test
0S00100E Knowledge Access: IP Office Contact Center Administration
0S00100E_INTRO Knowledge Access: IP Office Contact Center — Administration — Introductory

Session
0S00100E_LAB Knowledge Access: IP Office Contact Center — Administration — Practise Lab

Workshop
8S00010V Fast Track: IP Office Contact Center Virtual Instructor Led

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot Avaya
products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Introduction
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Procedure
• To find videos on the Avaya Support website, go to http://support.avaya.com and perform one

of the following actions:

- In Search, type Avaya Mentor Videos to see a list of the available videos.

- In Search, type the product name. On the Search Results page, select Video in the
Content Type column on the left.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and
perform one of the following actions:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click the name of a topic to see the available list of videos posted
on the website.

Note:

Videos are not available for all products.

Support
Go to the Avaya Support website at http://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Related links
Using the Avaya InSite Knowledge Base on page 19

Using the Avaya InSite Knowledge Base
The Avaya InSite Knowledge Base is a Web-based search engine that provides:

• Up-to-date troubleshooting procedures and technical tips

• Information about service packs

• Access to customer and technical documentation

• Information about training and certification programs

• Links to other pertinent information

If you are an authorized Avaya Partner or a current Avaya customer with a support contract, you can
access the Knowledge Base at no extra cost. You must have a login account and a valid Sold-To
number.

Support
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Use the Avaya InSite Knowledge Base to look up potential solutions to problems.

1. Go to http://www.avaya.com/support.
2. Log on to the Avaya website with a valid Avaya User ID and password.

The Support page appears.
3. Enter the product in The InSite Knowledge Base text box.
4. Click the red arrow to obtain the Search Results.
5. Select relevant articles.

Related links
Support on page 19

Introduction
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Chapter 2: IP Office Contact Center User
Interface for Windows overview

You can configure the IP Office Contact Center User Interface for Windows application display
based on the requirements of your work. You can customize the display by arranging available
elements on the interface enabling you to access necessary functions quickly.

Supervisors configure access to applications for agents based on privileges. Supervisors and
Agents can also be granted privileges to configure functions of an application. If elements of the IP
Office Contact Center User Interface for Windows application are inactive or unavailable, you do not
have the privileges for that function.

The IP Office Contact Center User Interface for Windows application is the switchboard for all
actions in the IP Office Contact Center system. All other modules required for an IP Office Contact
Center system are integrated into this application.

The users of IP Office Contact Center User Interface for Windows application are:

• Agent: An agent works in the customer service area. The agent can make and answer both
calls and emails. They also have access to other features, such as chat if configured.

• Supervisor: A supervisor works in the supervision area. The supervisor monitors and
supervises the agents. The supervisor can customize the different real time information types
and create statistics.

• Administrator: An administrator works in the administration area. The administrator configures
various modules of the IP Office Contact Center User Interface for Windows application.

The functions of the users are as follows:

Customer service
modules

Supervisor modules Administration modules

• Home

• Telephony

• Email

• Chat

• Realtime information

• Reporting

• Agent Status Reports

• Contact Detail Reports

• Configuration

• UI config

• Task Flow Editor

• Dialer

• Error list

• Email configuration

• Textblock administration

• Address book administration
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Related links
Starting IP Office Contact Center User Interface for Windows on page 22
Agent groups and profiles on page 29
Break on page 31

Starting IP Office Contact Center User Interface for
Windows

About this task
The IP Office Contact Center User Interface for Windows application can be configured to log in
automatically with your Windows user account. If you configure single sign on, the application does
not display a login screen. You must be logged in to Windows as the corresponding user. You
cannot use a function if you do not have the necessary privilege.

Before you begin
• Get the IP Office Contact Center server configured by the system manager.
• Get the appropriate connection setting to install the IP Office Contact Center.
• Get the appropriate privileges.
• Get the user name and the password provided by the system administrator.
• Select a terminal when logging in.

Procedure
1. On the Windows menu or Windows desktop, click Start.

2. On the login screen:

a. In the Username field, enter the agent, supervisor, or administrator user name.
b. In the Password field, enter the password.
c. (Optional) If you are logging in as an agent, in the Telephone Extension field, type the

telephone extension number.

The system displays the User Interface screen.

Related links
IP Office Contact Center User Interface for Windows overview on page 21
Logging out and quitting the application on page 22

Logging out and quitting the application
About this task
You cannot log out during a call. To end your work you must log out and then quit the IP Office
Contact Center User Interface for Windows application.

IP Office Contact Center User Interface for Windows overview
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Before you begin
Log in to the application.

Procedure
1. On the status bar, click the drop down arrow .

2. Click Logout.

3. Click OK.

The system displays the login screen.

4. To quit the application, do the following:

a. On the File menu, click Exit 

b. Click OK.

Related links
Starting IP Office Contact Center User Interface for Windows on page 22

Passwords and aliases

Changing passwords
About this task
Passwords can consist of 1 to 10 alphanumeric characters.

Your password must consist of minimum 8 characters. You can use the following types of
characters in the password:

• Lower case letters
• Upper case letters
• Numbers
• Special characters

Before you begin
Ensure you have the required privileges to change passwords.

Procedure
1. On the menu bar, click File > Change password.

2. In the Change Password window, provide information in the following fields:

a. Old password

b. New password

Passwords and aliases
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c. Confirmation

3. Click OK.

Changing alias
About this task
Your alias is used for anonymous statistics.

Before you begin
Ensure you have the required privileges to change alias.

Procedure
1. On the menu bar, click File > Change alias.

2. In the Change Alias window, type your new alias.

3. Click OK.

Structure of IP Office Contact Center User Interface for
Windows

When you start IP Office Contact Center User Interface for Windows for the first time, you can see
the following elements:

• The menu bar

• The work area

• The task bar

Menu bar
You can select a component from the menu bar or press the F10 or Alt key and use the cursor to
navigate.

Name Description
File The options are:

• Change password

• Change alias

• Exit
Table continues…
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Name Description
Go to The options are:

• Home: Displays the home area.

• Telephony: Displays the telephony area.

• Realtime information: Displays the real time information area.

• Reporting: Displays the reporting area.

• Agent Status Reports: Displays the agent evaluation area.

• Contact Detail Reports: Displays the contact evaluation area.

• Error list: Displays the date time, code, and the error description.

• Configuration: Displays the standalone Configuration module.

• UI Config: Displays the UI configuration area.

• Task Flow Editor: Displays the standalone Task flow editor module

• IVR Editor: Displays the standalone IVR editor module.

• Dialer: Displays the standalone Dialer module.

• Email Configuration: Displays the Email administration module.

• Text Block Administration: Displays the Text block administration module.

• Address Book Administration: Displays the Address book configuration module.
Help The options are:

• Contents: Displays the online help content.

• Information: Displays the information of IP Office Contact Center User Interface for
Windows application.

Menu bar status information and messages
In addition to the command menus, the menu bar displays the following information:

• The time that the agent logs in.

• The time that the agent is in break.

• The status of the logged in agent for Telephony, Email, and Chat.

• The name of the logged in agent and the configured telephone extension.

• Information messages.

Status indicators of modules and agent breaks
Icon Status indicator Description

Red circle with an x No connection to the task server.

Table continues…
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Icon Status indicator Description
Gray circle with an x Not logged in.

Yellow circle Logged in but not signed in to any agent group.

Green circle Logged in but not signed in to all agent groups.

Green circle with check
mark

Logged in and signed in to all agent groups.

Gray cup Logged in and a break is prepared.

Red cup Logged in but on a break.

Depending on the agent status, you can use the following functions:

• Sign in to an agent group.
• Sign off an agent group.
• Sign in to all agent groups.
• Sign off of all agent groups.
• Log in to a task type, such as chat.
• Log out of a task type, such as email.

Information messages
The information icon  in the menu bar displays messages if you minimize the view.

Icon Name Description
Gray Specifies that you have no messages.

Flashing orange Specifies that you have unread messages.

Orange Specifies that you have messages. The system displays unread messages
in bold and read messages in default font.

If you click a message, the system marks the message as read.

Connection messages
The system displays a message when a connection to the PBX or email system is interrupted. You
can view the messages in the Error list module.

Message Description
The connection to the
telephone system is
interrupted.

Specifies that the connection to the telephone system is interrupted, for
example, when there are network problems. The message disappears
when the connection is restored.

The connection to the
email system is
interrupted.

Specifies that the connection to the email server is interrupted, for
example, when there are network problems. The message disappears
when the connection is restored.
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Real time information messages
If a real time information element exceeds the configured alarm threshold, the system displays an
information message. You can view the messages in the Realtime information module.

Message Description
Realtime information Name
Page: Page number

Specifies that a value has reached or exceeded the configured
alarm threshold.

The message disappears when the alarm status changes.

Telephony messages
When you log out of the telephony module, the system displays a message that indicates the reason
for log out. Depending on the reason, you might be prompted to log in again.

If the task server restarts, you get logged out and you must log in again. You cannot log in, for
example, if you are logged out remotely or if you are logged in to another computer. In these cases,
the system does not provide the option to log in again.

Message Description
Connection to PBX
is broken. Click
here to log in
again.

The connection to the telephone system is interrupted.

Connection to the
PBX is established
again. Click here
to log in again.

The connection to the telephone system is established.

You have been
logged out from the
telephone, another
user has logged in.

Another user is logged in.

Telephony function
"Call routing" is
active. Click on
here to deactivate
it and log in
again.

You are logged out, because call routing is set up on the telephone in use.

Telephone function
"do not disturb" is
active. Click on
the button to
deactivate it and
login again.

The do not disturb function is activated on the telephone.

Work area
The work area displays the open modules.
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Task bar
The task bar displays icons for the modules available to agents, supervisors, and administrators.

Agent task bar
Icon Name Description

Home Displays additional information for an agent.

Telephony Displays the telephony area.

Email Displays the email area.

Chat Displays the chat area.

Supervisor task bar
Icon Name Description

Realtime information Displays real time information area.

Reporting Evaluates statistical data that is counter-
based.

Agent Status Reports Evaluates agent statistical data. The
telephony or email-based data is not
evaluated.

Contact Detail Reports Evaluates contact-related statistical data for
individual contacts.

Error list Displays application messages and errors.

Administrator task bar
Icon Name Description

Configuration Configures objects in the IP Office Contact
Center system.

UI Configuration Configures elements and areas in the user
interface.

Task Flow Editor Creates call flow sets and email flow sets.

IVR Editor Creates IVR scripts.

Dialer Creates campaigns and jobs.

Email Configuration Configures the email system.

Text Block Administration Creates text blocks.

Address Book Administration Configures address books.
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Accessing help files
About this task
Use this procedure to access help files and other help systems.

Procedure
Do one of the following:

• On the menu bar, click Help > Contents.

• On the keyboard, press F1 .

Performing a search
Procedure

1. On the Help menu, click Contents.

2. In the Online help dialog box, click the Search tab.

3. Type in the key word to find the search entry, and click List Topics or press Enter.

4. To display the selected topics, in the Select Topics to display dialog box, select a topic and
click Display.

Agent groups and profiles
Agent groups
If you have the Automatic login privileges configured, the system automatically logs in to the agent
groups assigned to you. If this privilege is not set up, you must log in manually. You can create
different profiles for logging in to agent groups.

Profiles
You can use the profiles to select specific agent groups to keep from always having to select the
same agent groups. For example, you can have a profile for working during the day and another for
the night shift. You can create any number of profiles. When naming a profile, select a name that
indicates the purpose of the profile.

Agent group selection icons
Icon Name Description

Save Saves the current settings in a profile.

Delete Deletes the current profile.

Telephony Displays the agent groups to log in to the Telephony work area. You
must select the appropriate check boxes.

Table continues…
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Icon Name Description
Email Displays the agent groups to log in to the Email work area. You must

select the appropriate check boxes.
Chat Displays the agent groups to log in to the Chat work area. You must

select the appropriate check boxes.

Related links
IP Office Contact Center User Interface for Windows overview on page 21
Logging in to agent groups on page 30
Logging out of agent groups on page 30
Creating profiles on page 31
Deleting profiles on page 31

Logging in to agent groups
Procedure

1. On the status bar, click the drop down arrow  and click Select AG.

2. In the Agent group selection dialog box, do one of the following:

• To select an agent group, select the appropriate check box.
• To select multiple agent groups, drag the mouse over multiple entries.
• To select all the agent groups, in the work area, click the Telephony icon .

3. In the drop-down box, select a profile.

4. Click OK.

The system displays that you are logged in to the selected agent groups.

Related links
Agent groups and profiles on page 29

Logging out of agent groups
About this task
Agents and administrators do not have the privileges of deleting agent groups.

Procedure
1. On the status bar, click the drop down arrow  and click Select AG.

2. In the Agent group selection dialog box, do one of the following:

• Clear the check box of the appropriate agent groups.
• To clear all the agent groups, in the work area, click the Telephony icon .
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3. Click OK.

The system displays that you are logged out of the selected agent groups.

Related links
Agent groups and profiles on page 29

Creating profiles
Procedure

1. On the status bar, click the drop down arrow  and click Select AG.

2. In the Agent group selection dialog box, select the required agent groups.

3. Click Save.

4. In the Save configuration dialog box, type a name for the configuration profile and click OK.

5. Click OK.

Related links
Agent groups and profiles on page 29

Deleting profiles
Procedure

1. On the status bar, click the drop down arrow  and click Select AG.

2. In the Agent group selection dialog box, select a profile.

3. Click Delete.

4. Click OK.

Related links
Agent groups and profiles on page 29

Break
You can stop working with the IP Office Contact Center system to take a break. The system notifies
the supervisors of your break status. When you take a break, you do not receive any new calls
through call distribution.

The Active or On Break status for the Telephony or Email task types is displayed individually for
each task type in the Break window. You can start or end a break for both task types at the same
time.

Break
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You can configure a sign-off prevention quota for an agent group. The sign-off prevention quota
defines the number of agents that must remain signed on to the agent group and the number of
agents that cannot sign out or take a break.

If the sign-off prevention quota is reached, the IP Office Contact Center system denies your break.
The break function depends on the task type. For example, you can start a break for the Email task,
but not for Telephony. You receive a message to this effect and can try again later to start a break
for the Telephony task type. You can take a break after wrap-up time by clicking on the break icon
and selecting Break time.

Related links
IP Office Contact Center User Interface for Windows overview on page 21
Starting a break on page 32
Ending a break on page 32

Starting a break
About this task
You can take a break if you are in wrap-up time or later. The system activates the On Break status
immediately. If break codes are defined in the Configuration module, the system displays a list of
break codes in the Break Time dialog box. The break types are:

• Lunch
• Meeting
• New break
• Recess

Procedure
1. On the status bar, click the drop down arrow  and click Break Time.

2. In the Break Time dialog box, select the break type and click Break Time.

The system indicates that the break is started and displays a red coffee cup on the status
bar.

Related links
Break on page 31

Ending a break
Procedure

1. On the status bar, click the drop down arrow  and click Break Time.

2. In the Break Time dialog box, click Off Break Time.

The system displays that the break is over.
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Related links
Break on page 31

Break

February 2016 Using Avaya IP Office Contact Center for Windows 33
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


Part 1: Customer service
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Chapter 3: Realtime information display for
the Home and Telephony
modules

Real time information display operates in the same manner in both the Home and Telephony
modules. The descriptions and procedures in this section apply to both modules.

The Home and Telephony modules display information about the status of objects in the IP Office
Contact Center system. Some object states can be monitored in real time, while others are updated
periodically. If you have the appropriate privileges, you can edit the objects in the display.

When you have the base module privilege setting of Select own home file or Select own
telephony file, you can select a home or telephony file to display. The preconfigured file contains
real time information objects that provide system status information. When you have the higher level
privilege of Home configuration or Telephony configuration, you can configure the real time
information objects.

Home and Telephony menu bar options
Name Required privilege Description
Select home file

Select telephony file

Select own home file

Select own telephony
file

Displays the option to select a home or
telephony file.

File View Home configuration

Telephony configuration

Displays folders and files containing
configured real time information.

Inspector Home configuration

Telephony configuration

Creates and edits real time information.

Preview Home configuration

Telephony configuration

Previews the real time information
configuration.

Default View Home configuration

Telephony configuration

Displays the real time information
configured for the currently selected file.

Related links
File View on page 115
Viewer on page 118
Inspector on page 119
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Selecting real time information display
Procedure

1. On the Go to menu, select Home or Telephony.

2. Depending on the module you choose, do one of the following:

• On the menu bar, click Home > Select Home file.

• On the menu bar, click Telephony > Select Telephony file.

3. In the File Selection window, select a folder and then select a file.

4. Click Edit.

The system displays the real time information configuration in the work area.

Managing real time information folders and files
About this task
You can use this procedure to view the real time information in the File View, Preview, Inspector,
and Default views.

Procedure
1. On the Go to menu, select Home or Telephony.

2. Depending on the module you choose, do one of the following:

• On the menu bar, click Home > File View.

• On the menu bar, click Telephony > File View.

3. In the File View dialog box, in the Folder area, click a folder.

The system displays the selected folder in the Home Files or Telephony files field.

4. Click a file, and click Preview.

5. In the Preview window, click Edit.

The system displays the real time configuration in the Inspector view. For predefined files,
the Edit icon is inactive. To modify a default file, you must first create a copy of the file and
then click Edit.

6. (Optional) To view the home page, select Default View.

The system displays the real time information configuration work area for the currently
selected file.

Realtime information display for the Home and Telephony modules
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Configuring the real time information work area
Procedure

1. In the Home or Telephony module, open a real time configuration file in the Inspector view.

The system displays the Work Area pane on the right of the user interface.

2. Right-click the work area, and select Properties.

3. In the Properties window, click the General tab and do the following:

a. To edit the name of the real time configuration file, click the Name field.

The Name field can contain up to 29 alphanumeric characters.

b. To configure the Size of the work area field, type Width and Height values.

The range for Width and Height is from 160 to 3000 points.

4. Click the Settings tab, and do the following:

a. Type a name in Page name.

b. To display a grid in the work area, select the Grid check box.

c. (Optional) If you have enabled a grid, enter values for the grid Width and Height.

The range for the grid Width and Height is from 2 to 50 points and determines the
spacing of the grid. For example, if you enter a value of 2 for the grid width or the
height, a grid point is placed every 2 points.

5. Click the Presentation tab, and do the following:

a. In the Font area, configure the font display.

b. In the Line area, configure the line width and the color.

c. In the Background area, you can select a background color or choose a background
image.

6. Click OK.

7. (Optional) To add multiple pages to the work area, at the bottom of the work area, right-click
the page tab and select Add page.

If required, configure the properties for the new page.

Configuring real time information elements
Procedure

1. In the Home or Telephony module, open a real time configuration file in the Inspector view.

2. From the list of elements on the left, click and drag an element to the work area.

3. After you have positioned the element, release the mouse button.

Configuring the real time information work area
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The system displays the Properties dialog box for the elements.

4. Configure the properties for the element.

Assigning a real time information configuration to an
agent

About this task
You can assign a real time information configuration file to yourself and to other agents.

Before you begin
Get the Telephony configuration privileges.

Procedure
1. In the Go to menu bar, click UI Config.

2. In UI Configuration, click Agent.

3. In the agent list on the right, double click an agent.

4. In the UI configuration for the agent <name> window, click the Home or Telephony tab.

5. Clear the Default check box to enable file selection.

6. Click browse icon .

The system displays the File selection dialog box.

7. Select a folder and then a real time information configuration file.

8. Click Select.

The system displays the selected file in the Current Telephony file field.

Realtime information display for the Home and Telephony modules
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Chapter 4: Telephony contact bar

The Telephony module contact bar contains a contact information area and a function bar. The
contact information area displays text-based call details. The function bar contains icons that can be
clicked to execute telephony commands. If you have the appropriate privileges, you can modify the
icons displayed in the function bar.

Contact information area
The contact information area displays the following call information with one line for each call.

• Message text.
• Call direction, inbound or outbound.
• Call status. For example, dialing, busy, or on hold.
• Topic name.
• Conversation length.
• The remaining time if Wrap Up is configured.

If time is activated manually, 12:00:00 a.m. is displayed because the time is not limited. In this
case, the wrap-up time must also be closed again manually.

• The name of the customer, if known, or the telephone number.

Related links
Call Center call on page 40
Contact bar icon descriptions on page 40
Configuring the contact bar in Telephony on page 42
Assigning a contact bar configuration to an agent on page 42
Answering a call on page 43
Ending a call on page 43
Calling a subscriber on page 44
Starting a call on page 44
Redialing the last number on page 45
Making consultation calls on page 45
Toggling between calls on page 46
Starting a conference call on page 47
Transferring a call on page 47
Putting a call on hold on page 48
Requesting support on page 48
Telephone book overview on page 49
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Job code overview on page 51
Working with the Wrap Up settings on page 52
Turning on Wrap Up on page 53
Entering DTMF signals on page 53
Qualifying a call as correct on page 54
Qualifying a call as incorrect on page 54
Qualifying a call when a fax machine is reached on page 55
Quick bar and customer history on page 55

Call Center call
With the IP Office Contact Center User Interface for Windows application, you can dial a number or
answer a call. You can log in to specific agent groups automatically or manually. A subscriber calls a
topic number. The IP Office Contact Center system distributes the call to an available agent. The
system administrator determines the criteria of how to distribute the call within the IP Office Contact
Center.

Related links
Telephony contact bar on page 39

Contact bar icon descriptions
The Contact bar displays the following telephone elements:

Icon Name Description
Answer Answers the current call.

Dial Starts the dial sequence.

Hang up Ends the call or process.

Consultation Puts the current call on hold to perform a
consultation.

Hold Puts the current call on hold.

Toggle Toggles between two subscribers.

Conference Connects several subscribers in a
conference.

Transfer Transfers a connection to another subscriber.

DTMF Opens a keypad to type DTMF signals.

Table continues…
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Icon Name Description
Extend Wrap Up Extends the wrap up time for a call after the

end of the call.
End Wrap Up Ends wrap up for a conversation.

Job Code Enters a job code.

Emergency Enables the agent to request assistance from
the supervisor.

Silent Monitoring Enables the supervisor to monitor the active
conversation of an agent.

RPC Specifies that the call was successful and you
spoke with the correct party.

Closure Specifies that the call was unsuccessful as
you did not call the correct party. For
example, if you dial a wrong phone or fax
number, or the party is unavailable.

Fax Specifies that you called a fax machine. The
system disconnects the call immediately and
evaluates as a closure.

Record call Records a conversation. You must configure
a topic or an external destination for the call
recording.

Call recording pause Pauses the call recording.

Topic Selection Specifies that you can select a topic. The
topic must be configured accordingly.

Choose external destination Specifies that you can select an external
destination. The external destination must be
configured accordingly.

Delete Deletes the mapping.

Separator Displays a line to separate buttons.

You can use the following functions:

Name Description
Available elements Displays the available telephony elements.
Selected elements Displays the selected telephony elements.
Call recording on: (element: recording) Configures a topic or an external destination for the

element recording. You can also delete the mapping.
Show only authorized topics (element: Call) Displays only authorized topics for element calling.
Compressed view Displays all information about a call in a single line.

The call information lines are arranged one after the
other.

You can use the following buttons on the Contact bar:

Contact bar icon descriptions
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Name Description
Up Moves the selected element up in the list.
Add Adds the selected element to the Selected elements list from

the Available elements list.
Remove Removes the selected element from the Selected elements

list.
Down Moves the selected element down the list.

Related links
Telephony contact bar on page 39

Configuring the contact bar in Telephony
Procedure

1. On the UI configuration tab, select one of the following:

• System

• Profile

• Agent

2. In the right pane, double-click an item in the list.

3. In the UI configuration dialog box, in the Contact bar > Available elements field, select
the required elements and click Add.

The system adds the selected elements to the Selected elements field.

4. Click OK.

Related links
Telephony contact bar on page 39

Assigning a contact bar configuration to an agent
Procedure

1. On Go to menu, click UI Config.

2. On the UI Configuration tab, click Agent.

3. In the agent list on the right, double-click an agent.

4. In the UI configuration window, click the Contact bar tab.

5. Clear the Default check box.

Telephony contact bar
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6. Do one of the following:

• To add an icon to the contact bar, select the icon in the Available elements list and

then click Add.
• To remove an icon from the contact bar, select the icon in the Selected elements list and

click Remove.

7. To position the icons on the contact bar, select Up or Down.

8. To add the Record call icon to the contact bar, in the Call recording on (element:
recording) field, do the following;

a. Select a topic, in the Topic selection field.
b. Choose an external destination, in the Choose external destination field.

Related links
Telephony contact bar on page 39

Answering a call
About this task
The Answer icon on the contact bar indicates an incoming call. If you do not answer the call within
the configured time, the system automatically logs you out of all agent groups. The contact bar
displays the time in seconds when you are logged out.

Before you begin
Log in to the application.

Procedure
To answer a call, click Answer.

The system connects the call to the caller, and you can conduct your conversation.

Related links
Telephony contact bar on page 39

Ending a call
Procedure
Click Hang up.

The system disconnects the call. If configured, you are assigned Wrap Up.

Related links
Telephony contact bar on page 39

Answering a call
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Calling a subscriber
About this task
If you are dialing using a number box, you must type the number using your keyboard.

Before you begin
• Log in to the application.
• Configure the Dial function key on the contact bar.

Procedure
1. Click the Dial button.

2. In the Dial dialog box, do one of the following:

• Type a number in the Number selection box.

• Choose a number from the selection box or from the telephone book.

3. Click Dial.

The system starts the dial sequence and displays the call status as Avail.

Related links
Telephony contact bar on page 39
Using the Telephone book on page 51

Starting a call
About this task
You can mark a call as a call center-specific call and select a topic for the call. The call for the
selected topic is listed as a call-center call in the report. The counter names contain outcc.

Outgoing call center calls work only for external target subscribers. The system administrator
defines the access code dialed for the call in the Configuration module in the PBX configuration
using Access code for external OutCC.

Before you begin
Log in to the application.

Procedure
1. On the contact bar, click Dial.

2. In the Dial window, do one of the following:

• Type a number in the Number selection box.

• Select a number from the selection box or the telephone book.

Telephony contact bar
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3. To mark the call as a call center-specific call, do the following:

a. Select Outgoing ACD call.

b. Select Intern for a subscriber within the PBX or Extern for a subscriber outside the
PBX.

c. Select a topic.

4. To start the dial sequence, click Dial.

Related links
Telephony contact bar on page 39
Using the Telephone book on page 51

Redialing the last number
About this task
You can redial a number anytime.

Before you begin
Get the administrator to configure the dial function key on the contact bar.

Procedure
1. On the contact bar, click Dial.

2. In the Dial window, click the arrow of the selection box.

The system displays the last 10 numbers dialed.

3. Click the last dialed number.

4. To start the dial sequence, click Dial.

Related links
Telephony contact bar on page 39

Making consultation calls
About this task
While on a call, you can start a second call for a consultation.

Before you begin
An active call must be in progress.

Redialing the last number
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Procedure
1. During a conversation, on the contact bar, click Consultation.

The system puts the first party on hold.

2. In the Consultation window, do one of the following:

• Type a number in the Number selection box.
• Select a number from the selection box or the telephone book.

3. Click Dial.

The system establishes a two-party call with the agent.

4. When the consultation session is complete, do the following:

a. To drop one of the parties from the conference call, click Hang up next to the number
that you want to drop.

b. To retrieve the call, click Hold.

Related links
Telephony contact bar on page 39
Using the Telephone book on page 51

Toggling between calls
Before you begin
An active call must be in progress.

Procedure
1. On the contact bar, click Consultation.

2. In the Consultation window, do one of the following:

• Type a number in the Number selection box.
• Select a number from the selection box or the telephone book.

3. Click Dial.

The system establishes a two-party call with the agent.

4. To return to the original call, click Toggle on the contact bar.

The system puts the third party in the consultation call on hold.

5. To continue to toggle between calls, do one of the following:

• Click Hold in the contact bar to return to the active call on hold.
• In the contact information area, click the line item for the active call on hold.

6. To end your current call, click Hang up.

Telephony contact bar
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The system disconnects the current call and the other two parties remain connected.

Related links
Telephony contact bar on page 39
Using the Telephone book on page 51

Starting a conference call
Before you begin
An active call must be in progress.

Procedure
1. On the contact bar, click Consultation.

2. In the Consultation window, do one of the following:

• Type a number in the Number selection box.

• Select a number from the selection box or the telephone book.

The system establishes a two-party call with the agent.

3. Click Dial.

The system connects you to the subscriber that you want to engage in a conference.

4. On the contact bar, click Conference.

The system interconnects the two parties and you in a conference.

5. To withdraw from the conference, click Hang up on the contact bar.

The other two parties remain connected.

Related links
Telephony contact bar on page 39
Using the Telephone book on page 51

Transferring a call
About this task
Use this procedure to transfer a call when you are connected to a caller who wants to connect to
another extension.

Procedure
1. On the contact bar, click Consultation.

Starting a conference call
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2. In the Consultation window, do one of the following:

• Type a number in the Number selection box.

• Select a number from the selection box or the telephone book.

3. Click Dial.

In the Contact information area dialog box, the system displays whether the extension is free
or busy.

4. If the extension is free, do the following:

a. Tell the caller that you are transferring the call.

b. Click Transfer.

The system connects the two subscribers in a consultation call.

5. If the extension is busy, do one of the following:

• Transfer the call, and click Hang up.

• Return to the original caller, and tell the caller that the extension is busy, click Hold.

Related links
Telephony contact bar on page 39
Using the Telephone book on page 51

Putting a call on hold
Before you begin
Start a call.

Procedure
1. On the contact bar, click Hold.

The system turns the Hold icon to green.

2. To return to the call, click Hold again.

Related links
Telephony contact bar on page 39

Requesting support
Before you begin
Start a call.

Telephony contact bar
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About this task
An agent can request supervisor support during a call. The two types of support are:

• Silent monitoring: The supervisor joins the active call and listens to the conversation. The caller
and the agent cannot hear the supervisor.

• Active participation in the call or Emergency: The supervisor can cut into the active call and
help the agent. The caller can also hear the supervisor.

Procedure
1. On the contact bar, click Silent monitoring or Emergency.

The system displays the icon as dimmed. A signal is activated on the supervisor interface.

2. The supervisor cuts into the agents connection.

The system turns the emergency icon to green.

Related links
Telephony contact bar on page 39

Telephone book overview
You can use a Telephone book to find a subscriber in the address book and to call the subscriber.
You can use only the configured address books in the Telephone book. You can search the
Telephone book based on the following criteria:

• Last name
• First name
• Title
• Phone (business)
• City
• Company

When you enter a term in search field, the telephone list displays how many matching data records
are found. The telephone list displays maximum 250 records. If the list is more than 250 records,
you must narrow down your search. If the database is extensive, the search can take a few
seconds.

The detailed view displays the following information from the selected phone book entry when
available:

• First name
• Last name
• Title
• Gender
• Street

Telephone book overview
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• Branch
• Post code
• State
• Province
• Country
• Company
• Department
• Business phone
• Home phone
• Mobile phone
• Fax number
• Email address
• Home page

The search is not case sensitive. You can use the following placeholders for phone book searches:

Placeholde
r

Description Example Result

% Placeholder for any
characters.

%en Searches for all entries containing ‘en’.

_ Placeholder for any
character.

_ish Searches for all entries starting with any character
and then containing ‘ish’.

[character] Placeholder for a certain
character.

M[ae][iy]er Searches for all entries with Maier, Mayer, Meier,
or Meyer.

[character -

character]

Placeholder for a certain
string.

[M-Z]owell Searches for all entries starting with a letter from M
to Z and then containing ‘owell’.

* Placeholder for any
characters.

* Searches for all entries.

Related links
Telephony contact bar on page 39
Opening the phone book on page 50
Using the Telephone book on page 51

Opening the phone book
Procedure

1. In the contact bar, click Dial or Consultation.

2. In Telephone book dialog box, select a Telephone book or all address books.
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The Telephone book dialog box can be displayed in two views: the default view and the
detail view.

3. To switch from default view to detail view and back, click Details.

Related links
Telephone book overview on page 49

Using the Telephone book
Procedure

1. In the contact bar, click Dial or Consultation.

2. In the Telephone book dialog box, select a Telephone book or all address books.

3. To view more fields, click Details.

4. In the City field, type a location.

5. In the Last name field, type a name.

6. Select a subscriber entry.

If the subscriber has more than one phone numbers, then you must dial the number that you
want to call.

7. Click Dial or Apply.

The system incorporates the number in the Dial or Consultation dialog box.

Related links
Telephone book overview on page 49

Job code overview
You can configure job codes for statistical evaluation of incoming calls. A job code entry is
mandatory when configuring the IP Office Contact Center system. You can enter multiple job codes
for a call. Job codes can be helpful if a caller orders something and then requires technical support.
You can enter a job code during a call or during Wrap Up. When you enter the job code, the system
automatically relates the topic to the call. The length of the job code is defined. You cannot specify
more characters than the defined number.

If a job code entry is mandatory, an incoming call turns the contact bar Job code icon to orange and
the Wrap Up icon to green. If you disconnect a call before entering a job code, the Job code icon
remains orange. The contact information line for the call displays Job code. If a job code entry is
mandatory, you must enter a job code for each call. The system does not assign a new call to you,
until you enter a job code.

Related links
Telephony contact bar on page 39
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Entering a job code on page 52

Entering a job code
Before you begin
Configure the system for mandatory job code entry.

Procedure
1. During a call or during the wrap-up time, in the contact bar, click Job code.

2. In the Job code dialog box, click the right arrow to add the job code to the Selected list, and
do one of the following:

• From the list, click Job code.

• In the Unrestricted entry field, enter a job code.

The system displays the selected job code in the list.

3. (Optional) From the selected list, click Remove to remove the job codes or click Add to add
additional job codes.

4. To apply the job codes to the selected list, click Send.

Related links
Job code overview on page 51

Working with the Wrap Up settings
About this task
After a call ends, the system provides a configured time to do any required post call processing
tasks, such as job code entry. The period is referred to as Wrap Up. The system administrator
configures the wrap-up time

When you are in the wrap up period for a call, the contact information line for the call displays the
remaining wrap-up time. The call status is End Wrap up.

Before you begin
You must end a call and be in the Wrap Up period.

Procedure
1. On the contact bar, click Extend Wrap Up.

The system turns the contact bar Wrap Up icon to dark green and the Wrap Up time is now
unlimited. The contact information line for the call displays the Wrap Up time as 00:00:00.

2. To end the wrap up, click End Wrap Up.
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The system ends the Wrap Up and displays the icon as unavailable.

Related links
Telephony contact bar on page 39

Turning on Wrap Up
About this task
Use this procedure to turn on Wrap Up after a call ends, so that you get time for post call
processing. You can manually turn on Wrap Up.

Procedure
1. On the contact bar, click Wrap Up.

The system turns the Wrap Up icon to dark green.

2. After you complete your task, click End Wrap Up.

The system ends the Wrap Up session.

Related links
Telephony contact bar on page 39

Entering DTMF signals
About this task
Dual-tone multi-frequency dialing (DTMF) can be used for special functions. For example, you can
send DTMF signals when connected to a voice mailbox.

Before you begin
Get the DTMF configured on the contact bar.

Procedure
1. On the contact bar, click DTMF icon.

2. In the keypad window, click the buttons as required.

3. Click Close.

Related links
Telephony contact bar on page 39
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Qualifying a call as correct
About this task
The outbound dialer is the part of the IP Office Contact Center system that starts automatic
outbound calls. When working in the outbound dialer, you must qualify calls. Use this procedure
when the call is successful, and you reach the correct subscriber.

Procedure
1. On the contact bar, click the Right Party Contact qualification (RPC) icon.

The system evaluates the call as successful. The RPC window displays if the qualifications
are configured.

2. Select qualifications on the left and add them to the list on the right.

The selected values are saved as additional information tags on the CallJob tags.

Related links
Telephony contact bar on page 39

Qualifying a call as incorrect
About this task
Use this procedure when the call is unsuccessful.

Procedure
1. On the contact bar, click the Closure qualification icon .

2. In the Closure dialog box, use the available options to qualify a call.

3. To complete the qualification, click OK.

Related links
Telephony contact bar on page 39
Closure qualification field descriptions on page 54

Closure qualification field descriptions
When you qualify a call as incorrect, the following options are available:

Name Description
Reminder Specifies that the call is repeated at a later time.
Wrong number Specifies that you dialed the wrong number.

Table continues…
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Name Description
New number Specifies the field to type a new number in the Number box.
AM Specifies that you reached an answering machine (a.m.).

• If you mark a.m. and indicate a time, the system generates a new job.

• If you mark a.m. and do not indicate a time, the system closes the job.
Check box Enables the check box to limit the time during which a new call is made.
Start time Specifies the start time of a new call.
Stop time Specifies the stop time of a new call.
Today Specifies to make a new call today. The call must occur in about 1 hour.
Tomorrow Specifies to make a new call tomorrow. The call must occur in 24 hours.

Related links
Qualifying a call as incorrect on page 54

Qualifying a call when a fax machine is reached
About this task
Use this procedure when the call reaches a fax machine.

Procedure

On the contact bar, click the Qualification as fax abandoned icon .

The system ends the call immediately and evaluates the call as a fax.

Related links
Telephony contact bar on page 39

Quick bar and customer history
The quick bar is an additional display tool for the Telephony, E-mail, and Chat modules. In the E-
mail and Chat modules, the quick bar displays the customer history information element. In the
Telephony module, the quick bar can display telephony information elements in addition to the
customer history element.

The quick bar can be opened and closed using the arrow button in the top left corner. The quick bar
has two display modes:

• Mode Overlay: The quick bar content is displayed only when needed. The cursor must remain
on the arrow to keep the quick bar open. The quick bar display covers other content in the
module.
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• Mode Embedded: The quick bar remains open after the arrow is clicked. Other module content
is not displayed.

You can use the following Telephony elements in the quick bar :

• Text element

- Label

- Value element

- Longest wait time (topic) [Telephony]

- Longest wait time (topic) [Email]

- E-mail to contact

- Out of office notice

- Variable

- Tag

• Lists

- Queue [Telephony]

- Abandoned Call list

• Graphics elements

- Image

- Group

- Bar chart

- Longest wait time (topic) [Telephony]

- Longest wait time (topic) [Email]

- Queue (topics) [Telephony]

- Waiting emails ( topics) [Email] (bar chart)

- Individual status LED

- Pie chart

- Agent status (AG)

- Agent status (team)

- Phone state

• Other elements

- Customer history

- Direct call

- Internet browser

- Supervisor Emergency
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Related links
Telephony contact bar on page 39
Configuring the quick bar on page 57
Customer history on page 58

Configuring the quick bar
About this task
During installation, the system creates a quick bar file containing a customer history element.

Before you begin
You must have the appropriate privilege that a quick bar displays. The system configures the
privileges with the application configuration. To use the quick bar, you must have the following
features:

• Show quick bar: When you select this privilege, the system displays the quick bar.
• Select own quick bar: When you select this privilege, an agent can select a Telephony file for

the quick bar.
• Telephony configuration: When you select this privilege an agent can configure Telephony.

Procedure
1. On the UI Configuration tab, select one of the following:

• System

• Profile

• Agent

2. From the list of configured systems, agents, or profiles in the right pane, double-click an item
in the list.

3. In the UI configuration dialog box, click the Telephony tab and click the browse icon .

4. From the File selection window, in the Quick bar files, click a file.

5. (Optional) Right-click the quick bar and click Configure > File selection > Quick bar files .

6. Click a file.

7. Click Select.

You can use the quick bar to either display on demand or use always on top using the
overlay or embedded mode.

Related links
Quick bar and customer history on page 55
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Customer history
If you have a customer contact and data is available for the customer, then the customer history
element displays the information. The information displayed depends on the module that you are
currently working on. The customer history displays information about the current task, that is,
telephone call, email, or chat. The source of the customer history information is the task reporting
database. Therefore, the task reporting processes must be running.

The following customer history options are available:

• You can adjust the real time display.

• You can adjust the size.

• You can hide the title.

• You can customize the column arrangement.

• You can modify the properties.

• You can change the background color.

The customer history title bar displays:

• The name of the customer.

• The number of the caller.

• The email address of the sender.

The body of the customer history element displays a column for each type of customer history that is
configured. The following information is available in the task reporting database:

Name Description
Date Displays the date of the contact.
Time Displays the time of contact.
Task type Displays the task type: telephony, email, or chat .
Caller / From Displays the name of the customer, if configured.
Called address Displays the dialed number (topic or extension) or the email address

(TO).
Original topic Displays the original topic (first topic).
Last topic Displays the last topic.
Last agent Displays the last agent who handled the telephony, email, or chat

task.
External target name Displays the external target name.
External destination : address Displays the external destination.
Note Displays a note. A note appears only with a call. The note displays

the contents of CallTag CCK_Customer_Info. In a pre-defined
Table continues…
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Name Description
telephony element, the CallTag can be set by an agent. In an email,
the note is empty.

Subject Displays the subject of an email. In a call, the subject is empty.
Dialer note Displays a dialer note. The dialer note displays the contents of

calltag OD_Pers_Note. In an email, the dialer note is empty.

Address Displays the call number or email address of the contact.
Initial request Displays the initial request of a chat customer.

Related links
Quick bar and customer history on page 55
Configuring customer history on page 59
Using customer history on page 59

Configuring customer history
Procedure

1. On Go to menu, select Telephony.

2. Click Telephony and then select File view.

3. Click New quick bar file.

4. Enter a file name.

5. Click Edit.

6. In the Telephony inspector dialog box, select and drag the Customer history element into
the work area.

7. Choose a period.

The period that you select determines which contact data is displayed in the customer
history. The starting point is always from the current time. If you specify 0, then all existing
data is displayed. Using 0 can result in the display of a large amount of data and can cause
delays.

8. Choose required tabs.

9. Click OK.

Related links
Customer history on page 58

Using customer history
About this task
You use the customer history feature from a quick bar. You can also use customer history in
Telephony. You can get information, for example, the telephony or email contacts of a customer.

To view the name of a caller or sender, the name must be configured as a customer. The system
detects the name of a customer when the phone number and email address of the customer are
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configured. Even if a caller or sender has already called or sent emails before being configured as a
customer in customer history, the system still displays the customer contact.

Before you begin
You must have the following IP Office Contact Center processes:

• Taskreporting database server (TRDB_SRV.EXE)
• Taskreporting Server (TR_SRV.EXE)

Note:
For this feature to work optimally, ensure the database is regularly serviced.

Procedure
1. To sort the table by column, click on the column title.

Customer history is presorted by date. The system displays the latest data at the top.

The system displays the sorted table with an icon in the column indicating whether the table
is sorted in ascending or descending order.

2. To print customer history, right-click Customer history.

3. Click Print.

The system displays the option to select a printer and print the contents.

4. To send a new email to the customer, right-click Customer history.

The email address is included in the To field.

5. Click Create Email.

The system displays a new email in edit mode.

Related links
Customer history on page 58
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Chapter 5: Email module overview

The Email module contact bar contains menu bar and function area to read and process emails
assigned to each user and to manage breaks. Agents can log in and log out of IP Office Contact
Center or specific agent groups from the Email module user interface. You can access specific
functions in the Email module interface, depending on your user privileges.

The following table lists the functions that are available based on each user privilege:

User Privilege Available features
Agent • Log in and log out of an agent group.

• Start and end breaks.

• Accept and process emails.

• Delegate or assign emails.

• Send, forward, delete, and print emails and perform spell checks.

• Display use text blocks.

• Display use and import address books.
Supervisor • Display agent mailboxes.

• Delegate, process, and delete documents in the Overview folder.

• Delegate and delete documents in the Deleted folder.

• Import and administer dictionaries.
Generic • Display emails by status: Active, Interrupted, Held, and Completed.

• Modify email display formats: ASCII, HTML, and RTF.

• Display drafts and stored emails.

Related links
Email module screen on page 62
Opening the Email module on page 76
Using Email menu bar commands on page 76
Email privileges on page 77
Viewing documents in mailbox folders on page 90
Paging through mailbox folders on page 90
Using search filters on page 91
Activating documents on page 92
Viewing the document process and transmission status on page 93
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Creating new documents on page 93
Performing spell checks on page 94
Text blocks on page 96
Sending documents on page 97
Email reply on page 98
Forwarding documents on page 99
Picking up documents on page 101
Delegating documents on page 101
Emptying the recycle bin on page 102
Closing transactions on page 102
Creating signatures on page 102
Allocating job codes on page 103
Adding attachments on page 103
Downloading and opening attachments on page 103
Editing attachments on page 104
Setting Send options on page 104
Holding and resubmitting documents on page 105
Saving draft documents on page 106
Repeating failed transmissions on page 106
Resending documents on page 106
Printing documents on page 107
Viewing message properties on page 107

Email module screen
The following illustration displays the Emailmodule user interface and the various areas on the
screen.
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No. Name Description
1 Menu bar Displays the File, Go to, Email Client, and Help tabs.
2 Toolbar and status

bar
Displays the icons to access the Home, Telephony, Email, and Chat
functions. Also displays the logoff option.

3 Mailbox folders Displays the folders of the mailbox.
4 Document list Displays the list of emails related to the different status.
5 Action bar Displays the various actions that you can perform on the action bar.
6 Processing status

indicator
Displays the status of documents.

7 Agent status Displays the status of agents. For example, agent is logged in, or is on a
break.

8 Display and
processing area

Displays the options to format the documents.

9 Text blocks Displays text blocks that you can use to create messages with the uniform
appearance.

Related links
Email module overview on page 61
Email Client field descriptions on page 64
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Email transmission job status icon description on page 66
Email creation icon descriptions on page 66
Email text field descriptions on page 67
Email display and processing area on page 76

Email Client field descriptions
Name Description
Import Address
Book

Imports address book entries from a CSV file. The system displays this field only for
users with relevant privileges.

Create Address
Import File

Creates a template CSV file for importing addresses or distribution lists.

View The options are:

• Visible Folders: Displays the selected folders. The default folder is Inbox, and
you cannot hide the Inbox folder.

• Columns: Specifies the columns to display in the Email module.
Additional Options The options are:

• Signature: Creates a signature to include in outgoing emails.

• Options: Displays options to start the notifications and specifies a time for the
notification display.

• Show Search Filter: Displays the available search filters to search a specific
information in a mail folder.

• Empty recycle bin: Deletes all documents from the recycle bin.

Related links
Email module screen on page 62

Email document status
Email status icon description

Default
Icon

Email with an
active reply

Email with an active
forwarded message

Description

New message

Read message

Active message

Interrupted message

Table continues…
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Default
Icon

Email with an
active reply

Email with an active
forwarded message

Description

Resubmitted message

Deferred message

Delegated message

Job code missing

Outgoing message

Related links
Email module screen on page 62

Send options field descriptions
Name Description
Account Displays the account number.
Send priority Specifies the priority of the mail that you send. The

options are:

• Normal: The default setting.

• Low: The mail with the low priority icon .

• High: The mail with the high priority icon .
Acknowledgm.of.receipt (only for email) Displays a confirmation when the recipient opens the

email.
Immediately Displays the document is sent immediately.
Time Displays the document that is sent at a specified

time.

Default: Displays the current date and time.

To change the date, click the ellipsis ... , and then
select a date from the calendar.

To change the time, type the time value in the field.
Cover Specifies to select a cover sheet from the list box for

the fax

Related links
Email module screen on page 62
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Email transmission job status icon description
Icon State Description

Successful Specifies a successful transmission.

Failed Specifies that the transmission failed.

Active/being processed Specifies that the transmission is active and is
being processed.

Waiting or Tried Specifies that the transmission is being
reattempted.

Stopped Specifies that the transmission stopped.

Related links
Email module screen on page 62

Email creation icon descriptions
Icon Name Description

Bold Formats the selected text in bold.

Italic Formats the selected text in italic.

Underline Underlines the selected text.

Align Left Aligns the selected text to the left
margin.

Center Aligns the selected text to the
centre of the text area.

Align Right Aligns the selected text to the right
margin.

Justify Aligns the selected text on both
sides.

Horizontal Line Inserts a horizontal line.

Numbering Starts a numbered list.

Bullets Starts a bulleted list.

Decrease Indent Decreases the left indent.

Table continues…
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Icon Name Description
Increase Indent Increases the left indent.

Font Color Changes the font color.

Highlight Color Highlights the selected text in the
selected color.

Cut Moves the selected text to the
clipboard.

Copy Copies the selected text to the
clipboard.

Paste Pastes the text from the clipboard.

Note:

You cannot paste graphics.
Undo Cancels the last change applied to

the text.
Redo Restores the change that you

canceled using Undo.
Spell check Checks the spelling of the words

in the text.

Related links
Email module screen on page 62

Email text field descriptions
Name Description
Style Formats the text using the selected style.
Font Applies the specified font to the selected text.
Font size Applies the specified font size to the selected text.

Related links
Email module screen on page 62

Mailbox folders
Inbox folder

The system places the new incoming documents or resubmitted documents automatically in the
Inbox folder.
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You can perform actions on the documents on the Action bar or the pop-up menu.

You can perform the following actions as required:

Action No
document
selected

Preview New
document
created

Active
document:
View

Active
document:
Replying

Active
document:
Forwarding

Create — — — —

Reply — — — — —

Forward — — — — —

Delegate — — — — —

Send — — —

Exit — — — — —

Delete — — —

Job code — — — — —

Add
attachment

— — —

Transmissio
n options

— — —

Close — —

Note:

The delete action in Reply and Forward refers to an active reply or to a forwarded mail.

Related links
Email module screen on page 62

Sent folder
The Sent mailbox folder provides an overview of the latest sent mails.

Related links
Email module screen on page 62
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Drafts folder
The Drafts folder provides an overview of all newly created documents that are not yet mailed. The
folder does not display the incomplete replies and the documents for forwarding. You can access
these documents exclusively by activating the original document.

The Drafts folder indicates the number of documents in the folder by a figure in brackets on the tab.

You can access the actions with and on documents through the Action bar or a pop-up menu.

You cannot activate Drafts as the documents are not distributed through IP Office Contact Center,
but created directly by the agent. Only the agent can select and process the draft further.

When a newly created document is closed, the system discards the document if the agent did not
make any entries in the header, the body, and the send options. The system displays a message to
the agent to save the changes.

If you further process a document and then close, the system again displays a message to save the
changes.

You can perform the following actions in Drafts:

Action No document selected Document selected
Newly created —

Reply — —
Forward — —
Delegate — —
Send —

Delete —

Hold — —
Job code — —
Add attachment —

Send options —

Close —

Related links
Email module screen on page 62

Recycle bin folder
The Recycle bin mailbox folder provides an overview of all emails that are deleted.
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The system moves the document to the Recycle bin that is deleted by the supervisor, and thus
removed from distribution. The supervisor can finally delete a document in the Recycle bin folder,
or delegate the document back to a topic. You cannot delegate the document to an agent. You can
only move the document into the system by delegating the document to a topic.

Related links
Email module screen on page 62

Deferred folder
The Deferred mailbox folder provides an overview of all on-hold documents. The system stores
such documents in this folder until the configured date or time. The system then moves the
documents automatically to the Inbox folder and marks the documents with the Follow up icon.

Related links
Email module screen on page 62

Completed folder
The Completed mailbox folder provides an overview of all completed or closed documents that are
not removed from the email database. As a email agent, you can access the Completed folder. To
see completed mails in the Completed folder, the agent needs the authorization for the appropriate
topic. As the document is completed, the system assigns the document to a particular agent. The
system maintains the assigned document in the Completed folder. The agent can find the
documents only if the agent has access to the object or the document. An agent must have required
privileges for some special functions. For example, if the email is in the agent mailbox, the agent
needs authorization to view a document in the overview tab. With the relevant privileges, an agent
can also view the documents of other agents.

Transactions such as an original document and the associated replies or forwarded documents are
linked to each other by a unique transaction number. You must activate the automatic assignment of
ticket IDs for emails.

You can add the job code column, JCode, to the view.

Related links
Email module screen on page 62

Overview folder
The Overview folder displays the documents independent of the mailbox folders in which the
documents are located. The inbox folder tab displays the number of unread or new documents.

Note:

You must have the relevant privileges to use all the functions in the Overview folder.

In the Overview folder, the supervisor can intervene in the distribution of documents by delegating
documents using the Delegate button.

The supervisor can delegate or delete all documents that are not in an Active status. An agent can
pick up documents.
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The following table displays the actions that can be performed on a document depending on the
state of the document:

Action No document
selected

Preview Active
document:
View

Active
document:
Replying

Active
document:
Forwarding

Delegate — — — —

Pick up — — — —

Delete — — — —

Exit — — — — —
Close — — — —

Related links
Email module screen on page 62

Outbox folder
The Outbox folder displays all the emails that are created and send by an agent. If an email is
answered and not completed the email, the system displays the email in the Outbox folder. The
agent can configure Forward, Show send state and properties.

Related links
Email module screen on page 62

Archive folder
The Archive folder provides an overview of all completed documents that have already been moved
from the Runtime database to an external database during a store run. The archive is only available
if a transfer of completed documents to an external store database is planned and the
UMRClientAdapter is configured accordingly. In this case, all the agents can access the Archive
folder. After the transfer is complete, each document is assigned to a particular agent or topic. The
assigned documents remains intact so that you can easily find your own documents again.

The types of documents displayed can be restricted for each user with rights. You can use these
rights to specify which documents from which topics an agent can view. All documents from other
topics are not displayed to these agents. All agents can view documents, such as read
confirmations, that went directly to the agent and were then stored by the agent without being
distributed through the system. You can no longer process these documents. You can only view
these documents. No actions are possible if more than one document is selected.

Transactions such as an original document and their associated replies or forwarded documents are
linked to each other by a unique transaction number. These unique transaction numbers can be
displayed with the document. To receive unique transaction numbers, the system automatically
assigns a ticket ID for an email that must be activated in the topic configuration. If a document is
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forwarded from the mailbox folder, the system generates a new entry in the Completed folder with
the forwarded document and the transaction number. In this way, you can also retrace the forward
action later.

The displayed documents are limited with a search filter. A free text search can be performed
through the subject, the body, and the transaction number. Because the mailbox folder does not
have a view of current data, the mailbox is not automatically updated.

Related links
Email module screen on page 62

Directly addressed documents
You cannot activate documents that are addressed directly to agents rather than assigned through
Call Center. You can still process the document without activating the document. To get access to
the uncompleted replies or documents to be forwarded, you must select the original document. The
active reply or active document for forwarding is displayed in maximized form, that is, the original
document is hidden. You cannot delegate directly addressed incoming documents. The original
document remains selected after a reply is sent or a document forwarded. The system does not
save a complete or exited document in the Completed folder.

Related links
Email module screen on page 62

New outgoing documents
When you close new outgoing emails, these emails are stored in the Drafts folder. The Drafts folder
only displays outgoing documents that are not sent. You cannot activate new documents. You must
select the documents saved in the Drafts folder for further processing.

Related links
Email module screen on page 62

Mailbox folder icon descriptions
The following table lists the mailbox folders and columns available for each folder type. A number in
parentheses after the name of the folder indicates the number of unread documents in that folder.

The columns marked with an asterisk (*) are not the default columns. You can display these
columns if necessary. The following mailbox folders are available for documents, including emails or
text messages.

Icon Mailbox folder name Description
Inbox Contains all incoming documents.

Status image, Attachment, Status text, Service, Sender,
Topic, Subject, Received, To*, Cc*, Created*, Sender
address* <> Inbox (symbol), attachment, status (text),
service, from, topic, subject, received, to*, cc*, created*,
from address*, priority*

Sent Contains all documents.

Table continues…
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Icon Mailbox folder name Description
Status image*, Attachment, Status text*, Sender, Topic,
Subject, To, Cc*, Created, Sender address* <> Sent
columns are actually: attachment, from, topic, subject,
to, created, state (symbol)*, state (text)*, cc*, from
address*, priority*

Drafts Contains draft documents that you have not sent yet.

Status image, Attachment, Status text, Sender, Subject,
To, Cc*, Bcc*, Created, Sender address*

Recycle bin Contains documents that you deleted.

Status image, Attachment*, Status text*, Sender, Topic,
Subject, Received, To*, Cc*, Created*, Sender address*
<> Recycle bin columns are actually: state (symbol),
attachment, from, topic, subject, received, state (text)*,
to*, cc*, created*, from address*

Deferred Contains documents that will automatically be
resubmitted to the Inbox at the specified date and time.

This folder only appears if you have the Place emails on
hold privilege.

Status image*, Follow up time, Attachment,
Resubmission time, Status text*, Sender, From, Topic,
Subject, To*, Cc*, Created*, Sender address* <>
Deferred columns are actually: attachment, follow up
time, from, topic, subject, state (symbol)*, state (text)*,
to*, cc*, created*, from address*, priority

Completed Contains all completed documents that remain in the
UMR database.

Status image, Ticket id, Attachment*, Status text*,
Sender, Topic, Subject, Job code, Received, Mailbox,
To*, Cc*, Created*, Sender address* <> Completed
columns are actually: State (symbol), ticket id, from,
topic, subject, job code, received, mailbox, attachment*,
state (text)*, to*, cc*, created*, from address*, priority*

Overview Contains all documents categorized by topics.

Status image, Attachment, Status text, Service, Sender,
Topic, Subject, Received, Mailbox, To*, Cc*, Created*,
Sender address*

Outbox Displays all sent documents.

Attachment, Sender, Status image*, Priority*, Status
text*, Sender address*, CC*, Topic, To, Subject,
Created, Mailbox

Table continues…

Email module screen

February 2016 Using Avaya IP Office Contact Center for Windows 73
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


Icon Mailbox folder name Description
Archive Provides an overview of all completed documents that

have already been moved from the Runtime database to
an external database during an archiving run.

Status image, Transaction number, Attachment*, Status
text*, Sender, Topic, Subject, Received, Mailbox, To*,
Cc*, Created*, Sender address*

Related links
Email module screen on page 62

Processing status of documents in the mailbox folder
You can see the processing status of the document on the left of each document on the Action bar
window. The system displays the area with a slightly darker background. When a new document is
created, this indicator is empty at the start. The following table lists the processing status available
for each document:

Name Description
Multiselection Displays the multiple documents that you selected.
Create mail Displays a newly composed, outgoing email.
Reply mail Displays a reply to a Call Center email.
Forward mail Displays a Call Center email for forwarding.
Mail sent Displays an email that has already been sent.
Enter job code Specifies that you must enter a job code before the email is closed.
Reply not CC mail Displays a written reply to an email that was not assigned to you by

Call Center.
Forward not CC mail Displays an email to forward that was not assigned to you by Call

Center.
Not CC mail Displays a non-Call Center email.
Preview Displays an email or task that is not activated. Therefore only

available for a preview.
Document does not exist Displays a system error:

The selected document is unavailable.
Replied Specifies whether an email is replied to or not.
Forwarded Specifies whether an email is forwarded or not.

Related links
Email module screen on page 62

Action bar button descriptions
You can perform various actions on the action bar, including email. The order in which the buttons
are displayed varies for individual actions. The following table lists all the buttons available in Action
bar:
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Icon Name Description
New Creates a new document.

Send Sends the document. This button is always the first
button on the left of Action bar.

Reply Replies to the sender of a document.

Reply all Replies to all senders of a document.

Delete Deletes a document.

Save Saves the document.

If you are writing a new email, the email is saved in
Drafts.

Defer Puts the document on hold.

Forward Forwards the document.

Retry Sends the document again after a failed
transmission.

Resend Sends another copy of the document.

Delegate Delegates or assigns the document, and adds a note
to the document.

Pick Picks up the document.

Complete Completes the processing of a transaction. The
stored document is closed and moved to the
Completed folder.

Job code Allocates a job code.

Mandatory Job code Indicates that a job code is required.

Add attachment Adds an attachment to the document.

Send options Configures send options.

Stop Stops the transmission job.

Note Adds a note.

You can add a note when delegating a document or
putting it on hold for resubmission. The Note icon
appears in the document list and in the mail header
of a document. To read the note, click the icon in the
mail header.

Print Prints the document.

Maximize Maximizes the work area.

Restore Reduces the work area.

Table continues…
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Icon Name Description
Close Closes the document.

If you make changes to the document, the following
message is displayed: Document was changed.

Related links
Email module screen on page 62

Email display and processing area
To process documents, you can use the email display area and processing area located below the
Action bar. If you are replying to an email, the following areas are displayed:

• Email display area

• Processing area: For example, the reply to an email that you are in the process of writing.

Related links
Email module screen on page 62

Opening the Email module
Procedure

On the task bar, click the Email module icon .

The system displays the Email module screen.

Related links
Email module overview on page 61

Using Email menu bar commands
Procedure
In the menu bar, do one of the following:

• Click Menu and select a Command.

• Press F10 or the Alt key, and use the cursor to navigate to the command you want.

Related links
Email module overview on page 61
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Email privileges
Privileges are used to control the applications that an agent can use and the actions that the agent
can execute within the applications. Depending on your privileges, the system displays relevant
icons in the Administration task bar. System administrators set up privileges in the Configuration
module.

The email privileges are:
• Email Administrator
• Keyword-based email routing
• Textblock administrator
• Email Supervisor
• Using textblocks
• Agent queue view
• Deleting emails
• Email Archive
• Defering emails
• Printing emails
• Automatic log in
• Replying as agent

Related links
Email module overview on page 61

Customizing mailbox folders

Configuring visible folders
About this task
You cannot hide the Inbox folder.

Before you begin
Select the folders to display.

Procedure
1. Click E-Mail Client > View > Visible Folders.

2. In the Visible Folders dialog box, do one of the following:

• Use the >> and << buttons to configure the visible folders.
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• You can use the Up and Down arrow buttons to modify the sequence of the Selected
folders displayed.

3. Click OK.

Related links
Email module overview on page 61

Displaying extended state text
About this task
For the Inbox, Deferred, and Overview folders, you can configure the extended display text. You
can also configure whether to display the following information:

• No answer sent
• No forwarding sent

The settings are saved as personal settings when the agent logs off.

Before you begin
Specify the columns to display for each folder.

Procedure
1. Click E-Mail Client > View > Columns.

The system displays the Inbox-Columns dialog box, with two lists:

• Available columns: Displays all the columns that are available for the relevant mailbox
folder.

• Selected columns: Displays all the selected columns for the relevant mailbox folder.

2. Click the Show extended state text check box according to your needs.

3. Click OK.

Related links
Email module overview on page 61

Selecting columns
Procedure

1. Click E-Mail Client > View > Columns.

The system displays the Inbox-Columns dialog box, with two lists:

• Available columns: Displays all the columns that are available for the relevant mailbox
folder.

• Selected columns: Displays all the selected columns for the relevant mailbox folder.
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2. To move a column from one list to the other, select the column and then click on the relevant
arrow.

3. In the Selected columns list, you can use the Up and Down arrow buttons to modify the
sequence of the displayed columns.

4. Click OK.

Related links
Email module overview on page 61

Sorting columns
About this task
The sort direction is indicated by a small arrow. An upward arrow indicates an ascending order and
a downward arrow indicates a descending order.

Procedure
1. Click a column header.

The system displays the selected column header as dimmed.

2. Click the column header again to reverse the sort sequence.

Related links
Email module overview on page 61

Changing column width
Procedure

1. Click the column separator.

The system changes the shape of the mouse pointer.

2. Use the mouse to slide the separator line to change the width of the column.

Related links
Email module overview on page 61

Changing the work area
About this task
You can maximize or minimize the work area.

Procedure
1. To maximize the size of the work area, click Maximize icon .
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The system hides the list of mails in the work are and displays the details of the selected
mail.

2. To display the document list again, click the Restore icon .

The system displays the list of mails in the selected folder.

Related links
Email module overview on page 61

Key sequences

Email editor key sequences
Name Description
Ctrl+A Select all
Ctrl+C Copy to clipboard
Ctrl+V Add the clipboard content
Ctrl+X Move to the clipboard
Ctrl+Z Undo
Ctrl+Y Retry
Ctrl+B Indicates bold
Ctrl+I Indicates italic
Ctrl+U Underline
Ctrl+E Center
Ctrl+L Align left
Ctrl+R Align right
Ctrl+Shift+Z Delete formatting
Ctrl++ Bigger type size
Ctrl+- Smaller type size
Ctrl+Shift++ Increase indent
Ctrl+Shift+- Decrease indent

Related links
Email module overview on page 61
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Email list view key sequences
Name Description
Ctrl+Home First page
Ctrl+End Last page
Ctrl+Page Down Previous page
Ctrl+Page Up Next page

Related links
Email module overview on page 61

Email function and command key sequences
Name Description
Ctrl+N Create new email
Ctrl+R Reply
Ctrl+Shift+R Reply with options
Ctrl+Shift+I Reply all with or without the original message
Ctrl+W Forward
Ctrl+G Delegate
Ctrl+Shift+K Defer
Ctrl+D Delete
Ctrl+Shift+A Use Job code (email)
Ctrl+Shift+E Send
Ctrl+H Add attachment
Ctrl+S Save
Ctrl+T Activate the selected email and change to the email

text view
Ctrl+F Active the search filter
Ctrl+O Set the focus on the current folder list
Ctrl+Shift+T Select textblocks
ESCAPE Leave textblock, and return to email editor

Related links
Email module overview on page 61
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Address books

Address books overview
In the Email module, you can use a personal address book, a shared address book, or both.

When addressing a message in the address book, you can select the names, the email addresses,
and the distribution lists.

When you type a name in the To, Cc, or Bcc fields in an email message, the Email module
automatically checks the address book for matching names. If a matching entry is found, the system
inserts the name displayed and the email address and sends a message. If a match is not found,
the system displays a message asking for more information. If you enter more than one letter for a
name, the system displays a list of matching names to select from the list.

In addition to using an address book to address messages, you can search for other information in
the address book by entering a name. For example, office addresses and telephone numbers .

Types of address books:

• Personal address book
• Shared address book
• External address book

Personal address book
The personal address book consists of a list of names and the distribution lists that you can create
and maintain. Personal address book entries are stored in a file. You can also import a personal
address book.

Limitations:  Importing address book data has the following restrictions:
• When you import data, the system overwrites all data that is in the address book. Therefore,

you must always import the address list and the distribution lists together.
• You cannot import addresses or each distribution list at a later date.
• If you create the CSV file in Microsoft Excel, you cannot have a single value in a row. Microsoft

Excel interprets all remaining columns as being empty and creates a line in the format
<Distribution list name>;;;;;;;;;;;;;;. You must precede the name with a hash
mark (#) so that the distribution list recognizes the names during import.

Error handling:  If the address book server is unavailable, the system displays an information
message to that effect. You cannot import data in this situation. The Email module attempts to
restore the connection to the address book server. To attempt a new import, you must open the
import window again. If errors occur during an import operation, these errors are written to a log file.

Import files:  Import files must be ASCII text files. The file extensions CSV and TXT are permitted.

Shared address book
The shared address book contains the names and email addresses of all users within your
organization. This address list is centrally created and maintained by the system administrator. The
shared address book can also contain the email addresses of shared distribution lists.
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External address book
Your system administrator can connect an external address book so that you can use the relevant
information.

Related links
Email module overview on page 61

Searching address books
Procedure

1. In an active email, click To.

2. In the Targets dialog box, type your search criterion.

You can limit your search if required. Choose the relevant list box entries, for example,
Personal address book.

3. Click Search.

The system displays a list containing the matching entries. A scroll bar is added if necessary.

4. From the list of entries, select the required entry.

5. To transfer the entry, click To, Cc or Bcc.

6. Click OK.

You can change the data and add or delete addresses, if required.

Address book search field descriptions
Use the following information to limit the search in the address books:

Name Description
Address books The list of available address books. The options are:

• All address books

• Global address book - Exchange
Search all The search criteria. The search fields are:

• Last Name

• First name

• Email

• Phone (mobile)

• Phone (business)
Distributor A list of names of all complied recipients. The field

represents a simple tool for sending messages to a
group of people. When you send a message to a

Table continues…
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Name Description
distribution list, the message goes to all the
recipients on the list. The recipients can view their
own name in the To line with the names of all other
recipients. However, the name of the distribution list
is not displayed.

Service The service you can send messages:

• Email: The message is sent as an email to the
email address.

Displaying and changing transmission settings
About this task
You can view and change the transmission settings. You cannot change the properties of an
address book entry in the address book. If you change a transmission setting, these changes only
apply to the current transmission job.

Procedure
1. In the message or in the addressing window, double-click on the entry in the To, Cc, or Bcc

field.

2. In the Send details dialog box, change the following transmission settings:

• Service

• Target

• First name

• Name

• Street

• ZIP code

• Town

• Country

• Company

3. Click OK.

Related links
Email module overview on page 61
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Displaying distribution lists
About this task
The distribution list displays the names of the recipients with the following information:

• Last name
• First name
• Email address

You can only see the distribution list. You cannot add or remove recipients or change the
distribution list in the address book. You can, however, use this procedure to revise the
recipients of the current document and change the distribution list.

Procedure
1. Click the entry in the To, Cc, or Bcc field.

2. In the Address book dialog box, select a distribution list.

3. Click the To, Cc, or Bcc field.

The system transfers a distribution list to the field.

4. Click OK to apply your selections.

Related links
Email module overview on page 61

Importing files
Before you begin

• Create a suitable CSV files for the address book and distribution lists.
• Import atleast one address book list or one or more distribution lists.
• Gain access only the imported address book list or the distribution lists.

Procedure
1. On the File menu, select Import for address book.

2. In the Import addresses for personal address book dialog box, in Addresses, click Browse.

3. Select a file.

4. In Distribution lists, click Browse.

5. Select a file.

6. Click Import.

The system imports the data files and displays the log file. This file contains all information
about the import.
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7. Click Close.

The data in the personal address book and the distribution lists is ready for immediate use.

Creating CSV file templates
About this task
You can create specific templates for importing the addresses or the distribution lists.

Procedure
1. In the File menu, click E-mail client.

2. Click the Create address import file.

The system displays the Create CSV file templates dialog box.

3. Select the required entries for the Address book or the Distribution list field.

4. Do one of the following:

• For an address import, click Template for address import.

You can apply the following fields for a template for address import:

LastName, FirstName, State, Province, PostalCode, City, Company,
Street, Department, MailboxDisplay, PhoneNumber, MobilePhone,
PrivatePhone, BusinessFax, MailAddress, Country, EntryId

• For a distribution list, click Template for distribution lists.

You can apply the following fields for a template for distribution lists:

voiceAddress, mailAddress, smsAddress, faxAddress, DisplayName,
ForeignKey, UniqueKey, LastName, FirstName, Gender, Sex, State,
Province, PostalCode, City, Company, Street, Department, Title,
HomePage, BusinessURL, Category, MailboxDisplay, PhoneNumber,
PhoneNumber2, MobilePhone, MobilePhone2, PrivatePhone,
PrivatePhone2, OtherPhone, OtherPhone2, Fax, BusinessFax, Fax2,
PrivateFax, EmailAddress, MailAdress, EMailAddress2,
EMailAddress3, Country, UserDef1, UserDef2, UserDef3, UserDef4,
UserDef5, UserDef6, UserDef7, UserDef8, UserDef9, UserDef10,
HomePage2, PrivateURL, EntryId, NotesTicketId, GPTicketId, SMS,
SMS2, AdbId

The system creates a .csv file for the address import or the distribution list template.

5. Save the .csv file that you created or open with another application.

Import file specifications and examples

Import
information
(header)

The columns to which the values in the subsequent data records are assigned are
defined in the first row.

The column names must match the names permitted for importing addresses into
this address book.
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The valid column names can be seen in the dialog box.

Leading or trailing blanks in the column names are ignored.

Column names are case-sensitive.

Invalid columns are not imported and a corresponding error message is displayed
in the log file.

Data records The data records must be arranged in rows.

The individual values must be separated by semi-colons (;).

The values must not contain semi-colons.

Type-dependent (address list or distribution list) import information must be
placed at the beginning of the import data.

The import files may contain any number of empty rows.

The remaining rows contain the actual data records with the values to be
assigned to the various columns.

Columns may be left empty.

The number of values including empty values must match the number of values in
the import information header.

Rows containing an invalid number of values are ignored during the import.

A corresponding error message is written to the log file.

Leading or trailing blanks in the values are ignored.

Rows containing only empty values are ignored. A corresponding error message
is written to the log file.

Address book import file example
The following example shows a file used to import a personal address book.
EntryID; LastName; FirstName; Street; PostalCode; City; PhoneNumber; 
MailAddress
123; Utzer; Ben; Dorfstraße 34c; 22941; Bargteheide; 04532-1234567; 
ben@firma.com
124; Comergo Bargteheide; ; Bahnhofstraße 24; 22941; Bargteheide; 
04532-269 0; info@comergo.com
125; Bredet; Vera;;;;;vera_b@web.de
Distribution list import file example
The following example shows a file used to import a distribution list:
LastName; FirstName; voiceAddress; faxAddress; mailAddress; smsAddress; 
DisplayName
Department A
Utzer; Ben; 04532-269 0; 04532-269 199; ben.utzer@avaya.com;;Benni
Bredet; Vera; 089-999 888; 089-999 999; verabredet@firma.de; ; VeraB
Gent; A.; 04532-123 456; 04532-269 199; agent@umrtest.int; ; A.Gent
#Department B;;;;;;
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Maier; Carsten; 04532-123456; 04532-40123456; carsten.maier@firma.com; ; 
CarstenM
Müller; Christian; 04532-123457; 04532-40123457; 
christian.mueller@firma.com;; ChristianM
Schultze; Stefan; 04532-123458; 04532-40123458; 
stefan.schultze@firma.com; ; StefanS

Displaying valid column names
About this task
You must specify the column names in the first row of the import file so that the system displays
valid column names. You can display valid column names.

Procedure
1. On the E-mail Client menu, select Import address book.

2. In the Address book and the distribution list import dialog box, click Show.

The system displays the underlined valid column names that are included in the import.

Importable columns
Your system administrator can configure the importable columns in the Address book administration
application.

Column characteristics Description
Columns The following columns are defined for the pre-

configured personal and shared address books:

ForeignKey, LastName, FirstName,
Gender, State, Province, PostalCode,
City, Company, Street, Department,
Title, Homepage, Category,
MailboxDisplay, PhoneNumber,
PhoneNumber2, MobilePhone,
MobilePhone2, PrivatePhone,
PrivatePhone2, OtherPhone, OtherPhone2,
Fax, Fax2, EmailAddress, EMailAddress2,
EMailAddress3, EntryId

Restrictions Only the EmailAddress column is currently used for
sending a message by email.

Distribution lists Individual entries in a distribution list might contain all
the above columns.

In addition, the mailAddress, faxAddress,
smsAddress, and voiceAddress columns must be
present.

When a message is sent to a distribution list, these
additional fields are used as the destination that is
email message to mailAddress.

Table continues…
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Column characteristics Description
In a distribution list, the columns listed are seen as
address information for the person. The four
additional fields serve as unambiguous destination
addresses for the transmission of the message.

For example, you can deliberately use one set of
email addresses for a bowling team distribution list
and another for a development department
distribution list although the people involved might be
the same.

Setting folder options

Options field descriptions
Name Description
Activate call center e-mail on selection Indicates that the message is automatically activated

when you click on it.
Show CC input Specifies that the CC field must be displayed when

you are processing a message.
Show BCC input Specifies that the BCC field must be displayed when

you are processing a message.
Play sound on incoming mail Plays the configured sound when you receive an

email. You can configure the sound at New Mail
Notification in the Sounds tab in Control Panel –
Sounds and Audio Devices.

Show message on incoming mail Displays a notification when you receive a new
email.

Close message manually Indicates that the notification is closed after the set
period of time. If you choose this option, you must
close the notification manually.

Close after Specifies the time period after which the notification
is closed. The time is expressed in seconds, and you
can set a time between 0 and 60 seconds.

Rows Specifies the number of rows displayed in a folder.
The default value is 100 rows You can scroll down if
the folder contains more that 100 lines.

Always display paging info Displays the visible scroll icons.

Related links
Email module overview on page 61
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Setting the Options
About this task
You can specify how and when a folder is updated. You can set an interval between 0 and 60
seconds to automatically update the folder, or you can update the folders manually. Avaya does not
recommend this setting.

Procedure
1. Click E-Mail Client > Additional options  > Options.

2. In the Options dialog box, enter the required settings.

3. Click OK.

Related links
Email module overview on page 61

Viewing documents in mailbox folders
Procedure
Click on the relevant mailbox folder tab to display documents within that folder.

Related links
Email module overview on page 61

Paging through mailbox folders
About this task
If you set the Maximum rows displayed option, the system displays a line below the entries. If you
have selected the Always display paging info option, the scroll functions are always available.

Procedure
1. To page through the search results, click one of the following:

• The next icon : To go to the next page.
• The previous icon : To go to the previous page.
• The last icon : To go the last page.
• The first icon : To go the first page.

2. To go to a particular page, enter the page number and click Go to.

The system displays the report in the selected page.

Email module overview
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Related links
Email module overview on page 61

Using search filters
About this task
Use this procedure to limit the number of documents that are displayed in each folder. The field
indicating the number of lines to display is set automatically to 100. If more than 100 documents are
present in a folder, the system displays the controls of the search function automatically.

If you have the View extended Archive privilege, you can also search in the Archive folder for
mailboxes of deleted agents or topics. The search filter limits the documents that are displayed.

Note:
In the Archive folder, you cannot disable the search function or hide the search input fields.

Procedure
1. Click E-Mail Client  > Additional options > Show search filter.

2. Use the following search criteria:

• Search for

• Search in

• Recipient

• From

• From To

• Topic

• Ticket ID

• Mailbox

• Status

3. Click the Use filter icon .

4. (Optional) To clear all fields, click the Reset filter icon .

5. (Optional) To hide the input fields for the search function, click the Close icon 

6. (Optional) To search the mailboxes of deleted agents and topics, do the following:

a. Perform a search in the Archive folder.

The system displays a mailbox list of deleted agents and topics in a different font.

b. Select an agent or topic.

Using search filters
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Related links
Email module overview on page 61
Show search filter field descriptions on page 92

Show search filter field descriptions
You can use the following search criteria:

Name Description
Search for Searches for parts of words.
Search in Searches in the Subject line or the Subject and text body.
Recipient Searches for a recipient.
From Searches for a sender.
From

To

Specifies to select a date in the From and To field. You can
enter the time.

Topic Searches for a topic.
Ticket ID Searches for a Ticket ID, which is only available in the

Completed folder.
Mailbox Enters the mailbox in the Completed and Overview folders

that you want to search within mailbox.
Status Displays the status of the email. For example, Forwarded,

Received, Replied, and Sent.

Related links
Using search filters on page 91

Activating documents
About this task
You can activate only one document at a time. If you activate a second document, the first activated
document is placed in the Break time state. If you make changes to the first document without
saving, the system displays a message to save the document. When you close an active document,
the system places the document in the Break time.

Note:
If the agent is on a break, only a preview is permitted. The documents cannot be activated. This
applies both to documents assigned by IP Office Contact Center and to directly addressed
documents.

Before you begin
• Activate the documents before processing through IP Office Contact Center.

Email module overview

February 2016 Using Avaya IP Office Contact Center for Windows 92
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


• Activate a document to access incomplete replies or documents for forwarding.

Procedure
Do one of the following:

• Double-click on the document.
• Right-click on the document, and select Activate from the pop-up menu.

Related links
Email module overview on page 61

Viewing the document process and transmission status
About this task
You can view the processes for a document and see the transmission status in the Outbox and
Sent folders.

Procedure
1. Right-click a document and select Show send state.

2. In the Show send state dialog box, click one of the following:

• Stop
• Retry
• Resend
• Delete

Related links
Email module overview on page 61

Creating new documents
Procedure

1. Click Inbox folder, and then click the New icon .

The system changes the processing status indicator to Create E-mail.

The system displays buttons in Action bar. The To button and the Subject field are
displayed along with Maximize work area icon  and Close icon .

2. In the To field, do one of the following:

• Select an address book.
• Enter the address.

Viewing the document process and transmission status
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3. (Optional) To select an address in the Address book, do the following:

a. Click the To button.

b. Select the appropriate Email service.

c. Select an address book.

d. Enter a search term.

e. Click Search.

f. Select an entry.

g. Click To, Cc, or Bcc.

h. Add more recipients if necessary.

i. Click OK.

4. (Optional) Type the recipients address in the To field.

For example, Email: SMTP=name@company.com. If you use multiple recipients, separate
with semicolons (;).

5. Click OK.

6. Enter a subject in the Subject field.

7. Enter the text in your email.

8. (Optional) To save the document temporarily while you are composing it, click the Save
document icon .

9. To send the document, click the Send document icon .

Related links
Email module overview on page 61

Performing spell checks
About this task
When you write a message, you can check the Subject line and the body for spelling errors. You
can select a language. The system displays entries that are not found in the dictionary and suggests
a replacement. You can accept or ignore the suggestion or suggestions. The default language of the
user interface is the language that you select.

Procedure
1. Within a message, click the Spelling icon .

The system displays the Spellchecker dialog box with a text message. The system displays
the first entry that is not found in the dictionary. The Change into field displays the
suggested entry.
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Note:

You cannot edit the text in the Spellchecker dialog box.

2. To apply the change, click Change.

The system replaces the entry with the selected entry and automatically selects the next
misspelled word in the message.

3. To select a replacement word, from the Suggestions list, select a word.

The system displays the selected word in the Change into field.

4. To ignore the suggested change, click Ignore.

5. (Optional) You can discard the change for all instances of a word by clicking Ignore all.

6. Click Apply.

The system applies the selected changes to the text and displays the text.

7. (Optional) If you do not want to apply the changes, click Close and do one of the following:

• To discard changes, click OK.

• To cancel the discard changes, click Cancel.

Related links
Email module overview on page 61
Spell check field descriptions on page 95

Spell check field descriptions
Name Description
Language Displays the language of the dictionary.
Not in dictionary Displays a word that is not in the dictionary.
Change into Displays the modified text.

You can edit the text as required.

Suggestions Displays suggestions from the dictionary.

Button Description
Ignore Ignores a word.
Ignore All Ignores all instances of a word.
Change Changes a word as specified in the Change To field.
Change All Changes all instances of a word as specified in the

Change To field.
Apply Applies the changes to the text.

Table continues…
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Button Description
Add Word Adds a word.
Close Ends the spelling check.

The system displays a message asking whether you
want to discard the changes.

Related links
Performing spell checks on page 94

Text blocks
You can use text blocks to create messages that are uniform in appearance. The text blocks can
also contain, for example, templates for opening salutations and a closing phrase. When you are
editing a message, an additional window is displayed on the right-hand side of the screen containing
the available text blocks. The view is organized in a tree structure.

Text blocks can contain placeholders. A placeholder is a kind of a variable. The system normally
substitutes a placeholder automatically. Where necessary, your system administrator can use a
placeholder to insert extra information into the message.

Note:
When you make changes to a text block, you must log off and log in again to see and use the
changed block.

The options to navigate to Text blocks are:

Name Description
+ Indicates that the folder contains one or more text blocks or

subfolders.
- Displays the opened folder.

Displays a folder that might contain subfolders.

Displays the Text block.

Related links
Email module overview on page 61
Inserting text blocks on page 96

Inserting text blocks
Before you begin
Get the Use Text blocks privilege.
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Procedure
1. To navigate the text blocks, click one of the options.

2. (Optional) To change and sort the text block view, click one of the following:

• Language: Displays only text blocks in a specific language.

• Topics: Displays only text blocks in a specific topic.

3. (Optional) To display or hide the text block view, click on the right or left arrow.

4. To edit a message, select the text block, and do one of the following:

• Double-click on the text block.

• Select the text block and click Paste.

When you send the message that contains placeholders, the system displays a Replace
unknown placeholders dialog box.

5. Enter information into the placeholder field.

6. Click OK.

Related links
Text blocks on page 96

Sending documents
About this task
You can set the agent name or a topic as the sender of an email, a reply, or a forwarded document.
For replies, the default is to use the topic through which the document entered the system. For
forwarded or new documents, the agent is set as the default sender. Any topic for which the agent in
question has authorization is available for use.

Before you begin
Create a new document.

Procedure

To send the document, click the Send document icon .
Related links

Email module overview on page 61
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Email reply
You can send a reply with or without the original text. The text of the original document is
automatically incorporated when you send a reply to a document. The formatting is retained in
HTML emails. A header is generated and placed before the text.

For example:
-----Original Message-----

From: <Sender of the original message>
Received: <Date and time the original document was received>
To: <Recipient of the original message>
Cc: <Cc recipient of the original message>
Subject: <Subject of the original message>
[..] Text of the original document [..]
Attachments to the original document are not incorporated into replies.

Each original document can have only one active reply. You can send any number of replies to an
original document.

After you send a reply, the status icon for the original document reverts to the standard icon with no
active reply. You cannot close or exit the original document if an answer exists, which is not sent or
deleted.

The system displays the default topic to use, the way the document entered the system. The agent
is set as the default sender. The agent can use only those topics to which the agent has
authorization.

Replies are sent in a multipart or alternative format. That is, the body is present in both plaintext and
HTML form.

Related links
Email module overview on page 61
Replying to documents on page 98

Replying to documents
Procedure

1. Click one of the following:

• The Reply icon .

• The Reply list box, and select Reply with original to include the original message with
your reply.

• The Reply list box, and select Reply without original to send a reply without including
the original message in your reply.

The original email view is hidden, and the area containing the prepared reply document is
maximized. The name of the sender is inserted in the To field. The system displays Re: in
the Subject field with the text of the original subject line.
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Note:

If the document is closed without sending a reply, the system saves the reply and remains
linked to the original document. The original document is marked with a corresponding icon.
The system does not display these replies in the Drafts folder.

2. (Optional) With Reply as an agent privilege, you can select a sender address in the From
field.

Note:

You cannot enter free text for a sender address. You can only select an agent or topic as
a sender.

a. Click the From button.

b. From the Sender list box, select an agent or a topic.

The agent is separated from the topics by a broken line. The topics are in alphabetical
order.

3. Enter the text of your email.

4. (Optional) To save the document temporarily while you are composing the document, click
the Save document icon .

5. (Optional) To discard an active reply, click the Delete button.

The system displays the original document again.

Related links
Email reply on page 98

Forwarding documents
About this task
Attachments to the original document are included with forwarded documents.

Each original document can only have one active document for forwarding. You can forward an
original document any number of times.

After a document is forwarded, the status icon of the original document reverts to the standard icon
with no active document to forward. You cannot close or exit the original document while an answer
exists that is not sent or deleted or is waiting to be forwarded or deleted.

The agent is the sender by default. Any topic for which the agent in question has authorization is
available for use.

Forwarded documents are sent in a multipart prealternative format. The body of the document is
present in both plaintext and HTML format.

Forwarding documents
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Procedure
1. Click the Forward button .

The original email view is hidden and the area containing the prepared forwarding document
is maximized. Fwd is inserted in the Subject field along with the text of the original subject
line.

2. In the To field, do one of the following:

• Select an address book.

• Enter the address.

3. (Optional) To select an address in the Address book, do the following:

a. Click the To button.

b. Select the appropriate Email service.

c. Select an address book.

d. Enter a search term.

e. Click Search.

f. Select an entry.

g. Click To, Cc, or Bcc.

h. Add more recipients if necessary.

i. Click OK.

4. (Optional) Type the recipients address in the To field.

For example, Email: SMTP=name@company.com. If you use multiple recipients, separate
with semicolons (;).

5. Click OK.

6. Enter the text in your email.

7. (Optional) To save the document temporarily while you are composing it, click the Save
document icon .

8. (Optional) To discard an active document, click the Delete button.

The system redisplays the original document.

9. To send the document, click the Send document icon .

Related links
Email module overview on page 61
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Picking up documents
Procedure

1. In the Overview folder, select a document.

2. Click the Pick icon .

The system displays the document as Delegated in your Inbox, and you can process the
document.

Related links
Email module overview on page 61

Delegating documents
About this task
You can select the agent or topic to which the document is delegated from a list of possible
destinations. You can select the destinations available at that time. In addition, you can add a note.

Procedure
1. Click the Delegate icon .

The system displays a window to select a destination.

2. From the list box, select a destination.

Destinations are divided into topics and agents. Green indicates available, and red indicates
temporarily unavailable. For example, if the agent is not logged in. You can delegate the
document to an agent that is temporarily unavailable.

3. (Optional) To provide the delegate with context for the document, type text in the Note field.

4. Click Delegate.

The system delegates the document to an agent or a topic in line with the email flow. If you
enter an agent as the destination, the system sends the document directly to that agent.

The system removes the document from the mailbox folder. In addition to the entries made
by the agent, the system displays in the note the name of the agent who delegated the
document.

Related links
Email module overview on page 61
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Emptying the recycle bin
About this task
You can empty the recycle bin in the Deleted folder.

Warning:
You cannot undo the delete action.

Procedure
In the Email-client folder, click Additional options > Empty recycle bin.

The system deletes all documents.

Related links
Email module overview on page 61

Closing transactions
About this task
Close transactions to complete the processing action on the system.

Procedure

Click the Complete processing of transaction icon .
Related links

Email module overview on page 61

Creating signatures
About this task
You can create a personal signature with specific information. You can select whether to add your
signature automatically to each message.

Procedure
1. Click Email Client > Additional options > Signature.

2. In the Personal signature dialog box, type your signature.

3. Select Use signature.

4. Click OK.

The system inserts your signature in each message.

Email module overview
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Related links
Email module overview on page 61

Allocating job codes
About this task
You can enter the job code more than once. Only the last value given is stored. The current job
code is displayed in the email header.

Note:
If a job code is required before the original document can be closed, then the system displays a
small warning icon in orange or red LED on the Job Code icon .

Procedure

Click Allocate job code .
Related links

Email module overview on page 61

Adding attachments
Procedure

1. In the mailbox folder action bar, click the Add attachment icon .

2. In the Add attachment dialog box, click a file.

3. Click Open.

The system displays the selected file at the bottom of the email.

Related links
Email module overview on page 61

Downloading and opening attachments
About this task
Attachments to the original document are displayed in a separate area at the bottom of the mail.
Each attachment displays the file name and size in bytes.

You can open the attachment directly if the type of attachment is known or if an appropriate
application for the type is registered. If the type is unknown, you must first download the attachment.

Allocating job codes

February 2016 Using Avaya IP Office Contact Center for Windows 103
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


Note:
You can only view an attachment if you activate the document. If the file does not open in the
program that you expect, contact your system administrator to change settings.

Procedure
Right-click the attachment and click one the following:

• Open.

• Save.

You can select a folder and save the attachment with a name.

• To remove the attachment, Click Remove.

Related links
Email module overview on page 61

Editing attachments
About this task
Use this procedure to edit an attachment. You can attach additional information to a document. You
can use the following functions for an attachment:

• Open (known type)
• Download (all types)
• Play back (telephone number) via telephone (WAV files only)
• Uninstall components

If you have the correct setup, you can listen to a WAV file over your telephone.

Procedure
1. Right-click the attachment.

2. In the pop-up menu, click a function.

Related links
Email module overview on page 61

Setting Send options
About this task
You can configure send options for all outgoing documents, including new documents, replies, and
forwarded documents.

Email module overview

February 2016 Using Avaya IP Office Contact Center for Windows 104
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


Procedure
1. Click the Send options icon .

2. Select one or more of the following options:

• Account

• Send priority

• Acknowledgm.of.receipt (only for email)

• Immediately

• Time

• Cover

3. (Optional) To discard the settings, click Cancel.

4. Click OK.

After you make changes to the body or header of an email or send options, the system
displays a message whether to save the changes when you close the document. You can
again view and make changes to the send options that are set and saved when the
document is closed.

Related links
Email module overview on page 61

Holding and resubmitting documents
Procedure

1. On the Action bar, in the mail view area, click the Defer icon .

2. Enter the date and time at which you want the document to be resubmitted.

3. In the Note field, type a note.

4. Click Defer.

The system moves the document to the Deferred mailbox folder that is stored until the
specified date and time. After the specified date and time, the system moves the document
to the Inbox folder marked with the Resubmission document status icon. When you open
the document, click the Note icon to read the note, which displays in the second column.

Related links
Email module overview on page 61
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Saving draft documents
Procedure

Click the Save document icon .

The system saves the document to the Drafts folder.

Related links
Email module overview on page 61

Repeating failed transmissions
About this task
If the original transmission ends with an error, you can repeat the transmission.

Procedure
1. In the Sent folder, right-click the document that could not be transmitted.

2. In the pop-up menu, click Show send state.

3. If the transmission fails, select the document.

4. Click the Retry icon .

The system repeats the transmission.

Related links
Email module overview on page 61

Resending documents
Procedure

1. In the Sent folder, right-click the document and select Show send state.

2. Select the document and click the Resend icon .

The system displays the document in edit mode.

3. Edit the document and enter a new subject or address if necessary.

4. To send the document, click the Send document icon .

Related links
Email module overview on page 61
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Printing documents
Before you begin
Connect your computer to a printer with the appropriate privileges.

Procedure
1. Click the Print icon .

2. In the Print dialog box, click the Select Printer option and select the printer.

3. Click Apply and then click OK.

Related links
Email module overview on page 61

Viewing message properties
About this task
Every message in the system has certain properties. When a topic receives a new message, the
system automatically assigns a number or Ticket-ID to the message. The system uses Ticket IDs to
logically connect customer requests and queries related to the same transaction. You can track the
events associated with a message with Ticket IDs. The system administrator sets the
Automatically issue ticket IDs option for the topics using the Configuration application.

Procedure
1. Right-click a message.

2. In the pop-up menu, click Properties.

The system displays the following message properties:

• Document ID

• Folders

• Write-protected

• Mailbox

• Send priority

• Replied

• Forwarded

• Auto-replied

• Task state

• Original topic

• Actual topic

Printing documents

February 2016 Using Avaya IP Office Contact Center for Windows 107
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


• Attribute

Related links
Email module overview on page 61
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Chapter 6: Chat module overview

Chat is an electronic communication in real time. You can edit chat requests with the IP Office
Contact Center Chat module.

The Chat module is divided into three areas:

• List view

• Chat progress

• Chat input

If necessary, you can use the scroll bar to set the height of each area.

List view
The List view displays the following information in chat requests:

• Status
• New request
• Topic
• Participant
• Participant address
• Started
• Text
• Customer name

Chat progress
Chat progress displays details in chronological order, including the time of the chat, the name of the
chat participants, and the chat message. You can print chat progress.

Chat input
In the Chat input field, you can type and send a text to the active chat request field. The function
of smilies and spell check are unavailable in the Chat input.
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Chat request icon descriptions
Icon Name Description

Maximize Maximizes the chat progress.

Print Prints the chat progress.

Smilies Unavailable in chat request.

Spell check Unavailable in chat request.

Send Sends the text.

Complete Completes the chat request.

Job code Enables you to choose a job code.

Required Job code Enables you to choose a required job
code.

Archive Archives a folder.

Search Displays archived chat requests in the
Store folder.

Reset Resets the search criteria.

List view field descriptions
Name Description
State: New Displays a new chat request.
State: Read Indicates that the chat request text is read. Chat progress displays

the chat request message.
State: Active Displays the active chat request. Chat progress displays the chat

request text.
New message Displays a new chat message. Chat request is inactive.
Composing Displays that the participant is typing.
Topic Displays the IP Office Contact Center topic for the chat request. The

participant chooses this topic.
Participant Displays the name of the chat participant. If the chat participant starts

an anonymous chat request, the name can consist of letters and
numbers.

Participant address Displays the Jabber Identifier of the participant.
Started Displays the start time of the chat request.
Text Displays the initial text of the chat request.
Customer name Displays the name of the customer.
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Using the Chat module
About this task
As an IP Office Contact Center agent, you can edit chat requests and use call center system
functionality. With the chat module, you can change to telephony or email processing as needed.

Before you begin
• Ensure that you are configured as a chat agent.
• Ensure that you have the required privileges.

Procedure
1. To open the Chat module:

• On the Go to menu, click Chat.

• On the task bar, click the Chat icon .

• On the tool bar, click the Chat icon .

2. To log in to an agent group, click the Select AG icon .

3. In the Agent group selection dialog box, mark the appropriate agent groups for Chat.

4. Click OK.

The system displays the logged in status of the selected agent groups.

5. To accept a chat request, click an entry in the list view.

The system displays the list view in active state.

6. To answer a chat request in Chat input, type the text.

You can enter smilies.

7. To send text, do one of the following:

• Click Send.

• Use the Enter key on the keyboard.

8. To complete a chat request, click Complete.

9. (Optional) If a job code is required, then click Job code and select Job code.

Using the Chat module

February 2016 Using Avaya IP Office Contact Center for Windows 111
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


Part 2: Supervision

February 2016 Using Avaya IP Office Contact Center for Windows 112
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


Chapter 7: Real time Information module
overview

You can provide real time information on the status of an object in the IP Office Contact Center
system. You can monitor some object states in real time, and the states of other objects periodically.
The states of objects are displayed alphanumerically, graphically, or in a tabular form. The system
displays the Realtime information icon on the task bar. You can also find the Real time
Information on the menu bar.

Features of the real time information module
• Configuring real time information.
• Displaying the real time information.
• Creating, changing, and deleting of real time information files.
• Managing, creating, changing, and deleting of folders and files.
• Assigning rights.

Monitoring object status
You can monitor the status of the following objects:

• Topic structured according to a task type
• Agent structured according to a task type
• Agent group structured according to a task type
• Team structured according to a task type
• PBX
• IVR

Related links
Real time information view types on page 114
File View on page 115
Viewer on page 118
Inspector on page 119
Real time information elements on page 123
Configuring the properties of elements on page 126
Text elements on page 129
Lists on page 135
Tables on page 142
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Graphics elements on page 145
Values on page 162
Saving window settings on page 171
Real time information calculation on page 174
Structure of IP Office Contact Center User Interface for Windows on page 24

Real time information view types
Real time information has three different views:

Name Description
File View Displays the folders and associated files for real time information. You

can edit the real time information files.
Inspector Creates and edits real time information in the Inspector view.
Viewer Displays real time information in the Viewer view.

Default monitor
The default monitor displays immediately after installation and a basic configuration. The default
monitors for an agent group and a topic are predefined.

Related links
Real time Information module overview on page 113
Real time information menu field description on page 114

Real time information menu field description
Name Description
Close "Name of Realtime
Information"

Closes the current real time information.

Realtime information file list Displays the open real time information. You can identify the
current real time information with a check mark.

For example:

Realtime Information 1

Realtime Information 2

Realtime Information 3
Autostart Automatically opens the current real time information when you

sign in the next time.

Table continues…
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Name Description
Profile autostart Selects a profile for which you want to configure autostart real time

information. For the autostart profile, all open real time information
with the current position information is stored as autostart real time
information.

Save Window Positions Saves the current window position of separate real time
information.

Related links
Real time information view types on page 114

File View
File View is divided into four areas:

• The title bar

• The toolbar

• The folder

• The Real time information files

The title bar displays the real time information File View.

Related links
Real time Information module overview on page 113
File view toolbar icon field descriptions on page 115
Folders and file view overview on page 116
File View icon field descriptions on page 116
Folder area pop-up menu field descriptions on page 117
File area pop-up menu field descriptions on page 117

File view toolbar icon field descriptions
Icon Name Description

New folder Creates a new folder.

New realtime information Creates a new real time information file.

Edit Toggles to Inspector view. You can edit
the selected file in the Inspector view.

Duplicate Copies a file.

Table continues…
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Icon Name Description
Delete Deletes the selected file or folder. You can

also delete more than one file at a time.
Full screen Displays the selected file as a full screen

in the Viewer view.
Work area Displays the selected real time information

file in the Viewer view.
Separate realtime information Displays the selected file in a separate

window in the Viewer view.

Related links
File View on page 115

Folders and file view overview
The folders area displays in a tree structure for real time information. You can use these folders to
arrange and clear a layout according to the topic. You can create private or public folders.

Realtime information files
The Real time information files area displays the real time information of a selected folder. The area
displays the name and type of real time information. The type indicates whether a real time
information file is a private file or a public file. You can use only private folders, and users with the
respective privileges can use public folders. The default Home and Telephony real time information
cannot be changed. To edit real time information, you must copy the screens first.

Related links
File View on page 115

File View icon field descriptions
The following icons are used in the Folder and Real time information files area:

Icon Name Description
Folder (public) Displays a public folder.

Folder (private) Displays a private folder.

File (public) Displays a public real time information file.

File (private) Displays a private real time information file.

Related links
File View on page 115
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Folder area pop-up menu field descriptions
Name Description

New  Folder (public) Creates a new public folder.

New  Folder (private) Creates a new private folder.

New  File (public) Creates a new public file.

New  File (private) Creates a new private file.

Add Pastes one or more copied or cut files in the selected folder.
Delete Deletes the selected folder.
Rename Renames a selected folder.
Private Converts a public folder to a private folder, and vice versa. The

conversion can also affect sub folders and files contained in the
folder. When you do the conversion, the system displays a
message.

Refresh Displays the latest version of the page.

Related links
File View on page 115

File area pop-up menu field descriptions
Name Description

Open  In Work Area Displays the selected file in the work area.

Open  Full View Displays the selected file in full view.

Open  In new window Displays the selected file in a separate window.

Edit Toggles to the Inspector view.

New  File (public) Creates a new public file. You can name the new file.

New  File (private) Creates a new private file. You can name the new file.

Cut Cuts the information. You can select and cut one or more files and
paste in another folder.

Copy Copies the information. You can select and copy one or more files
and then paste the files in another or the same folder.

Paste Pastes the copied files.
Delete Deletes one or more selected files.

Table continues…
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Name Description
Rename Renames the selected file.
Duplicate Copies the information. You can copy the selected file in the same

folder. You must rename the file.
Private Converts a public file to a private file or vice versa.
Refresh Refreshes the contents of the selected folder.

Related links
File View on page 115

Viewer
The Viewer displays the configured real time information in three areas:

• The title bar

• The tool bar

• The Realtime information files

The title bar displays Viewer - <file name>.

Related links
Real time Information module overview on page 113
Viewer tool bar icons on page 118
Editing the Viewers view on page 118

Viewer tool bar icons
Icon Name Description

Realtime information files Toggles the file view.

Edit Toggles the edit mode.

Full screen Toggles the full screen display.

Related links
Viewer on page 118

Editing the Viewers view
About this task
The Viewer displays the configured real time information of the Realtime information file.

Real time Information module overview
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Procedure
1. In the Realtime Information files field, select the appropriate file.

2. In the File View toolbar, click Edit.

The system displays the Inspector view.

Related links
Viewer on page 118

Inspector
You can configure, change, and delete real time information elements in the Inspector view.
Inspector view is divided into four areas:

• The title bar

• The tool bar

• The elements

• The real time information

The title bar displays the Inspector view and the name of the real time information.

Related links
Real time Information module overview on page 113
Inspector toolbar icons on page 119
Changing real time information properties on page 120
Inspector pop-up menu field description on page 120
Real time information properties field descriptions on page 121
Size of the work area on page 122
Default type on page 122
Real time information sheet on page 123

Inspector toolbar icons
Icon Name Description

Save Saves the real time information data.

Cancel Cancels the current process and data is
not saved.

Properties Displays the properties of the real time
information.

Table continues…
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Icon Name Description
Realtime information files Toggles to the File View.

Full screen Toggles to full screen display.

Work area Toggles to the work area.

Switch on selection mode Activates the select mode.

Draw rectangle Activates the draw mode and you can
draw a rectangle.

Draw line Activates the draw mode and you can
draw a line.

Related links
Inspector on page 119

Changing real time information properties
About this task
Use this procedure to edit real time information properties. Real time information can consist of one
or more real time information sheets.

Procedure
1. In the Realtime Information files, click a file.

2. In the File View toolbar, click Edit.

3. In the Inspector view, do one of the following:

• Click the Properties  icon.

• In the real time information sheet right-click and select Properties.

4. Configure the properties.

5. Click OK.

Related links
Inspector on page 119

Inspector pop-up menu field description
You can use the elements to create the real time information in the Inspector view area. You can
drag and drop the elements to create real time information. You must also enter the settings of the
elements.

Real time Information module overview

February 2016 Using Avaya IP Office Contact Center for Windows 120
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


Name Description
Delete Deletes the selected element.
Properties Opens the properties of the selected element.

You can use the following functions:

Name Description
Mark all (Ctrl+A) Marks all elements.
Copy (Ctrl+C) Copies the selected element. You must save the elements before copying.

Otherwise errors might occur when copying.
Paste(Ctrl V) Pastes the selected element. The elements can overlap when pasting.

Related links
Inspector on page 119

Real time information properties field descriptions
Name Description
Realtime information file
Name Displays the name of the real time information file. You can

change the name of this file.
Type of default Displays the type of default. The options are:

• None

• Topic

• Agent group

• Agent

• Team

• Workplace

• PBX

• IVR
Size of work area Displays the size of the work area. You can configure the size

between 4 and 6,000 points with the following options:

• Width

• Height
Realtime information sheet
RT Information Displays the name of the real time information sheet and the order

of the real time information sheets with drag and drop.

Table continues…
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Name Description
Grid Displays a select operation to display or hide a grid. You can

define the size of the grid between 4 and 100 points with the
following options:

• Width

• Height
Presentation
Font Displays a list of available fonts.
Line Displays a list of drawing lines.
Background Displays the following options to change the background:

• Color: Displays the selected color. You can select a color from
a palette for the following settings in color selection:

- Labeling for text color.

- Dividing line for line color.

- Background color.

• Image: Displays the path of the selected image.

Related links
Inspector on page 119
Changing the color, line type, and line width on page 170
Background presentation on page 126

Size of the work area
You can configure the size of the work area for real time information in the real time information
Properties dialog box. To view real time information in full screen and to fit your monitor, configure
the size of the work area according to your resolution. When the size of the work area exceeds the
window size, the scroll bar is invisible.

Related links
Inspector on page 119

Default type
To create a real time information sheet for a certain type of object, you must select the correct
default type in the real time information sheet properties. For example, if you select agent groups as
the default type, you can create only real time information elements for agent groups on this real
time information sheet.

You can then configure a real time information element, such as agent status for AG (grid). If you
select agent group as <Default> in the properties , the system does not display agent group in
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Inspector view. Specifying <Default> defines that an agent group is displayed in the real time
information element.

You must select an agent group in the Viewer area.

Related links
Inspector on page 119

Real time information sheet
Each real time information sheet has a corresponding tab. Right-click the real time information sheet
and, you can add or delete real time information sheets. You can drag and drop the real time
information sheets to change the order.

Right-click the monitor sheet, and you can use the following functions to monitor leaves:

• Add RT information sheet
• Copy RT information sheet
• Insert RT information sheet
• Delete RT information sheet

Related links
Inspector on page 119

Real time information elements
To configure real time information windows, you must have real time information elements. Real
time information elements display in Inspector view. You can customize a real time information
window with the drag and drop option. You can edit the settings of an element.

You can use the following real time information elements with the Real time information module:

Name Description

Text element Label ( )

Value element ( )

Longest wait time (topic) [Telephony] ( )

Longest wait time ( topic) [E-mail] ( )

Hyperlink ( )

Email to contact ( )

Out of office notice ( )
Table continues…
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Name Description

Variable ( )

Variable ( )

Tag ( )

Tag ( )

Lists Agent status list (AG) [Telephony] ( )

Agent status list (AG) [E-mail] ( )

Agent status list (AG) [Chat] ( )

Agent status list (team) [Telephony] ( )

Agent status list (team) [E-mail] ( )

Agent status list (team) [Chat] ( )

Queue [Telephony] ( )

Queue [E-mail] ( )

Queue [Chat] ( )

Conversations per AG (topic) ( )

Number of opened emails per AG (topic) ( )

Skill combination ( )

Abandoned call list ( )

Tables Agent group table ( )

Dialer table ( )

Topic table ( )

IVR overview ( )

Graphics elements Image ( )

Group ( )

Bar chart ( )

Longest Wait Time (topic) [Telephony] ( )

Longest Wait Time (topic) [E-mail] ( )

Queue (topics) [Telephony] ( )

Waiting e-mails (topics) [Email] ( )
Table continues…
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Name Description

Individual status LED ( )

Individual status parser ( )

Pie chart ( )

Agent status (AG) ( )

Agent status (team) ( )

Phone state ( )

Active agents (AG) ( )

TSF (topic) ( )

TSF (team) ( )

Accept level (topic) ( )

Accept level per shift (topic) ( )

Network overflows [Telephony] ( )

Other elements Agent history ( )

Remote functions ( )

Internet browser ( )

Supervisor Emergency ( )

Related links
Real time Information module overview on page 113
Displaying or hiding elements on page 125

Displaying or hiding elements
About this task
The real time information elements are arranged in the left panel of the Inspector view in a tree
structure. You can display and hide real time information elements within the tree.

Procedure
1. In the Elements column, click the plus icon .

The system expands the tree to display the elements.

2. In the Elements column, click the minus icon .

The system collapses the tree to hide the elements.

Real time information elements

February 2016 Using Avaya IP Office Contact Center for Windows 125
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


Related links
Real time information elements on page 123

Configuring the properties of elements
Procedure

1. Right-click the element.

2. In the pop-up menu, click Properties.

3. In the Properties dialog box, configure the properties.

Related links
Real time Information module overview on page 113
Configuring the size elements on page 126
Background presentation on page 126
Hiding the title on page 127
Hiding the total on page 127
Configuring the column arrangement on page 127
Configuring the number of columns on page 128
Bar chart field descriptions on page 128
Configuring the presentation settings on page 129

Configuring the size elements
About this task
You cannot change the size of all real time information elements.

Procedure
1. Click the border of the element.

2. Use the mouse to drag and drop the border of the element to enlarge or reduce the size.

Related links
Configuring the properties of elements on page 126

Background presentation
You can select the background color for some real time information elements.

The Show borders option displays the real time information element with a border in Viewer view.
You can also select a figure or image as a background for certain real time information elements.
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You can select a color from a palette for the following settings:

• The labeling the text color
• The line color
• The background color

Related links
Configuring the properties of elements on page 126

Hiding the title
Procedure

1. Right-click the element, and in the pop-up menu, click Properties.

2. In the Properties dialog box, clear the Show title check box.

3. Click OK.

Related links
Configuring the properties of elements on page 126

Hiding the total
About this task
With the Table elements, you can display or hide total values.

Procedure
1. Right-click the element, and in the pop-up menu, click Properties.

2. In the Properties dialog box, select the Hide total check box.

3. Click OK.

Related links
Configuring the properties of elements on page 126

Configuring the column arrangement
About this task
You can adjust the arrangement of columns in a table. The real time information element displays
the information from the list of visible information.

Procedure
1. Right-click the element, and in the pop-up menu , click Properties.
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2. To move information from Available information to Visible information, click the Right
arrow icon .

3. To move information from Visible information to Available information, click the Left
arrow icon .

4. To move information in an upward direction, click Up.

5. To move information in a downward direction, click Down.

6. Click OK.

Related links
Configuring the properties of elements on page 126

Configuring the number of columns
About this task
You can control the number of columns automatically or define a set number of columns for some
real time information elements.

Procedure
1. Right-click the element, and in the pop-up menu, click Properties.

2. In the Properties dialog box, in the Number of columns, select one of the following:

• Automatic: To display the number of columns automatically.

• n columns: To display the number of columns according to the specified value n.

3. Click OK.

Related links
Configuring the properties of elements on page 126

Bar chart field descriptions
Name Description
Presentation The options are:

• Font: Modifies the font style, size, and color.

• Background: Configures the background color.
Threshold
Threshold values The options are:

• Alarm: After the value exceeds the alarm
threshold, the bar color changes to red.

Table continues…
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Name Description
Warning: After the value exceeds the warning
threshold, the bar color changes to yellow.

The default settings are green or blue for OK, yellow
for warning, and red for alarm. You must enter a
whole number value. When entering a time, you
must enter the value in seconds. For example, 240
for 4 minutes.

Range The options are:

• Min

• Max

You can set the minimum and maximum values for
the display range. The value of the real time
information element is displayed within these limits.
You must enter a whole number value. When
entering a time, you must enter the value in seconds.
For example, 240 for 4 minutes.

Related links
Configuring the properties of elements on page 126

Configuring the presentation settings
Procedure

1. Click the element.

2. In the Properties dialog box, click Presentation.

3. Configure the presentation settings.

4. Select Options.

5. Click OK.

Related links
Configuring the properties of elements on page 126

Text elements
The Text elements displays, for example, the alphanumeric statuses of the objects, the references,
or the titles of areas.

Related links
Real time Information module overview on page 113

Text elements
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Labels on page 130
Value elements on page 130
Longest wait time for multiple topics on page 131
Hyperlink on page 131
Email to contact on page 131
Out of office notice on page 133
Variable on page 133
Tag display on page 135

Labels
The Label element is a text element for titles or designating areas. You can adjust the size of the
element and also change the text properties.

Example
The following is an example of a label:

Related links
Text elements on page 129

Value elements
The Value element is in an alphanumeric display that displays the actual value and an abbreviation
of the value.

The abbreviations of the task types are:

• [T] for Telephony

• [E] for Email

• [C] for Chat

With the Value element, you can:

• Adjust the size.
• Select an object.
• Hide the label or abbreviation.
• Change the text properties.
• Change the background color.

Related links
Text elements on page 129
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Longest wait time for multiple topics
The Longest wait time element displays the value for multiple topics.

The abbreviations of the task types are:

• [T] for Telephony

• [E] for Email

With the Longest wait time element, you can:

• Adjust the size.
• Select one or more topics.
• Hide the label or abbreviation.
• Change the text properties.
• Change the background color.

Related links
Text elements on page 129

Hyperlink
The Hyperlink element links multiple real time information sheets with references. If a link refers to
another real time information sheet and if the sheet changes to alarm status, the system displays a
signal with flashing text.

With the Hyperlink element, you can:

• Adjust the size.
• Change the text properties.
• Change the background color.
• Type the text to display.
• Select a real time information element file, a real time information sheet, or a URL as the link.

Related links
Text elements on page 129

Email to contact
The Email to contact element opens the Email module, and a new email is created in the edit
mode. The fields To and Subject are automatically set with tags. You can use Email to contact
element to send an email to the caller. For example, during a conversation or in the wrap-up time.
The email address and subject are configured with tags.

Text elements
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With the Email to contact element, you can:

• Adjust the size.

Change the text properties.

Change the background color.
• Hide the borders.
• Tag for To: Specifies to select a tag for the recipient. The content of the tag is copied into the

To field of the new email.
• Tag for Subject: Specifies to select a tag for the subject. The content of the tag is copied into

the Subject field of the new email.

Related links
Text elements on page 129
Using email functions on page 132

Using email functions
About this task
Use this procedure to use Email function with all the features.

Procedure
1. Create two tags according to the following example:

• Tag names:

- email_contact_subject

- email_contact_to

• Type: Custom

• Data type: String

2. (Optional) Set the tags in an IVR script.

3. Create a Task flow.

You can create a corresponding Tasktag operation.

4. Create the Telephony.

You can also set the monitor for an agent in a profile. An agent can use the function. In the
customer history view, the same function can be used through a context menu (Email to
create). The condition is that the customer has had an email contact and is configured as a
customer.

Related links
Email to contact on page 131
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Out of office notice
In the Out of office notice element, you can enter a notice in display mode. The input field contains
more than one line and up to 254 characters. You can use this element in the agents Home or
Telephony area. The supervisor can see the agents Out of office notice in the supervisor Out of
office notice area.

Only a logged in agent can enter an out of office notice.

With the Out of office notice element, you can:

• Adjust the size.
• Select an agent, <Default> or <Logged-in user>.
• Hide the title.
• Change the text properties.

Change the background color.
• Hide the borders.

Exit out of office notice
To change an Out of office notice for other users, you need the following privileges:

• Real time information: Out of office notice.
• Variables: Agents.

Related links
Text elements on page 129

Variable
In the Variable element, you can select a variable, configure a minimum and a maximum value,
hide the slide control, and start a marquee. You can choose between two different presentations
with name and value, or a window display.

With the Variable element, you can:

• Adjust the size.

Change the text properties.
• Change the background color.
• Hide the borders.

Variable selection
A Variable selection displays:

Text elements
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Name Description
Select variables Selects a variable.
Can be edited Displays or hides the slide control. If the slider is hidden, the real time information

element displays only the numeric value.
Display as marquee Selects the display as marquee. If the text is longer than the space available, the

text is automatically presented as marquee.
Values Specifies a minimum and a maximum value for the variable. You can change the

variable in display mode.
Use horizontal slider Displays or hides a horizontal slider.
Use vertical slider Displays or hides a vertical slider.

Changing a variable in Display mode
The Variable element in display mode, displays a value. You can change the value with the slider
and save the changes.

If a value is outside the valid range of values, the system displays a dialog box with the message
that the entered value is invalid and that the value is corrected.

Name Description
Verifies the specified value. For example, the value can be used in the task flow set.

Cancels the specified value. The system displays the last saved value.

Prerequisites
You must have the following prerequisites to change a variable:

• Set the minimum and the maximum values for the properties of the element.
• Use and evaluate the variable in the active task flow set, if the call distribution is affected by

changing the variable.

Related links
Text elements on page 129
Setting values for variable elements on page 134

Setting values for variable elements
Before you begin
Start the edit mode.

Procedure
1. Right-click the element and click Properties.

2. In the Properties dialog box, click Selection > Select variable.

3. (Optional) Select Can be edited.

4. (Optional) Select Display as marquee.

5. In the Values tab, enter the minimum and maximum values.
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6. (Optional) Select Use horizontal slider or Use vertical slider.

7. Click OK.

Related links
Variable on page 133

Tag display
The Tags element displays all tags of received calls. The system displays a tag as an informational
unit that is attached to a call. A tag accompanies a call even if, for example, you forward the call.
Tag information consists of values or texts. The distribution can query the information of a tag and
take the tag into account. You can display and edit the value of a tag with the Tag element. In IP
Office Contact Center system, there are two types of tags, namely system tags and user-defined
tags. The system tags are prepared in the IP Office Contact Center system and are always attached
to a call.

With the Tag element, you can:

• Adjust the size.
• Select a tag.
• Change the display name.
• Choose whether a value can be edited.
• Change the text properties.
• Change the background color.
• Hide the borders.

Related links
Text elements on page 129

Lists
Related links

Real time Information module overview on page 113
Agent status list on page 136
Calls in queue on page 138
Number of conversations (AG) (topic) on page 139
Number of opened emails per AG on page 140
Skill combination on page 140
Abandoned Call list on page 141
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Agent status list
You can configure the Agent status list element for an agent group and a team for telephony,
email, and chat.

With the Agent status list element, you can:

• Displays Realtime information.
• Adjust the size.
• Select an agent group or <Default>.
• Hide the title.
• Display information to authorized users only.
• Select the display content of all agents or only present agents.
• Customize the column arrangement.
• Change the text properties.
• Change the background color.

Sorting restrictions
You can sort any column in an ascending or a descending order. Columns are organized in two
groups:

• The first group displays the properties and the states of displayed agents and contains exactly
one row for each agent.

• The second group displays the processed task types of each agent. An agent can process
more than one task types, while the output can be more than one row for each agent.

.

You can sort columns only of the first group, because the different task types of an agent cannot be
presented coherently.

Related links
Lists on page 135
Visible columns field descriptions on page 136
Display range field descriptions on page 138

Visible columns field descriptions
Visible agent columns
Name Description
Name Displays the agents name.
Login state Displays the login status of agents. The options are:

• No display: The agent is not logged in.
Table continues…
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Name Description
• Pres.: The agent is logged in.

• ACD: The agent is signed in to call distribution.

• P: The agent is on a break.
W. state dura Displays the current duration of the displayed state. For example, displays how long an

agent has been on the phone with an ACD call.
W. state Displays the work state of agents. The options are:

• Avail: The agent is available.

• Busy: The agent is busy and the number of ACD call is displayed.

• ACD: The ACD conversation.

• Wrap Up: The agent is finished with conversation and is on wrap up.
TNo Displays the physical number of the terminal.
Break time
code

Displays the reason code for a break.

OutOfOrder Displays that the agent is no longer available.
Reserve Displays the name of the agent that the task is reserved for.

Visible task columns
Name Description
Term state Displays the state of the terminal. The options are.

• Available: Displays the number of calls and agents available.

• Off-hook: Displays that the handset is off-hook.

• Call : Displays a call.

• Conn: Displays that a call is connected.

• Hold: Display that the connection is on hold.

• bTone: Displays a busy tone.

• Fault: Displays the terminal fault.
int/ext Displays int for an internal connection or ext for an external connection.
Directiond Displays incom for an incoming connection or outg for an outbound

connection.
ACD Displays if the call is distributed through call distribution in ACD.
Topic Displays the current topic that the agent is working for.
AG Displays the current agent group that the agent is working for.
Task.dura. Displays the current duration of the displayed terminal state.

Related links
Agent status list on page 136

Lists
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Display range field descriptions
Right-click a line in the display range to open a selection box to select the following options:

Name Description
Sign on to AG To sign in to an agent group in Telephony and Email.
Sign out of AG To sign out of an agent group in Telephony and Email.
Login To log in to a telephone.
Logout To log out from a telephone.
Out of Office To enter an out-of-office notice in a dialog box.
Break Time To set an agent to go for a break. You can select a

break code in the submenu when required.
End Break Time To end the break state of an agent.

Related links
Agent status list on page 136
Display range field descriptions on page 138

Calls in queue
The Queue element displays the calls in the queue of the selected topic. You can display the tags or
information of the calls in the real time information element. The tag display retains the value when
the call enters the queue and does not change when the tags are updated dynamically. For
example, tag operations in the task flow.

With the Queue element, you can

• Displays Realtime information.
• Adjust the size.
• Change the text properties.
• Change the background color.
• Hide the title.
• Select a topic or <Default>.
• Customize the column arrangement.

Related links
Lists on page 135
Queue data field description on page 139
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Queue data field description
Name Description
No. Displays the phone number of the caller.
Topic Displays the dialed-in topic.
Ln Displays the line number.
TT Displays the time-in topic.
Announcement Displays the kind of connected announcement. The options are:

None, Interruptible, and Not interruptible.
Announc. scripts Displays the name of a connected announcement.
TCS Displays the time in the current state.
reserv.for Displays the name of the agent that the entry is reserved for.
Tag Displays the option to select one or more tags.
Address Displays the email address of the sender.
TQueued Displays the wait time of an email.

Related links
Calls in queue on page 138

Number of conversations (AG) (topic)
The Number of conversations (AG) (topic) element displays the number of established calls
(TEC) for the selected topic broken down into agent groups (AG). The names of the agent groups
with the respective numbers of calls are displayed in a table. The values are reset to 0 at the end of
the calculated period like TSF, which is set to 100% at the end of the configured time frame. You
can display an additional total line. You can choose whether to display AG or TEC in the first
column.

With the Number of conversations (AG) (topic) element, you can:

• Displays Realtime information.
• Adjust the size.
• Select a topic or <Default>.
• Hide the title.
• Hide the total line.
• Display information to authorized users only.
• Change the text properties.
• Change the background color.

Related links
Lists on page 135
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Number of opened emails per AG
The Number of opened emails per AG (topic) element displays the number of open emails
(totNAccE) for the selected topic broken down into agent groups (AG). The names of the agent
groups with the respective numbers of emails are listed in a table. The values are reset to 0 at the
end of the calculated period like TSF, which is set to 100% at the end of the configured time frame.
You can display an additional total line. The interval begins independent of the email activation for
the number of open emails (totNaccE) counter. For example, an interval of 1 minute starts when an
email activates after 40 seconds. The number of open emails (totNAccE) counter must be 1 minute
only for 20 seconds. After that the counter must decrease to 0 because the system starts with
another interval. You can choose whether to display AG or totNaccE in the first column.

With the Number of opened emails per AG (topic) element, you can:

• Displays Realtime information.
• Adjust the size.
• Select a topic or <Default>.
• Hide the title.
• Hide the total line.
• Display information to authorized users only.
• Change the text properties.
• Change the background color.

Related links
Lists on page 135

Skill combination
The Skill combination element displays the skill combinations.

With the Skill combination element, you can:

• Displays Realtime information.
• Adjust the size.
• Hide the title.
• Hide the total line.
• Customize the column arrangement.
• Change the text properties.
• Change the background color.

Related links
Lists on page 135
Skill combination field description on page 141
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Skill combination field description
Name Description
request Displays the number of requested combinations.
Skill combination Displays all skills of the combinations.
reduc Displays the number of reduced combinations.
new rout Displays the number of newly routed combinations.
serv Displays the number of served combinations.
overfl Displays the number of overflow combinations.
n.serv Displays the number of unserved combinations.

Related links
Skill combination on page 140

Abandoned Call list
The Abandoned Call list element displays the call list of the selected topic.

With the Abandoned Call list element, you can:

• Displays Realtime information.
• Adjust the size.
• Select a topic or <Default>.
• Hide the title.
• Hide the total line.
• Customize the column arrangement.
• Change the text properties.
• Change the background color.

Related links
Lists on page 135
Call list field descriptions on page 141

Call list field descriptions
Name Description
No Displays the phone number of the caller.
SysAC Displays the number of connections canceled by the system.
ExtAC Displays the number of connections canceled by an external party

before answering a call.
Date Displays the date of the last call.

Table continues…
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Name Description
Time Displays the time of the last call.
Callno. blocked Displays the option of No or Yes.

Yes means that the number is blocked for callback. When an agent calls
the subscriber or is having a conversation with the subscriber, then the
entry is blocked for a callback.

Name Displays the name of the caller.

You can use the following functions in the call list:

Name Description
Print You can right-click on the call list and click Print in the context menu.

The system displays that the entire call list is printed.

Related links
Abandoned Call list on page 141

Tables
The Table element displays states and values of an object, for example, agents in rows and
columns. You can configure the columns with the properties of the real time information and hide the
headings for tables, if required. The heading of a table displays the name of the object and the
name of the real time information.

The abbreviations of the task types are:

• [T] for Telephony

• [E] for Email

• [C] for Chat

Related links
Real time Information module overview on page 113
Agent group table on page 142
Dialer table on page 143
Topic table on page 143
IVR overview on page 144

Agent group table
The Agent group table element lists, agent groups and the available information. You can
configure different values.
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With the Agent group table element, you can:

• Displays Realtime information.
• Adjust the size.
• Hide the title.
• Hide the total line.
• Hide the details.
• Display information to authorized users only.
• Select one or more agent groups.
• Customize the column arrangement.
• Change the text properties.
• Change the background color.

Related links
Tables on page 142
Agent group values field descriptions on page 165

Dialer table
The Dialer table element lists, agent, topic, or campaign dialers and available information. You can
configure different values.

With the Dialer table element, you can:

• Displays Realtime information.
• Adjust the size.
• Hide the title.
• Hide the total line.
• Hide the details.
• Select agent, topic, or campaign dialers.
• Customize the column arrangement.
• Change the text properties.
• Change the background color.

Related links
Tables on page 142
Dialer field description on page 167

Topic table
The Topic table element lists topics and available information. You can configure different values.

Tables
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With the Topic table element, you can:

• Displays Realtime information.
• Adjust the size.
• Hide the title.
• Hide the total line.
• Hide the details.
• Display information to authorized users only.
• Display name or number.
• Select one or more agent groups.
• Customize the column arrangement.
• Change the text properties.
• Change the background color.

Related links
Tables on page 142
Topic values field description on page 162

IVR overview
The IVR overview element lists IVR information. You can configure different values.

With the IVR overview element , you can:

• Displays Realtime information.
• Adjust the size.
• Hide the title.
• Hide the total line.
• Hide the details.
• Select one or more voice units.
• Customize the column arrangement.
• Change the text properties.
• Change the background color.

Related links
Tables on page 142
IVR field descriptions on page 167
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Graphics elements
You can use graphic elements to customize real time information.

Related links
Real time Information module overview on page 113
Image on page 145
Group on page 146
Bar chart on page 146
Longest Wait Time for telephony and email topics on page 147
Queue on page 147
Waiting emails on page 148
Individual status LED on page 148
Individual status parser on page 149
Pie chart on page 150
Agent status on page 151
Phone state on page 154
Chart on page 154
Network overflows on page 156
Agent History on page 157
Remote functions on page 157
Internet browser on page 160
Supervisor Emergency on page 160

Image
In theImage element, you can insert various graphics, images, or image elements.

The following formats are possible:

• *.bmp
• *.jpg
• *.gif
• *.png

With the Image element, you can:

• Adjust the size.
• Select a graphics file.
• Hide the borders.
• Choose a title.

Related links
Graphics elements on page 145
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Hyperlink on page 131

Group
In the Group element, you can graphically combine multiple real time information elements.

With the Group element, you can:

• Adjust the size.
• Hide the title.
• Specify the title.
• Change the font properties.
• Change the background color.

Related links
Graphics elements on page 145

Bar chart
A Bar chart visualizes a value with the help of a bar. If the value exceeds a certain limit value, the
system changes the bar color. The bar turns yellow in the event of a warning. The bar turns red in
the event of an alarm. The threshold points display in a dotted line.

You can select the following objects:

• Topic
• Agent
• Agent group
• Team
• PBX
• IVR

With the Bar chart element, you can:

• Adjust the size.
• Hide the title.
• Change the font properties.
• Change the background color.
• Select an object, for example, Agent group.
• Select a value.

Enter the threshold values for alarm and warning, and the minimum and maximum values for the
display range of the bar. You must enter a whole number. When entering a time, you must enter the
value in seconds, for example, 240 for 4 minutes.
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Related links
Graphics elements on page 145

Longest Wait Time for telephony and email topics
The Longest Wait Time (topic) element for Telephony and Emails displays the selected topics in
the bar chart. If the value exceeds a certain limit value, the system changes the bar color. The bar
turns yellow in the event of a warning. The bar turns red in the event of an alarm. The threshold
points are displayed in a dotted line.

With the Longest Wait Time (topic) element, you can:

• Adjust the size.
• Hide the title.
• Change the font properties.
• Change the background color.
• Select topics.

Enter the threshold values for alarm and warning, and the minimum and maximum values for the
display range of the bar. You must enter a whole number. When entering a time, you must enter the
value in seconds, for example, 240 for 4 minutes.

Related links
Graphics elements on page 145

Queue
The Queue element displays the number of calls in a queue for the selected topics in bar chart. The
waiting calls of all selected topics are added up.

With the Queue (topics) [Telephony] element, you can:

• Adjust the size.
• Hide the title.
• Change the font properties.
• Change the background color.
• Select topics.

Enter the threshold values for alarm and warning, and the minimum and maximum values for the
display range of the bar. You must enter a whole number.

Related links
Graphics elements on page 145
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Waiting emails
The Waiting emails (topics) [Email] element displays the number of selected topics in the bar
chart. The system adds up the queued emails of all selected topics.

With the Waiting emails (topics) [Email] element, you can:

• Adjust the size.
• Hide the title.
• Change the font properties.
• Change the background color.
• Select topics.

Enter the threshold values for alarm and warning, and the minimum and maximum values for the
display range of the bar. You must enter a whole number.

Related links
Graphics elements on page 145

Individual status LED
The Individual status LED element displays the status of a value or an object, such as an agent
group. The event is displayed as an LED. If the value exceeds a certain limit value, the LED
changes color and shape.

View option displays the following LED status:

Icon Name Description
Green square Displays that the status of a value

or an object is within a certain
limit.

Yellow triangle Displays a warning.

Red circle Displays an alarm.

With the Individual status LED element, you can:

• Adjust the size.
• Select an object, for example, Agent group.
• Select a value for the object, for example, the number of active agents.
• Select an agent group.
• Hide the title.
• Change the font properties.
• Change the background color.
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Enter the thresholds for alarms and warnings, and also the minimum and maximum values for the
displayed area of the bar. Type the values in seconds, for example, 240 for 4 minutes.

Related links
Graphics elements on page 145

Individual status parser
The Individual status parser element displays the status of a value or an object, such as an agent
group. The event is displayed as an LED. If the value exceeds a certain limit value, the system
changes the LED color.

View option displays the following LED status:

Icon Name Description
Green square Displays that the status of a value

or an object is within a certain
limit.

Yellow triangle Displays a warning.

Red circle Displays an alarm.

With the Individual status parser element, you can:

• Adjust the size.
• Hide the title.
• Enter the title.
• Change the font properties.
• Change the background color.

Related links
Graphics elements on page 145
Parser configuration field descriptions on page 149
Configuring the parser properties on page 150

Parser configuration field descriptions
You can use up to 245 characters for each option.

Name Description
Name Displays the name.
Warning Displays the field to enter the values for a warning.
Alarm Displays the field to enter the values for an alarm.
Operators Displays the option to select different operators.
Variable Displays the option to select different variables.

Table continues…
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Name Description
Objects Displays the following options:

• AG

• Topic

Related links
Individual status parser on page 149

Configuring the parser properties
About this task
Use this procedure to configure the parser properties for a warning and to configure an alarm.

Before you begin
Start the edit mode.

Procedure
1. Right-click the real time information, and click Properties.

2. In the Properties dialog box, click the Parser configuration tab.

3. (Optional) Select the Name check box and type a name.

4. Click Warning.

5. In the Objects tab, click AG or Topic.

The system displays a lists of different values for the objects.

6. Click the Variable tab.

7. In the Variable selection dialog box, double-click a value or click an object and click OK.

8. In the Operators tab, double-click an operator.

The system displays the operator value in the Warning field.

9. Enter a value.

You must enter a whole number. To enter a duration, specify a value in seconds, for
example, 240 for 4 minutes.

10. Click OK.

Related links
Individual status parser on page 149

Pie chart
In the Pie chart element, you can display different values for individual agents or agent groups.
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With the Pie chart element, you can:

• Adjust the size.
• Hide the title.
• Select an agent or an agent group as the object.

You can select the following values for a pie chart:

• Overview for an agent (telephony and email)
• Overview for an agent group (telephony)
• Overview for an agent group (email)

Pie chart colors for agent groups
You can display agent group states in different colors and also customize colors for every agent.
You can define colors for system, profile, or agent states.

If no colors are defined for the agent, the system displays the profile colors. If no colors are defined
for the profile, the system displays the system colors.

Related links
Graphics elements on page 145
Key and pie chart color on page 230

Agent status
A real time information grid display displays the agent status for agent group and team. A button is
assigned to each agent. The color of the button indicates the state of the agent. The states
displayed in the Realtime information element are preset. You can also use the buttons for special
actions. For example, sign on and sign off.

With the Agent status element for Agent Groups and Team, you can:

• Adjust the size.
• Hide the title.
• Change the font properties.
• Select the agent group or team.
• Display information to authorized users only.
• Call an agent with a double-click.
• Display a number instead of a name.
• Select if all agents or only present agents must be listed.
• Adjust the skill filter.
• Select the number of columns.
• Select the layout.

Related links
Graphics elements on page 145

Graphics elements

February 2016 Using Avaya IP Office Contact Center for Windows 151
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


Key color field description on page 152
Agent status field descriptions on page 152
Display range field descriptions on page 138

Key color field description
The color of the keys displays the status of the agent. Key colors can be customized for every
agent.

The following table is an example of the default key color setting:

Color Status Description

Light gray ACD unavailable and logged out Displays that the agent is not
present and not signed in.

Gray ACD inactive Displays that an agent is present
but not signed in.

Green ACD active Displays that the agent is on the
phone with an established ACD
call.

Yellow ACD and non ACD available Displays that an agent is available.

Orange Signal status of non ACD Displays that the agent is not on
the phone with an established
ACD call.

Related links
Agent status on page 151
Key and pie chart color on page 230
Display range field descriptions on page 138

Agent status field descriptions
In the display range, click the Legend icon  to display a list of the different agent statuses. You
can customize the key color for every agent.

The following table is an example of the default key color for possible agent status:

Icon Icon color Key Color Status Description
Gray Light gray Absent Displays that an agent is not

present and is not signed in.
Red Light gray Out of service Displays that the telephone is out

of service.
Red Light gray Call diversion

set
Displays that call diversion is set.

Black Gray Present,
signed off

Displays that an agent is present
but not signed in to all agent
groups.

Table continues…
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Icon Icon color Key Color Status Description
Black Gray Break Time Displays that an agent is on a

break.
Red Gray Signed off by

system
Displays that an agent was signed
off due to an exceeded ring time
out.

Orange Gray Wrap Up
without call

Displays that the agent is in
manual Wrap Up.

Black Gray Present, non-
ACD
conversation

Displays that an agent is not
signed in for ACD calls and is
conducting a non-ACD call.

Black Gray Present, non-
ACD ringing

Displays that an agent is not
signed in and is receiving a non-
ACD call.

Black Gray Present, non-
ACD outgoing
call

Displays that an agent is busy with
ACD calls. An agent calls a
subscriber and conducts a non-
ACD call.

Black Orange Non-ACD
conversation

Displays that the agent is on the
phone but not with an ACD call.

Green Orange Non-ACD
ringing

Displays that an agent is receiving
a call, but not on an ACD call.

Red-orange Orange Non-ACD,
Wrap Up
without call

Displays that the agent is on the
phone with a non-ACD call during
manual Wrap Up.

Green Orange No ACD call
during Wrap
Up

Displays that an agent is in Wrap
Up and is executing a non-ACD
call.

Black Orange Outgoing non-
ACD

Displays that an agent is logged in
for ACD calls. An agent calls a
subscriber and conducts a non-
ACD call.

Green Yellow Available Displays that an agent is available.

Red Yellow ACD blocked Displays that an agent is blocked
for ACD calls.

Green Green Wrap Up with
call

Displays that the agent is in Wrap
Up for an ACD call.

Green Green ACD ringing Displays that an agent is receiving
an ACD call.

Black Green ACD
conversation

Displays that the agent is on the
phone with an ACD call.

Black Green ACD outgoing Displays that the agent is
conducting an outbound ACD call.

Table continues…

Graphics elements

February 2016 Using Avaya IP Office Contact Center for Windows 153
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


Icon Icon color Key Color Status Description
Green Green Preview Displays that the dialer has routed

a call to an agent.
Gray Green email in the

inbox
Displays that the agent inbox
contains an email.

Green Green email being
progressed

Displays that the agent is
processing an email.

Black Green email
interrupted /
deferred

Displays that the agent has
interrupted or deferred an email.

Green Green Logged off,
email in the
inbox

Displays that the agent is logged
out and has an email in the inbox.

Green Green Pause, email
in the inbox

Displays that the agent is on a
break and has an email in the
inbox.

Related links
Agent status on page 151
Key and pie chart color on page 230
Display range field descriptions on page 138

Phone state
In the Phone state for telephone group, you can choose to display the name of the customer or the
telephone number. The name must be configured in the telephones.

Related links
Graphics elements on page 145
Agent status on page 151

Chart
You can use a graphic display to observe how values change with time. A graphic display displays
the time on the X-axis (T) and the range of the value on the Y-axis. A curve displays the
progression. The title of the graphic displays the object and the name of the real time information.

The abbreviations of the task types are:

• [T] for Telephony
• [E] for Email

With the Chart element , you can:

• Adjust the size.
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• Hide the title.
• Select an object.
• Change the Axis label properties.
• Change the background color.
• Change the chart colors.
• Adjust the scale for the X-axis and Y-axis.

Chart configuration
You must define various options when configuring a chart.

• Active agents (AG)
• TSF (topic)
• TSF (team)
• Accept level (topic)
• Accept level per shift (topic)

Related links
Graphics elements on page 145
Realtime information tab field descriptions on page 155
Chart tab field descriptions on page 155
Axes tab field descriptions on page 156
Scaling tab field descriptions on page 156

Realtime information tab field descriptions
Name Description
AG or Topic or Team Displays the option to select an object or <Default>.
Show label Displays the name of the selected title.

Related links
Chart on page 154

Chart tab field descriptions
Name Description
Graph Displays the following options that you can select:

• Line color

• Fill color

• Chart background
Background Displays an option to select the Window background color.

Related links
Chart on page 154

Graphics elements

February 2016 Using Avaya IP Office Contact Center for Windows 155
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


Axes tab field descriptions
Name Description
Axis labels Displays the label properties.
Axis value display Displays the properties of the axis value display.
Axis width and color Displays the line width and the color of the axes.

Related links
Chart on page 154

Scaling tab field descriptions
Name Description
Y-axis Displays the options of the Y-axis:

• No. of increments

• No. of marks for increments
X-axis Displays the option to enter a time when a mark with a value displays on the X-axis.

You can enter time from minimum 00:01 hour to maximum 23:59 hours. The options
are:

• Value interval

• Scale interval

Related links
Chart on page 154

Network overflows
The Network overflows [Telephony] element displays the network overflow of the configured
PBXs in tabular form. Individual network overflows are displayed as bars. You can set the minimum
and maximum values for the limit values. The default minimum value is 0 and the maximum value is
100.

With the Network overflows [Telephony] element, you can:

• Displays Realtime information.
• Adjust the size.
• Hide the title.
• Hide the total line.
• Hide the details.
• Select one or more PBXs.
• Customize the column arrangement.
• Change the text properties.
• Change the background color.
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• Enter limit values for the bar chart.

Related links
Graphics elements on page 145
Network overflows field descriptions on page 157

Network overflows field descriptions
Name Description
PBX Displays the name of the PBX.
Overfl. to X Displays the overflow of the X PBX.
Overfl. to Y Displays the overflow of the Y PBX.
Total Displays the total overflows.
Hide title Hides the title name.
Hide total Hides the total column.
Hide details Hides the PBX details.
Limit values bar chart Displays the limit values. The options are:

• Minimal value: Enter a mininum value.

• Maximum valu: Enter a maximum value.

Related links
Network overflows on page 156

Agent History
The Agent History element displays the already processed customer contacts and only call center
relevant contacts that are calls, emails, and chat requests. You can use the agent history in the
Home and Realtime information module. All topics calls, incoming calls, outgoing calls, and topics
started by the dialer calls are included for the task type telephony.

For more information about Agent history, see System administration handbook.

Related links
Graphics elements on page 145

Remote functions
The Remote functions element displays all configured agents in real time. If the agent is logged in
on a terminal, the physical number of the terminal and the configured agent groups are displayed.
You can also log agents in or out of agent groups, or selectively to an individual group. You can set
an agent to break time. When a break time code is required, you can select a break time code from
the sub menu. You can also end the break time of an agent.

Graphics elements
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With Remote functions element, you can:
• Adjust the size.
• Change the font properties.

Related links
Graphics elements on page 145
Remote function icons field description on page 158
Logging in an agent on page 158
Logging out an agent on page 159
Signing in to agent groups on page 159
Signing off from agent groups on page 159

Remote function icons field description
Icon Name Description

Gray circle with an x Displays that an agent is not logged in.

Yellow circle Displays that an agent is logged in, but is not signed in to any
agent group.

Green circle Displays that an agent is logged in, but is not signed in to all agent
groups.

Green circle with hook Displays that an agent is logged in and signed in to all agent
groups.

Cup Displays that an agent is logged in, but is on a break.

Related links
Remote functions on page 157

Logging in an agent
Before you begin
Get access to the Remote functions privilege.

Procedure
1. Right-click the agent.

2. Click “agent” log in.

3. In the Telephone selection dialog box, click one of the following:

• terminal
• telephone number

The system displays a list of all physical numbers of the terminals. Busy terminals are not
listed.

4. Click OK.

The system displays that the agent is logged in to the terminal.
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Related links
Remote functions on page 157

Logging out an agent
Procedure

1. Right-click the agent.

2. Select Log out "agent”.

The system displays that the agent is logged out.

Related links
Remote functions on page 157

Signing in to agent groups
About this task
Use this procedure to log in an agent to all assigned agent groups or a specific agent group.

Before you begin
Get the Remote functions privilege.

Procedure
1. Right-click the agent.

2. Click Sign on "agent" to all AGs.

The system automatically logs in the agent to all assigned agent group.

3. To log in to specific agent groups, right-click the agent.

The system displays a menu of all agent groups. A check mark in the menu displays that the
agent is already logged in to that agent group.

4. In the agent menu, select the respective agent groups.

The system displays that the agent is logged in to the selected agent groups, which is
indicated by a green circle.

Related links
Remote functions on page 157

Signing off from agent groups
About this task
Use this procedure to log out an agent from all assigned agent groups or specific agent group.

Procedure
1. Right-click the agent.

2. Click Sign off agent from all agent groups.
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The system automatically logs out the agent.

3. To log out from specific agent groups, do the following:

a. Right-click the agent.

b. In the agent menu, clear the check box for the appropriate agent groups.

The system logs out the agent from the selected agent groups.

Related links
Remote functions on page 157

Internet browser
You can add an Internet browser to real time information. You can specify a fixed URL or
determine the URL with a tag. You must install Microsoft Internet Explorer 6.0 or later to use the
Internet browser contact element.

Format for URL
You can enter a fixed URL. For example: http://www.avaya.com/.

You can also read the URL from a tag. Use the following format for the URL tag:

xyz%TAGNAME%xyz

You can add URLs. For example, if there is one URL for each topic, conversation guidelines can be
conveniently displayed. Example:http://www.avaya.com/product/%c.dialledTheme%/
Guidelines.html.

With the Internet browser element, you can:

• Adjust the size.
• Hide the title.
• Enter a URL or read it from a tag.

Related links
Graphics elements on page 145

Supervisor Emergency
An agent can request supervisor support during a call. The Supervisor Emergency element has
two types of support, silent monitoring and active participation in the call.

A supervisor in the IP Office Contact Center system monitors more than one agent. The Supervisor
Emergency element notifies the supervisor of the agents that require support.

The IP Office Contact Center User Interface for Windows application activates a signal on the
supervisor interface when an agent requests supervisor support. If the supervisor is available, the
agent can get supervisor assistance. A supervisor can only provide active support to one agent at a
time.
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Important:
Supervisor Assistance and Coaching is not currently supported in IP Office Contact Center.

With the Supervisor Emergency element, you can:

• Adjust the size.
• Hide the title.
• Insert or delete the agent groups or agents, and sort them up or down in a sequence.
• Select the display content of all agents or only the agents present.
• Set or automatically display the number of columns.
• Change the font properties.
• Change the background color.
• Use a scroll bar.

Related links
Graphics elements on page 145
Key color of agent status field description on page 161
Supervisor display range field descriptions on page 161

Key color of agent status field description
Name Description

Gray Displays that support is not requested by the agent.

Orange Displays that an agent requires support.

Green Displays that the supervisor is assisting the agent.

Related links
Supervisor Emergency on page 160

Supervisor display range field descriptions
Name Description
Silent Monitoring Enables the supervisor to monitor the active conversation of an agent. Neither

agent nor caller can hear the supervisor with the Silent monitoring function.
Emergency Enables the agent to request assistance from the supervisor. The supervisor can

take part in the conversation using the Emergency function.

Related links
Supervisor Emergency on page 160
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Values
You must select values for the following realtime information elements:

• Value elements

• Bar chart

• Individual status element

Related links
Real time Information module overview on page 113
Topic values field description on page 162
Agent values field descriptions on page 164
Agent group values field descriptions on page 165
Team field description on page 166
PBX field description on page 167
IVR field descriptions on page 167
Dialer field description on page 167
Lines field description on page 168
Inserting and deleting objects on page 169
Drawing a line on page 169
Drawing a rectangle on page 170
Switching on the selection mode on page 170
Changing the color, line type, and line width on page 170
Selecting and deleting drawn elements on page 171

Topic values field description
Name Description
NQueued[T] Displays the number of calls waiting in Telephony.
maxTQueued[T] Displays the maximum wait time in Telephony.
avgTQueued[T] Displays the average wait time of calls in the queue in Telephony.
avgTQueuedInterv[T] Displays the average wait time during the period under

consideration or interval in Telephony.
totNAbanDyn[T] Displays the number of unanswered calls during the period under

consideration or dynamic calculation in Telephony.
totNAbanInterv[T] Displays the number of unanswered calls during the period under

consideration with reference to an interval in Telephony.
TSFDyn[T] Displays the task service factor with reference to dynamic

calculation in Telephony.
TSF[T] Displays the current Task Service Factor in Telephony.

Table continues…
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Name Description
totNTSF[T] Displays the total number of calls for Task Service Factor

calculation that is for Telephony.
totNTSF+[T] Displays the total number of positive calls for Task Service Factor

calculation in Telephony. Positive calls are calls that resulted in a
discussion.

totNdoneInterv[T] Displays the number of processed tasks during the period under
consideration or updated periodically in Telephony.

totFDoneInterv[T] Displays the processing factor. Ratio of processed to deleted
tasks during the period under consideration or updated
periodically in Telephony.

totNDoneShift[T] Displays the number of conversations in each shift in Telephony.
totNNewShift[T] Displays the number of calls in each shift in Telephony.
totNtransExtDestShift[T] Displays the number of all received calls transferred to another

topic by an external destinations in each shift in Telephony.
totNDoneExtDestShift[T] Displays the number of conversations with external destinations in

each shift in Telephony.
totNExtDestShift[T] Displays the number of calls with external destinations in each

shift in Telephony.
totNOverload[T] Displays the overload in each shift in Telephony.
NReserved[T] Displays the number of reserved tasks in Telephony.
NVoiceMails[T] Displays the number of voice mails.
totTVoiceMails[T] Displays the total length of voice mails.
NQueued [E] Displays the number of queued emails.
NQueued [C] Displays the number of queued chat requests in Chat.
maxTQueued[E] Displays the maximum wait time for email.
maxTQueued[C] Displays the maximum wait time for Chat requests in Chat.
avgTQueued[E] Displays the average wait time of all queued emails
avgTQueued[C] Displays the average wait time of all queued chat requests in

Chat.
avgTQueuedInterv[E] Displays the average wait time during the period under

consideration or interval in Email.
TSFDyn[E] Displays the Task Service Factor that is dynamic calculation in

Email.
TSFDyn[C] Displays the Task Service Factor that is dynamic calculation in

Chat.
TSF[E] Displays the Task Service Factor in Email.
TSF[C] Displays the Task Service Factor in Chat.
totNTSF[E] Displays the total number of emails for the Task Service Factor

calculation in Email.

Table continues…
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Name Description
totNTSF+[E] Displays the total number of positive emails for the Task Service

Factor calculation in Email. Positive emails are closed emails.
totNDoneInterv[E] Displays the number of processed tasks during the period under

consideration that is updated periodically in Email.
totFDoneInterv[E] Displays the processing factor. Ratio of processed to deleted

tasks during the period under consideration that is updated
periodically in Email.

TSFShift[T] Displays the service level over the shift in Telephony.
avgTConvWaitShift[T] Displays the average speed of answer in each shift in Telephony.
totNAbanShift[T] Displays the abandoned calls in each shift in Telephony.
avgTAbanWaitShift[T] Displays the average time that the callers waited before the call

was abandoned in Telephony.
AcceptLevel[T] Displays the acceptance level in Telephony.
NQueuedAnnNotInt[T] Displays the number of waiting calls with none interruptible

announcement in Telephony.
AcceptLevelShift[T] Displays the acceptance level of the whole shift in Telephony.
totNAbanOutCCShift[T] Displays the number of abandoned outgoing calls each shift in

Telephony.
totNOutCCShift[T] Displays the number of calls each shift in Telephony.
totNDoneOutCCShift[T] Displays the number of conversations each shift in Telephony.

Related links
Values on page 162

Agent values field descriptions

Name Description
totNDoneShift[T] Displays the total number of conversations in each shift in

Telephony.
totNNewShift[T] Displays the total number of calls in each shift in Telephony.
totTBreakShift[T] Displays the total break time in each shift in Telephony.
totNdoneShift[E] Displays the total number of incoming emails in each shift in

Email.
avgTBreakShift[T] Displays the average of break time in each shift in Telephony.
totTSignOnShift[T] Displays the total time for a shift during which an agent is

signed on in Telephony.
avgTConvShift[T] Displays the average ACD conversation time in each shift in

Telephony.
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Name Description
totTConvShift[T] Displays the total ACD conversation times in each shift in

Telephony.
avgTWrapUpShift[T] Displays the average Wrap Up (after call work) in each shift in

Telephony.
totTWrapUpShift[T] Display the total Wrap Up in each shift in Telephony.
avgNConvPerHourShift[T] Displays the average number of ACD conversations in each

hour related to the time in which an agent signs on to each
shift in Telephony.

totNAbanOutCCShift[T] Displays the total number of outgoing ACD calls which were
unanswered by the destination.

totNOutCCShift[T] Displays the total number of outgoing ACD calls. The calls
which started in the actual shift by the agent in dial pad in
contact bar or has call back from an abandoned list in real time
information.

totNDoneOutCCShift[T] Displays the total number of calls answered by a destination.

Related links
Values on page 162

Agent group values field descriptions
Name Description
NSignOn[T] Displays the number of signed-on agents in Telephony.
NFree[T] Displays the number of available agents in Telephony.
NAct[T] Displays the number of active agents in Telephony.
NNew[T] Displays the number of calls through call distribution in

Telephony.
NAcc[T] Displays the number of conversations through call distribution in

Telephony.
NWrapUp[T] Displays the number of agents in wrap up in Telephony.
NFJCode[T] Displays the number of agents with mandatory job code in

Telephony.
NBreak[T] Displays the number of agents on break in Telephony.
avgNFree[T] Displays the average number of available agents in Telephony.
avgNAct[T] Displays the average number of active agents in Telephony.
avgNNew[T] Displays the average number of calls through call distribution in

Telephony.
avgNAcc[T] Displays the average number of conversations through call

distribution in Telephony.
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Name Description
avgNWrapUp[T] Displays the average number of agents in wrap-up time in

Telephony.
avgNFJCode[T] Displays the average number of agents with mandatory job code

in Telephony.
NSignOn[E] Displays the number of signed-on agents in Email.
NFree[E] Displays the number of available agents in Email.
NAct[E] Displays the number of active agents in Email.
NNew[E] Displays the number of agents with unopened Emails.
NAcc[E] Displays the number of agents with open Emails.
avgNFree[E] Displays the average number of available agents in Email.
avgNAct[E] Displays the average number of active agents in Email.
avgNNew[E] Displays the average number of agents with unopened Emails .
avgNAcc[E] Displays the average number of agents with open Emails.
NBreak[E] Displays the number of agents on break in Email.
Nact[C] Displays the number of active agents in Chat.
Npause[C] Displays the number of agents on break in Chat.
Nfree[C] Displays the number of available agents in Chat.
Nsignon[C] Displays the number of signed-on agents in Chat.

Related links
Values on page 162

Team field description

Name Description
TSF[T] Displays the current TSF in Telephony.
totNTSF[T] Displays the total number of calls in TSF calculation.
totNTSF+[T] Displays the total number of positive calls for TSF calculation in

Telephony. Positive calls are calls that resulted in a discussion.
TSF[E] Displays the current TSF in Email.
totNTSF[E] Displays the total number of email TSF calls for TSF calculation.
totNTSF+[E] Displays the total number of positive emails for the TSF

calculation. Positive emails are closed emails.

Related links
Values on page 162
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PBX field description
Name Description
NConfConnections[T] Displays the number of configured B-channels for each PBX

in Telephony.
NActConnections[T] Displays the number of active B-channels for each PBX in

Telephony.

Related links
Values on page 162

IVR field descriptions

Name Description
NBusyIVRPorts Displays the number of assigned IVR ports.

Related links
Values on page 162

Dialer field description
Name Description
curDialFactor Displays the current dial factor in percentage.
curDroprate Displays the current drop rate in percentage.
%CompletedJobs Displays the share of processed jobs.
NAbandonedJobs Displays the number of connections canceled by an

external party before answering the call.
NBusyDestJobs Displays the number of calls in which the external party

was busy.
totNJobs Displays the total number of jobs.
NInitJobs Displays the number of started jobs.
maxDroprate Displays the configured default value for drop rate in

percentage.
NCanceledJobs Displays the number of dial attempts canceled because

of exceeded ring time out.
NDroppedJobs Displays the number of connections canceled by the

system.
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Name Description
NUnfinishedJobs Displays the number of unfinished jobs.
NTriesJobs Displays the number of dial attempts.
NClosureJobs Displays the number of closures.
NRPCJobs Displays the number of Right Party Contacts.
NRawJobs Displays the number of jobs that are not dialed by the

dialer.

Related links
Values on page 162

Lines field description

Name Description
NAvailableTrunks Displays the number of free lines.
NBusyTrunks Displays the number of busy lines.
NOutOfServiceTrunks Displays the number of faulty lines.
NExtACDIncoming Displays the number of busy lines with incoming external

ACD calls.
NExtIncoming Displays the number of busy lines with incoming external

direct calls.
NExtACDOutgoing Displays the number of busy lines with outgoing external

ACD calls.
NExtOutgoing Displays the number of busy lines with outgoing external

direct calls.
NIntACDIncoming Displays the number of busy lines with incoming internal

ACD calls.
NIntIncoming Displays the number of busy lines with incoming internal

direct calls.
NIntACDOutgoing Displays the number of busy lines with outgoing internal

ACD calls.
NIntOutgoing Displays the number of busy lines with outgoing internal

direct calls.

Related links
Values on page 162
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Inserting and deleting objects
About this task
You can insert or delete one or more objects in a real time information element. You can also
customize the order. The objects are:

• Topics
• Agents
• Agent groups
• Teams
• PBXs
• IVR
• Campaigns, agent dialers, or topic dialers
• Lines
• Workplaces

Procedure
1. Use the mouse to drag and drop the element on to a real time information sheet.

2. To insert an object in the real time information element, in the Properties dialog box, click
Add.

3. In the Topic selection dialog box, click the appropriate objects.

4. Click OK.

The system displays the inserted topics.

5. To delete topics, click the appropriate objects and click Delete.

6. To change the order of the topic list, click the object, and do one of the following:

• To move the object down the list, click Down.

• To move the object up the list, click Up.

Related links
Values on page 162

Drawing a line
About this task
Use this procedure to configure a real time information sheet using lines and rectangles in addition
to elements. You can use the grid to draw horizontal or vertical lines. You can select more than one
elements, lines, and rectangles and move them together, but you cannot group them permanently.
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Procedure
1. On the menu bar of Inspector view, click the Draw line icon .

2. On the sheet, use the mouse to draw a line.

The system displays the drawn line.

Related links
Values on page 162

Drawing a rectangle
Procedure

1. On the menu bar of Inspector view, click the Draw rectangle icon .

2. To position a corner, click within the window and keep the mouse button pressed.

3. Drag the rectangle to the required size, and release the mouse button.

The system displays the drawn rectangle.

Related links
Values on page 162

Switching on the selection mode
About this task
Use this procedure to toggle from the draw mode to the selection mode.

Procedure
1. On the menu bar of Inspector view, click the Switch on selection mode icon .

2. To toggle to the draw mode, click Switch on selection mode again.

Related links
Values on page 162

Changing the color, line type, and line width
About this task
Use this procedure to change the color, line type, and line width of the drawn elements.

Procedure
1. Right-click a drawn element.
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2. In the pop-up menu, click Properties.

3. In the Properties dialog box, in the Line type field, click the line icon .

4. In the Line width field, click a line width. The range is from 0.5 point to 6 point.

5. Click the Color icon .

6. In the Color selection menu, click a color.

Related links
Values on page 162

Selecting and deleting drawn elements
About this task
You can select several elements to move or edit in one step.

Procedure
1. Use the mouse to drag and drop the required elements to the work area.

2. Do one of the following:

• Keeping the Ctrl key pressed, click the required elements.

• Draw a selection frame around the required elements.

3. To delete the drawn elements, do the following:

a. Right-click the drawn element.

b. In the pop-up menu, click Delete.

c. Click Yes.

The system deletes the selected drawn element.

Related links
Values on page 162

Saving window settings
You save your settings you have positioned all windows as required. These settings are only useful
for displaying real time information separately.

You can detach a monitor. The monitor must not appear in the window of IP Office Contact Center
User Interface for Windows application. The system displays a monitor as a detached or a separate
entity.
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You can only use the IP Office Contact Center User Interface for Windows application as a display
with a single sign-on and AutoStart monitors. The monitors are always in the foreground, and you
cannot minimize or close the monitors.

Related links
Real time Information module overview on page 113
Working with detached monitors on page 172

Working with detached monitors
Procedure

1. Select a monitor to detach.

2. Click File  > Open  > In the same Window

3. Click Save.

Related links
Saving window settings on page 171
Detached monitor field descriptions on page 172
Update types for real time information on page 173
Saving the settings of the current window arrangement on page 173

Detached monitor field descriptions
You can set the following properties in the system menu field of a detached monitor in addition to
the usual Windows functions. This must limit the usual Windows functions.

If the system displays a check mark, you can use the function.

Name Description
Always in the
foreground

Indicates that the monitor must always remain visible in the foreground, even if you
use another Windows application. Avaya recommends that, only important
monitors remain in the foreground. You can adjust the size of the monitor.

Prevent minimization Prevents the monitor to minimize.
Prevent closing Prevents the monitor to close. When you exit the IP Office Contact Center User

Interface for Windows application, the monitor also closes.

Possible Field of Application
You can only use the IP Office Contact Center User Interface for Windows application as a display
with a single sign-on and AutoStart monitors. The monitors are always in the foreground, and you
cannot minimize or close the monitors.

Related links
Working with detached monitors on page 172
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Update types for real time information
The values and states of real time information elements can be displayed either periodically or as a
sliding window, depending on the real time information element.

Real time display
The system updates the real time information continuously. The values match the current values in
the IP Office Contact Center system. A real time information element logs on to the Real time
Information server. Information and values are sent from the real time information server to the real
time information element if a change occurs. The real time information element then displays the
changed information or values.

Periodic update
The system updates the information and values after 10 seconds in a periodic update. The period of
10 seconds is predefined for the IP Office Contact Center system and cannot be changed. The
Configuration application system displays this time. You can use periodic update for tabular real
time information.

Sliding window
Sliding window means that after each update interval the calculated period of time moves one
update interval. A period of 10 seconds is set for the update interval of IP Office Contact Center
system. You cannot change the update interval. You can configure the calculated period of time with
the Configuration application.

Example
The following example displays the progress of a sliding window with stop and start time. The
following settings apply: Calculated period of 15 minutes that is updated at an interval of 10
seconds.

Calculation Start Stop
1. 11:00:00 AM 11:15:00 AM
2. 11:00:10 AM 11:15:10 AM
3. 11:00:20 AM 11:15:20 AM

Related links
Working with detached monitors on page 172

Saving the settings of the current window arrangement
About this task
The real time information that is currently on display opens automatically the next time that you sign
in with the same settings.

Procedure
Do one of the following:

a. Click Save Window positions.

b. Click Autostart.

Saving window settings
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The system saves the window arrangement.

Related links
Working with detached monitors on page 172

Real time information calculation
Real time information displays different current and average values. To assess these values, you
must know how the IP Office Contact Center User Interface for Windows application calculates
these values. You must know how average values are calculated, what is TSF and TSFDyn, and
how they are calculated.

Conditions for certain calculations are configured in the Configuration module.

Average values have a fixed update interval of 10 seconds. Individual values are recorded every
second. The system determines and updates the average at the end of the update interval.

The formula for the average values is:
A = (V1+V2+V3+V4+V5+V6+V7+V8+V9+V10)/I
Name Description
A Calculated average.
V1 to V10 Individual values that are recorded every second.
I Update interval that is 10 seconds.

Wait time
The wait time of a task depends on the task type.

• Wait time for calls: The wait time of a call starts from the time that the call is queued in the topic
queue.

• Wait time for emails: The wait time of an email starts from the that time the mail arrives in the
topic mailbox.

Acceptance Level
The formula for the acceptance level is:

Incoming calls / (received calls - short calls)

A call without a conversation with a waiting time <N sec [default: 10 sec] is defined as a short call.

Related links
Real time Information module overview on page 113
TSF calculation on page 175
TSFDyn calculation on page 175

Real time Information module overview
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TSF calculation
The Task Service Factor (TSF) displays the percentage of tasks that waited in a queue for less than
or equal to the wait time threshold. The wait time threshold for the TSF is configured in the
Configuration module for topics, agent groups, and teams. Different thresholds can be set for each
topic, agent group, or team. The threshold can be set between 5 and 900 seconds which is 15
minutes. All tasks that are waiting in the queue for longer than the calculated period set, are taken
into account for the Task Service Factor.

In contrast to the TSFDyn, the TSF is reset to 100% after each calculated period. The calculated
period is valid for the entire IP Office Contact Center system.

The TSF is recalculated and updated after each update interval. The fixed update interval for the call
center is 10 seconds.

The formula for the TSF is:

TSF = N / S * 100

Name Description
TSF Task Service Factor.
N Number of tasks less than or equal to the wait time threshold during the calculated

period of time.
S Total of all tasks during the calculated period of time.

Related links
Real time information calculation on page 174

TSFDyn calculation
The Dynamic Task Service Factor (TSFDyn) displays the percentage of tasks that waited in a queue
for less than or equal to the wait time threshold. The wait time threshold for the TSFDyn is
configured in the Configuration module for topics and agent groups. Different thresholds can be set
for each topic or agent group. The threshold can be set between 5 to 900 seconds which is 15
minutes.

A TSFDyn of 75% means that during the calculated time, 75% of all tasks were in the queue for a
time less than or equal to the defined wait time threshold. All tasks that have been waiting longer
than the calculated period set in the queue, are taken into account for the TSFDyn. The calculated
period is valid for the entire IP Office Contact Center system.

TheTSFDyn is updated after each update interval. The fixed update interval for the IP Office Contact
Center system is 10 seconds. The TSFDyn is a sliding window that is updated after every interval of
10 seconds. The calculated period moves along the time axis for one update interval.

The formula for the TSFDyn is:

TSFDyn= N / S * 100

Real time information calculation
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Name Description
TSFDyn Task Service Factor (Dynamic calculation).
N Number of tasks less than or equal to the wait time threshold during the

calculated period of time.
S Total of all tasks during the calculated period of time.

Related links
Real time information calculation on page 174

Real time Information module overview
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Chapter 8: Reporting module overview

The Reporting module records, examines, assesses, and presents all important IP Office Contact
Center system data. You can generate reports manually or automatically in many layouts and
outputs.

Reporting data
IP Office Contact Center provides detailed information about important events in the form of report
data. Additional report data is calculated from agent statuses, emails, voice mail messages, and
announcements.

Reporting evaluates the performance of the IP Office Contact Center system and calculates agent
hours to bill clients. You can also process the report data by using staff planning tools. For example,
using xstat_srv or other business programs.

Reporting gathers and classifies numeric data and other information, such as job codes and skill
combinations for defined objects such as agents, topics, and agent groups. You can also create
records of individual telephone conversations using tr_Srv. You can display and process the data
that you collect using reporting.

The database stores all report values. The recorded data is the basis for further evaluations or
special algorithms. You can collect data and evaluate results using the report generator server and
report viewer components.

Advantages of reporting
You can use reporting to:

• Ensure continuous quality of service. You can also identify peak times that can be
counteracted by the coordinated employment of staff.

• Use the previous evaluation as a basis to address seasonal or event-related increases in
customer requests.

• Record feedbacks about promotions and marketing measures.
• Determine the time needed for processing a service. You can also use this information to

calculate expenses.

Reporting types
You can create report evaluations for different objects of the system.

• Agent reporting
• Agent group reporting
• Telephone reporting
• Dialer reporting
• Skill combination reporting
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• System reporting
• Team reporting
• Topic reporting
• IVR reporting

Reporting types
The reporting types are:

• Manual Reporting: You can configure manual reporting that the user must start individually.
• Automatic Reporting: The evaluation of an automatic report starts automatically at a set date or

at certain intervals. For example, every evening or at the beginning of each month.

You can activate reporting for two different user groups:

• Private: You can enable reporting only for the user who defines the reporting. This report type
is marked with the private-enable option.

• Public: You can enable reporting as public, so that all users with privileges can view the
configured report type.

You must define a time frame for the report survey. The available options are Months, Weeks, Days,
Total period, and User-defined time in hours and minutes.

The system displays the presentation in:
• Tabular format: The report displays as a table. The system determines the order of the events

by custom grouping of the reporting counters used.
• Graphical display: The report displays as a line graph, bar chart, or pie chart. However, this

presentation is not possible for all agent groups and topic counters.

IP Office Contact Center can generate report results in the following formats:

• Display: The system displays the result.
• Export reporting: You can export your results to a Microsoft Excel, RTF, PDF, or .CSV file.

For more information about active reporting type, see Administering Avaya IP Office Contact Center
Configuration Module.

Reporting methods
You can select between interval-based and back office reporting in the system.

Note:

You must make the selection when commissioning the system. You must not use both reporting
methods together.

Reporting module overview
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Interval-based reporting
In interval-based reporting, counters are presented as events on the time axis. If a counter exceeds
the interval, the counter counts proportionally for each interval. Logical totals are necessary to
determine the actual number of events, such as totNNew and totNConv, and for the period under
consideration. Within an interval, you can cross check the counters according to specific rules, and
the system saves actual time such as ring times and conversation times.

Back office reporting
In back office reporting, all report values, such as counters, times, and job codes, are determined for
the report interval. IP Office Contact Center recognizes a call the first time during the report interval.
However, the time that exceeds the duration of interval is written as the first interval. For this event,
the system does not record report data for further intervals.

Special cases are consultation calls with or without transfer. The system creates a new call for the
consultation call. The consultation call does not need to start in the same interval as the original call.
All report values for the consultation call and a possible transfer are recorded for the interval in
which the system starts the consultation call. Back office reporting does not require the logical totals
because the technical total and logical total for back office reporting are the same.

Conditions for calls and conversations
You must take into account the calculated period when you count calls and conversations.

For interval-based reporting evaluation, you must select the resolution of the time axis and the
calculated period. You must follow this condition for all calculations. This condition also applies to
the subtotal, total data, and exported data.

Times
The following table explains the time calculation:

Times Description
Calculated period of time The calculated period is set in the Configuration module. The system

saves the data after each calculated period and determines the
resolution of the data.

Resolution of time axis You can configure months, weeks, days, total period, or user-defined
hours and minutes as the time axis resolution. The minimum value is
the maximum calculated period within the period that you select.

Duration of call, ring time,
conversation, Wrap Up, total
processing time, conversation time,
calls in the queue, and calls on hold

When a counter measures a duration, these counters count in the
periods in which the event occurs for interval-based reporting or in
the first period under consideration for back office reporting.

Number
The following table explains the calculation of totals in interval-based reporting:

Conditions for calls and conversations
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Name Description
Calls Calls are counted for the calculated periods, during which the calls are connected

to a terminal. If a call connects during two calculated periods, the call is counted
for both.

Conversations Conversations count for the calculated periods during which the conversations
occur.

If a call continues for more than one calculated period, conversations counts for all
periods. You must take this count into account for technical subtotals and totals.
Logical totals display the number of established calls because the whole period
under consideration is taken into account for logical calculations.

Only the duration of conversation during the period under consideration is taken
into account.

Calls in the queue Calls in a queue are counted for the calculated periods during which the calls are
queued.

Calls on hold Calls on hold are counted for the calculated periods during which the calls are on
hold.

Back office reporting
In back office reporting, totals are assigned to the period in which the call enters the system.

Reporting calculation
System calculations can result in misinterpretations. Therefore, you must learn how average values,
subtotals, and totals are calculated.

Maximum values refer to the period under consideration in relation to the resolution of the time axis.

Average calculations refer to the period under consideration in relation to the resolution of the time
axis. To calculate the average statistical subtotals and totals, use the following formula:

• Ø total = (Ø subtotal 1 + Ø subtotal 2 + Ø subtotal n) / n

Misinterpretations
Average subtotals and totals are not calculated according to the following formula:

• Ø total = (total of n individual values) / n

Example of how average values are calculated
The following example displays the calculation of the average ring time. If you divide the total of ring
times by the total of calls, the average value is 6.67. However, the Reporting application calculates
the average value of the individual average values and so the average is 6.25.

Period under
consideration

Counted and calculated are
totNNew <-RC totNConv <-RC totTRingAg <-RC Avg. Tring <-RC

Table continues…

Reporting module overview
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10:00 to 11:00 2 1 15 7.5
11:00 to 12:00 1 1 5 5
Total 20 6.25

Number Minutes Minutes

Simple report calculation example
The assumptions and prerequisites are:

• Create reporting for a team with two agents.
• Consider the time period from 10:00 a.m. to 11:00 a.m.
• Set the period to calculate to 1 hour.
• Set the resolution of time axis to Total period.
• Assume that during the time period that you consider the system processes one call.
• Assume that the conversation lasts for 30 minutes during the period under consideration. The

call rings from 10:20 a.m. to 10:25 a.m. The conversation starts at 10:25 a.m. and ends at
10:55 a.m.

Counters for simple reporting
An example of the counters for the evaluation of simple reporting:

Na.m.e Description
totNNew<-RC Number of calls
totNConv<-RC Number of conversations
totTRing<-RC Ring time
AvgTRing<-RC Average ring time
maxTRing<-RC Maximum ring time
totTConv<-RC Conversation time
maxTConv<-RC Maximum conversation time

Table for simple reporting
Evaluations for the period under consideration from 10:00 to 11:00 are:

Period
under
considerati
on

Counted and calculated are
totNNew <-
RC

totNCon v<-
RC

totTRi
ng <-
RC

AvgTRi
ng<-RC

maxTRi ng<-
RC

totTCon v<-
RC

maxTCo nv<-
RC

10:00 to
11:00

1 1 5 5 5 30 30

Number Minutes

Simple report calculation example
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Reporting time calculation example
An example of reporting time calculation explains how to count ring times, calls, established calls,
established conversations, and conversation times.

The prerequisites and assumptions for this example are:

• Create reporting for a team with two agents.
• Consider the time period from 10:00 a.m. to 12:00 p.m.
• Set the period to calculate to 1 hour.
• Set the resolution of time axis to Total period.
• Assume that during the time period that you consider, the system processes two calls.
• Assume that the conversation lasts for 30 minutes during the period under consideration. The

call rings from 10:35 a.m. to 10:45 a.m. The conversation starts at 10:45 a.m. and ends at
11:15 a.m.

• Assume that the second call rings from 10:55 a.m. until 11:05 a.m. and the call is unanswered.

Counters for reporting time calculation
Name Description
totNNew<-RC Number of calls
totNConv<-RC Number of conversations
totTRing<-RC Ring time
AvgTRing<-RC Average ring time
maxTRing<-RC Maximum ring time
totTConv<-RC Conversation time
maxTConv<-RC Maximum conversation time

Table for reporting time calculation in interval reporting
When you use interval reporting, the system evaluates the following for the different periods:

Period under
consideration

Counted and calculated are
totNNew
<-RC

totNCon
v<-RC

totTRing
<-RC

AvgTRing
<-RC

maxTRi
ng<-RC

totTCon
v<-RC

maxTCo
nv<-RC

10:00 to 11:00 2 1 15 7.5 10 15 15
11:00 to 12:00 1 1 5 5 5 15 15
10:00 to 12:00 2 1 20 10 10 30 30

Number Minutes

Note:
Note how the average ring time (ØTRing<-) and the conversation time (totTConv<-) depend on
the period under consideration chosen for evaluation.

Table for reporting time calculation in back office reporting
When you use back office reporting, the system evaluates the following for the different periods:

Reporting module overview
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Period under
consideration

Counted and calculated are
totNNew
<-RC

totNCon
v<-RC

totTRing
<-RC

AvgTRing
<-RC

maxTRi
ng<-RC

totTCon
v<-RC

maxTCo
nv<-RC

10:00 to 11:00 2 1 20 10 10 30 30
11:00 to 12:00 0 0 0 0 0 0 0
10:00 to 12:00 2 1 20 10 10 30 30

Number Minutes

Counters overview
Verifying reporting counters provides formulas and calculations for the respective counters. You can
verify the counters only if you meet the following prerequisites:

• Interval reporting: You cannot verify counters within the intervals. You can only verify counters
of an evaluation for a total period and in the logical total.

• Back office reporting: You can verify the counters within intervals.

Counters for topic reporting
Number of calls to the topic balance sheet:
totNIncome = totNSucc + totNLost
totNNew + totNRr = totNConvAg + totNConvExtDest + totNConvAutoAg +
totNAban + totNRouted->
Number of topic calls routed to agents:
totNAg = totNConv + totNAbanAg
Number of topic calls routed to external destinations:
totNExtDest = totNConvExtDest + totNAbanExtDest
Counters for agent groups
totN = totNNew + totNOverf<- = totNConv + totNAban + totNOverf->
totNAban = totNAbanWait<=N + totNAbanWait>N<=M + totNAbanWait>M
totNConv = totNConvWait<=N + totNConvWait>N<=M + totNConvWait>M
Counters for agents
totNNew<- + totNPickup<- = totNConv<- + totNAban<- + totNPickup->
totNNew<- = totNNew<-RC + totNNew<-DCInt + totNNew<-DCExt
totNConv<- = TotNConv<-RC + totNConv<-DCInt + totNConv<-DCExt
totNConvAg = totNConvWait<=N + totNConvWait>N<=M + totNConvWait>M

Counters overview
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Relationship among different times
totTConv<- = TotTConv<-RC + totTConv<-DCInt + totTConv<-DCExt
totTService<-RC = TotTConv<-RC + totTHold + totTWrap Up + totTForcedCWC

Note:
The Relationship among different times formula is valid only if the agent that you consider is
working exclusively with the incoming traffic.

The totTHold and totTWrapUP variables are used to count incoming and outgoing traffic.

Email reporting features
The system can take a long time to process emails. For example, a week. Hence, you must provide
the reporting information during the email processing time.

No difference between interval-based and back office reporting
The interval-based and back office reporting are the same for email reporting. Counters are
provided for evaluation at the end of the interval. During this time the system counts an event, such
as the arrival of a new email in the system. Only at the end of processing does the system evaluate
other counters that record the completion of email processing.

Availability of reporting counters
When you count emails, you must take the calculated period into account.

For report evaluation, you must consider the period, which is the resolution of the time axis and the
selected calculated period. You must ensure this condition when you calculate the subtotal, total
data, and exported data.

Name Description
Maximum time to accept The time to accept starts when an email arrives in the agents

folder.

If the agent does not open the email, which is an email client in IP
Office Contact Center User Interface for Windows or a Web
Client, before the maximum time for accepting, the workplace is
signed off from the distribution for all agent groups. After the
maximum time to accept is exceeded, the system redistributes
the email according to the task flow set.

Processing time The duration between opening and closing an email is the
processing time. The time when an agent interrupts the active
email or log off is not counted as processing time.

Default for processing time You can set a default processing time for the agent groups. The
default setting is 30 minutes.

The system sends a message to the agent if the processing time
exceeds the default processing time.

Table continues…

Reporting module overview
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Name Description
Wait time The duration between the arrival of an email in the inbox folder of

an agent and the time that the agent opens the email is called the
wait time.

Service-oriented topic counter
The new reporting counters, such as handling time, service level, and Lost or Successful, are
important for the user. Irrespective of the actual history of an email, the selected topic is most
important from the point of view of the user.

Handling time or processing time
The processing or handling time is the time between the arrival of an email in the system and the
time when the agent completes the email processing.

• Gross handling time: The total time between the arrival of an email and completion of
processing the email.

• Net handling time: The time difference between the arrival of the email in the system and the
completion of processing the email minus the blocking time of the initial topic during this
interval.

Number of emails from the point of view of the user
All mails that are completed by agents are counted as successful for the initial topic, that is
totNSucc, regardless of the topic by which the emails reached the agents.

For the initial topic, all emails are counted as definitively unprocessed, that is totNLost, if the emails
were deleted by an administrator, even if these emails have already been distributed through
several topics.

Email service factor
The net handling time is the calculation basis for the email service factor. The system does not
consider the mails that an administrator deletes.

Topic counters for internal workflow
You can verify emails for individual intervals. The counters for the arrival and exit of mails at the
beginning and end of the interval are available.

Privileges
You must have the following privileges to use the reporting functions:

• Reporting
• Topic
• Agent group
• Agent
• Show alias only
• Team

Privileges
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• Telephone
• Line
• Outbound ACD
• IVR
• Skill
• System
• PBXs
• Definition
• Automatic reporting
• Delete data
• Parameterize reports

Opening reporting
Procedure

1. On the task bar, click Supervision.

2. In the task area, click the Reporting ( ) icon.

Evaluating reporting counters
About this task
To evaluate reporting, you must select the relevant reporting counters in the Configuration module.

Procedure
1. On the task bar, click Administrator.

2. In the task area, click the Configuration icon .

3. In the service menu, click Reporting Filters.

4. From the available reporting counters, click the relevant reporting counters.

Reporting views
Reporting operations can be performed in two ways:

• Creating and editing a report.

Reporting module overview
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• Performing a report evaluation.
Depending on the method of operation, use a different reporting view. To create or edit a report, use
the Inspector view, and to view a report, use the File View.

Reporting File View
The File View is divided into the following:

• The title bar
• The tool bar
• The Folder area
• The Reporting files area

Reporting File View toolbar icons
Icons Name Description

New folder Creates a new folder.

New report Creates a new report.

Edit Toggles to the Inspector view. You can edit the selected reporting file in the
Inspector view.

Delete Deletes the selected reporting file or folder. You can also delete more than one
file or folder at a time.

Full screen Displays a report in full screen.

Work area Displays a report in the work area.

Export Exports a report.

Folders and Reporting files
The Folder area is displayed in a tree structure. You can use these folders to arrange and clear a
layout according to the topic. All users can create private or public folders. You can use private
folders, but only users with the required privileges can use public folders. You cannot change the
default folders. Folders are displayed in an alphabetical order.

The Reporting files area displays the reports of a selected folder. The system displays reports in a
table. The type indicates whether a reporting file is a private file or a public file. All users can use
private folders, but only users with the required privileges can use public folders. You cannot change
the default reporting files. To edit reporting files, you must copy the screens first.

Reporting File View
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Reporting File View icon descriptions
You can use the following icons to create folders and files in the Folder and Reporting files area:

Icon Name Description
Folder (public) Displays a public folder.

Folder (private) Displays a private folder.

Predefined reports [RO] Displays the default folder.

File (public) Displays a public report.

File (private) Displays a private report.

Predefined reporting files [RO] Displays the default reporting file.

Reporting Inspector view
The Inspector view is divided into the following:

• The title bar
• The tool bar
• The Elements area
• The Reporting area

Reporting Inspector toolbar icons
Icon Name Description

Save Saves the report data.

Cancel Cancels the current process and the data
is not saved.

Basic data Displays the basic report data.

File view Toggles to the File View.

Full screen Toggles to full screen display.

Work area Toggles to the work area.

Reporting module overview
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Reporting area field descriptions
You can use the elements to create a report in the reporting area of the Inspector view. You can
drag and drop the elements to create a report. You must enter the basic data accordingly. The
system displays the following components in the reporting area:

Name Description
Delete Deletes the selected element.
Properties Opens the properties of the selected element.
Select all Selects all the elements in the reporting area.
Copy Copies the selected elements.
Add Pastes the selected elements in the reporting area.

Reporting properties field descriptions
Tab Name Description
General Name Displays the name of the reporting

file.
Size of work area Displays the size of the work area.

You can configure the size of the
work area between 1280 and
6,000 points.

Settings Grid Displays a select operation to
display or hide a grid. You can
define the size of the grid between
4 and 100 points with the following
options:

• Width

• Height
Presentation Font Displays a list of available fonts.

Line Displays a list of drawing lines.
Background Displays the following options to

change the background:

• Color: Displays the selected
color. You can select a color
from a palette for the following
settings in color selection:

- Labeling for text color.

- Dividing line for line color.
Table continues…
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Tab Name Description
- Background color.

• Image: Displays the path of the
selected image.

Configuring reporting element settings

Changing the position of an element
Procedure

1. Click an element.

2. Use the mouse to drag and drop the element to the reporting area.

The system displays the element with a red dotted frame and highlighted corners.

3. Place the element in the new position and then release the mouse button.

Changing the size of an element
About this task
You can customize the size of elements by making changes horizontally, vertically, or in both
directions depending on the position on the corner. The pointer is displayed as an arrow indicating
the possible directions. Tables and Dividing lines always cover the full width.

Procedure
1. Click an element.

2. Use the mouse to drag and drop the element on to the reporting area.

The system displays the element with a red dotted frame.

3. Click and drag the corner of the element to enlarge or reduce the size.

4. Release the mouse button.

Folders and reports
You can rename, delete, or change the assignment from private to public or vice versa, and refresh
the view of Folders and Reporting files. You can duplicate a report.

Reporting module overview

February 2016 Using Avaya IP Office Contact Center for Windows 190
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


Renaming folders and reports
Procedure

1. Right-click a folder or a report.

2. In the pop-up menu, click Rename.

3. Type a name for the folder or report.

Duplicating reports
About this task
You can generate duplicate reports to use by default. For example, you can display the same basic
data and the logo for all reports.

Procedure
1. Right-click the report.

2. In the pop-up menu, click Duplicate.

The system generates a new report displaying the original name of the report with a number.

3. Type a new name for the duplicate report.

Deleting folders and reports
About this task
When you delete a folder, the system also deletes all the reports in the folder.

Procedure
1. Right-click a folder or a report.

2. In the pop-up menu, click Delete and confirm your selection if prompted.

3. Click Yes.

The system deletes the selected folder or report.

Refreshing views
About this task
You can refresh the view of a report when more than one user is working on the same report. The
system displays the changes made by other users in your view.
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Procedure
1. Right-click a folder or a report.

2. In the pop-up menu, click Refresh.

The system displays the updated version of the folder or report.

Changing the assignment of reports
Procedure
Do the following:

a. a. Right-click a report.

b. In the pop-up menu, click Private.

The system changes the assignment based on the previous status and the status of report icon
changes.

Changing the assignment of folders
About this task
When you change the assignment of a folder, you must specify whether to apply the change of
assignment to the reports in the folder.

Procedure
Do the following:

a. Right-click a folder.

b. In the pop-up menu, click Private.

The system displays a message whether to change the other folders and files of the same type.

c. Click Yes.

The system changes the assignment based on the previous status and the status of folder icon
changes.

Reporting elements
The following elements are displayed in the Inspector view:
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Icon Name Description
Basic data Displays the basic data of the selected report properties as text.

Logo Displays the logo of the selected graphic.

Label Specifies additional comments for a report with the label.

Table Displays a report in table format.

Pie chart Displays a report as a pie chart.

3D pie chart Displays a report as a pie chart in a three-dimensional (3D) format.

Line graph Displays a report as a line graph.

Bar chart Displays a report as a bar chart.

Dividing line Displays a horizontal dividing line.

Element properties
You can use the elements to compile reports. The following tables displays the two types of
elements:

Elements used for labeling Elements that display report values
• Basic data

• Logo

• Label

• Dividing line

• Table

• Pie chart

• 3D pie chart

• Line graph

• Bar chart

Basic data element
You can use Basic data to represent general report data. You can adjust the size of the basic data
field. You can choose whether to display names and data or only data.

The Basic data element displays the following information:

• Name
• Date created
• Editor
• Period

Element properties
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Logo element
You can use one or more logos in a report. You can adjust the size of the image and assign a link to
the image. Use one of the following image formats:

• JPG
• BMP
• GIF
• PNG

You can select a graphic in the Image selection tab.

Label element
With the Label element, you can provide additional comments or labeling for reporting. The size of
the label field can be adjusted. You can use up to 256 characters.

Table element
You must specify the following properties for a Table element:

• Settings
• Period
• Output
• Counters
• Agent

Pie chart element
You must specify the following properties for a Pie chart element:

• Settings
• Period
• Counters
• Agent
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3D pie chart element
You must specify the following properties for a 3D pie chart element:

• Settings
• Period
• Counters
• Agent

Line graph element
You must specify the following properties for a Line graph element:

• Settings
• Period
• Output
• Counters
• Agent

Bar chart element
You must specify the following properties for a Bar chart element:

• Settings
• Period
• Output
• Counters
• Agent

Dividing line element
You can specify the properties of a horizontal line. The Dividing line always covers the entire length
of reporting area. You can only move the line up or down. The following table lists the presentation
options:

Icon Name Description
Line Displays the selected line type.

Table continues…
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Icon Name Description
Line width Specifies the value for the line

width.
Text color Displays a color palette. You can

select a line color from the color
palette

Pie charts and 3D pie charts
You can create a Pie chart or 3D pie chart for an agent or topic. Depending on the type of reporting
you choose, the information varies.

Name Description
Pie chart or 3D pie chart for an agent
Call balance Indicates how many calls the agent received and what happened to the

calls. The Call balance counters are:

• totNAban<-

• totNConv<-

• totNPickup->
Pie chart or 3D pie chart for a topic
Success balance Indicates the number of calls received for the topic and the number that

resulted in a connection. The success balance counters are:

• totNLost

• totNSucc
Topic balance Indicates the number of calls received for the topic and what happened to

the calls. The topic balance consists of the following counters:

• totNRouted->

• totNConvExtDest

• totNConvAutoAg

• totNAban

• totNConvAg
Conversation balance Indicates the number of calls that led to a conversation and the wait time

for the calls. The conversation balance consists of the following counters:

• totNConvWait>M

• totNConvWait>n<=M

• totNConvWait<=N
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Tabs

Settings tab field descriptions
Name Description
Reporting name Displays the name of the report. You cannot change the

settings of the report.
Do you want the reporting to be
accessible by you exclusively or by all
users in the system?

Displays the type of reports. You cannot change the settings of
the report. The options are:

• Private

• Public
Select the type of a reporting Displays the type of reporting, depending on the element. The

options are:

• Agent

• Agent group

• Dialer

• IVR

• PBXs

• Skill combination

• System

• Team

• Telephone

• Topic

• Trunk line
Priority Displays the priority of the report. You can set the priority

between 1 and 9. The priority is appropriate for automatic
reporting.

Use only basic data/time range Indicates that there are no period definitions for the elements in
the report. The system uses the basic data period only for all
elements. The Using Avaya Agent for Chrome on IP Office
Contact Center displays reports only when you select this
option.

Period field descriptions
When selecting the new entries, you must ensure the following:

• The time intervals in the table must ascend.

Tabs
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• A new entry takes place behind the marked line.
• A time gap must be present, to add a new entry.
• The time intervals must not overlap.

Name Description
Use settings from
basic data

Displays the default time settings from the basic data. If you change the time
settings of the basic data, the time settings for the corresponding statistics also
changes.

Start

End

Displays a calender. You can set a day for the start and end of the time frame. You
can change the month with the arrow keys.

You can enter a start time and an end time to generate hourly statistics
automatically.

Restrict to You can limit the time frame to specific days of the week, and you can also limit the
time of day for report data sampling.

• Days: Displays the seven days of a week. You can select a day to generate a
report. The system displays the selected day as dimmed. If you select a day
marked with a red diagonal line, then you cannot generate a report on that specific
day.

• Time periods: Displays the configured times. The table displays a beginning and
end time with duration. You can edit the time. You can enter maximum one day
starting from 12.00 a.m. to 11:59 p.m. The entry of the time periods is preset and
cannot be deleted.

Use the following buttons to configure the Time periods:

Button Description
Inserts a new entry if the available rows are insufficient.

Deletes the selected entry.

Output tab field descriptions
Name Description
Use settings from basic
data

Displays a check box to use the default basic data settings.

Resolution of time axis Displays settings for the time-axis resolution The options are:

• Months

• Weeks

• Days

• Total period

• User defined

• Hours
Table continues…
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Name Description
• minutes

Table view
Broken down into:
Agent

Displays all reporting counters for Agent. The table is broken down into agents.

Broken down into:
Time

Displays the counters chronologically. The table is broken down into dates.

Technical total Displays the results of a counter. The conversations or established call counters
exceeding the calculation period are not filtered.

Logical total Displays values for mathematical calculation. If a conversation continued for two
calculation periods, this conversation counts for both calculation periods. In
contrast to the technical total, the logical total refers to the survey period.

Export
Export file Displays the name of the file entered. If an export file is not specified, then the

name of the macro file with an added number is used when a macro is used.
Name of export file with
date and time

Displays a check box to select a file with date and time. You can use the
following format to export a file:

Name_YYYY-MM-DD_hh-mm.Extension
Export folder Displays the file path of the folder to export or the default folder. The selected

folder is valid for all export files until you change the file path of the folder to
export again. The default folder is set during the installation.

Excel macro
Macro file

Macro name

Displays the macro file and macro name that you entered. You can use a macro
to export a file in MS Excel .

Output medium
• Excel

• CSV

• PDF

• RTF

Displays the output options for automatic reporting. You can select one or more
formats for the output medium.

Scheduler Displays the host name of your computer. The system enters the host name
automatically.

This PC Displays the host name of your computer. You must click the button to enter the
host name of your computer.

Additionally send as an Email.
To: Displays the recipient email address.
Subject: Displays the subject of the email. If you do not enter a subject, then the system

uses the statistic name.
SMPT server: Displays the name of the server.

Tabs
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Counters tab field descriptions
Name Description
Available
elements

Displays a list of available counters. The list displays the reporting counters in
following three tabs:

• Telephony

• Email

• Chat
Current elements Displays a list of selected available counters. The current elements display the

following two tabs:

• Counters: Displays the selected available counters.

• Task: Displays the task type
Add Adds an element from the list of available counters to the current counters.
Delete Deletes the element from the list of current counters.
Up Moves the selected counter in an upward direction.
Down Moves the selected counter in a downward direction.
View Displays the names or abbreviations of the reporting counters.

• A pound sign (#): Displays that the counter is broken down into topics.

• An asterisk (*): Displays that the counter is broken down into agent groups.

You cannot use reporting counters for each topic (#) or each agent group (*) in
graphical presentation.

Description Displays an exact description of the reporting counter and the counting method used.
Each counter consists of an abbreviation, a name, and an explanation.

Reporting type tab field descriptions
The reporting type tab displays the name of the report depending on the reporting type that you
choose. For example, if you select Agent as the reporting type, the name of the tab displays as
Agent.

Name Description
Available
elements

Displays a list of available elements.

Current elements Displays a list of selected available elements.
Add Adds an element from the list of available elements to the list of current elements. If

you select Agent as the reporting type, you can add either agents or agent groups.
Remove Removes an element from the list of current elements. If you select Agent as the

reporting type, you can remove either agents or agent groups.
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Generating and viewing reports

Creating new reports
Procedure

1. Do one of the following:

• In the Reporting-File view menu bar , click New report.

• In the Reporting files area, right-click a report and click New > File (public).

The system creates and displays a new report.

2. Type a name for the new report.

Generating reports
About this task
Reports recorded in the past are generated automatically. The number of display is restricted to
ensure that the output is manageable. The system displays a warning message if the number of
displays exceeds the number of display. To manage the output, reduce the reporting parameters,
that is, period, reporting counters, and objects. Use this procedure to generate a report that has not
yet finished recording or not yet begun to record.

Before you begin
• Ensure that the statistics generator must work.
• Log in as a service.

Procedure
1. In the Reporting files, right-click a report.

2. Click Generate.

The system displays a green icon in the list of files indicating that a report is generated. You
cannot use other functions.

3. To generate a report in the work area, do the following:

a. In the menu bar, click Work area.

b. In the Reporting display dialog box, click Generate.

The system generates a report.
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Viewing reports in full screen
About this task
If the reporting is extensive, you can view the report in full screen.

Procedure
1. In Reporting Files, click a report.

2. Click Full screen.

The system displays the report in full screen.

3. To return to the normal view, click Full screen again.

Editing reports
Procedure

1. In the Reporting files area, click a report.

2. Do one of the following:

• On the menu bar, click Edit.
• Right-click a report, and click Edit.

3. In the Basic data dialog box of the Inspector view, configure the basic data.

Automatic reporting
Automatic reporting is calculated at the time specified by you, with the specified cycle and type of
output. The evaluation of the report takes more time than expected because many parameters are
taken into account, for example large number of counters or extensive period. The automatic
evaluation of the report is defined as automatic reporting that is calculated even when you are not
logged in.

You can define the following settings for automatic reporting:

Name Description
Start date Displays the start date.
Start time Displays the start time.
Cycle Displays a monthly cycle and a user-defined cycle. You can set the days or hours

for the user-defined cycle.

The Statistics Scheduler works in an hourly cycle. However, statistics are generated in an unlimited
area.

With The Days and Hours fields you can configure the period for statistics. The default preset
values for manual statistics is 00:00 a.m. and 11:59 p.m., which cannot be changed. If the statistics
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to generate exceeds the default preset value, you must change the preset values. For example, if
you want to generate a statistic from 8:00 p.m. to 4:00 a.m., then you must change both values in
the input fields.

Example for Automatic Statistics
The following example displays an application for automatic statistics. Every hour statistics are
generated that display the values of the last hour. Use the Period tab in Basic data to configure the
times specifying when and in which cycle automatic statistics can be generated. The following
illustration displays an example of the settings:

Settings Time
Start time 7.00 a.m.
End time 8.00 a.m.
Cycle 1.00 hour
Limitations 7.00 a.m. to 12.00 p.m.

1.00 p.m. to 6.30 p.m.

The system generates the following statistics:
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Statistics Time generated Statistics period
1 8.00 a.m. 7.00 a.m. to 8.00 a.m.
2 9.00 a.m. 8.00 a.m. to 9.00 a.m.
3 10.00 a.m. 9.00 a.m. to 10.00 a.m.
4 11.00 a.m. 10.00 a.m. to 11.00 a.m.
5 12.00 p.m. 11.00 a.m. to 12.00 p.m.
6 2.00 p.m. 1.00 p.m. to 2.00 p.m.
7 3.00 p.m. 2.00 p.m. to 3.00 p.m.
8 4.00 p.m. 3.00 p.m. to 4.00 p.m.
9 5.00 p.m. 10.00 a.m. to 5.00 p.m.
10 6.00 p.m. 10.00 a.m. to 6.00 p.m.
11 7.00 p.m. 6.00 p.m. to 6.30 p.m.

Generating automatic reports
Before you begin
Start the Reporting Scheduler on your computer or another computer in the network.

Procedure
1. Create a report with the appropriate settings and the elements.

2. In Basic data, click the Period tab.

3. Select Automatic reporting.

4. Enter a date and time.

5. Click the Output tab.

6. In the Export file field, enter a file name.

7. In Output medium, select an output.

8. In the Scheduler field, enter the name of the computer on which the Reporting Scheduler
process is running.

9. To save settings, click OK.

The system generates a report automatically at the specified time. Automatic reporting is
located in C:\Documents and Settings\All Users\Application Data
\reporting data.
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Exporting reports
Before you begin
Create and generate a report.

Procedure
1. In the Reporting files area, click a report.

2. Do one of the following:

• On the menu bar, click Export.

• Right-click a report, click Export.

3. In the Export Reports dialog box, in the Export file field, enter a file name.

4. In Output medium, select one or more output media.

5. In Macro file, enter a file name, and in the Macro name field, enter a name.

6. Click OK.

The system exports the report in the selected formats and displays the Export successful
dialog box.

7. Click OK.

The system displays the files in the folder C:\Documents and Settings\ All Users
\Application Data\reporting data.

To open these files, you need the appropriate programs in the IP Office Contact Center
system.

Basic data configuration
You can use Basic data to create more than one table in a report with identical values. You need
not configure the values in each table individually because the system populates the Table
elements with the basic data.

Configuring the Settings tab
About this task
You cannot change the name of a report in the basic data.

Procedure
1. In the Inspector view, click Basic data

Basic data configuration
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2. In the Basic data dialog box, in Do you want the reporting to be accessible by you
exclusively or by all users in the system?, select Private or Public.

3. In the Select the type of reporting pop-up menu, click a reporting type.

4. In the Priority pop-up menu, choose between 1 and 9.

5. Select the Use only basic data/time range.

Configuring the Period tab
Procedure

1. In the Inspector view, click Basic data.

2. In the Basic data dialog box, click the Period tab.

3. Click a date in the following fields:

a. Start

b. End

The system displays the selected dates as dimmed ellipses. Use the arrow keys to can
change the month.

4. To limit generating reports on a specific day, in the Days field, click an appropriate day.

The system displays the selected day as dimmed and with a red diagonal line.

5. To configure Time periods, do the following:

a. To start recording, double-click an available field in Beginning and enter the time.

b. To stop recording, double-click an available field in Stop and enter the time.

The period cannot exceed 24 hours. You can make more than one entry to set time
limits. The system automatically enters the end time from the previous row. Use the
arrow keys to can change the time.

6. (Optional) To insert new rows, click the  icon.

7. (Optional) To delete a row, click the  icon.

Configuring the Output tab
About this task
In a graphical presentation, the horizontal axis represents the time axis and the vertical axis
represents the evaluated data. You can control the time axis with the settings in Resolution of time
axis. The system automatically controls the presentation on the vertical axis. Depending on the
resolution, the system labels the scale of the horizontal axis or divides the axis. You cannot label the
axis if the resolution of the horizontal axis is set to 24 hours. If your report includes a long survey
period, your results might be of little significance.
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Procedure
1. In the Inspector view, click Basic data.

2. In the Basic data dialog box, click the Output tab.

3. On Resolution of the time axis, choose a time frame.

You can choose between total period or the months, weeks, days, and the total user-defined
time broken down into hours and minutes. If you select the hours and minutes, the
calculation might take longer.

4. For a table display, in Table view, select one of the following:

• Agent: If you select Agent, select Technical total, Logical subtotal and Logical total.

• Time: If you select Time, select Technical total and Logical total.

5. To save the settings, click OK.

The system configures the Output tab.

Inserting and editing labeling elements

Inserting and editing basic data
Procedure

1. Click the Basic data element ( ) icon.

2. Press the mouse button, and drag the Basic data element to the reporting area.

3. To edit the properties, right-click Basic data and click Properties.

4. In the Properties dialog box, configure the properties.

5. Click OK.

Inserting and editing a logo
Procedure

1. Click the Logo element ( ) icon.

2. Press the mouse button, and drag the Logo element to the reporting area.

3. In Image selection, click Select.

4. Navigate to the image and click Open.

The system displays the file path of the selected graphic .
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5. (Optional) You can create a link to the logo on the General tab. You can then toggle to the
specified real time information or to another file in the reporting area.

6. Click OK.

7. To edit the properties, right-click Logo and click Properties.

8. In the Properties dialog box, configure the properties.

9. Click OK.

Inserting and editing a label
Procedure

1. Click the Label element ( ) icon.

2. Press the mouse button, and drag the Label element to the reporting area.

3. To edit the properties, right-click Label click Properties.

4. In the Properties dialog box, in the Presentation tab, do the following:

a. Select Font to change the font settings.

b. Select Background to change the background color.

5. Click OK.

Inserting and editing a dividing line
Procedure

1. Click Dividing line element ( ) icon.

2. Press the mouse button, and drag the Dividing line element to the reporting area.

3. To edit the properties, right-click Dividing line and click Properties.

4. In the Properties dialog box, in the Presentation tab, do the following:

a. Select Font to change the font settings.

b. Select Background to change the background color.

5. Click OK.

Inserting and editing Table
Procedure

1. Click the Table element icon .
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2. Use the mouse to drag and drop the Table element to the reporting area.

3. To edit the properties, right-click Table and click Properties.

4. In the Properties dialog box, configure the properties.

5. Click OK.

Inserting and editing Pie chart or 3D pie chart
Procedure

1. Click the Pie chart element icon  or the 3D pie chart element icon .

2. Use the mouse to drag and drop the Pie chart or 3D pie chart element to the reporting area.

3. To edit the properties, right-click the Pie chart or 3D pie chart and click Properties.

4. In the Properties dialog box, configure the properties.

5. Click OK.

Inserting and editing Line graph
Procedure

1. Click Line graph element ) icon.

2. Use the mouse to drag and drop the Line graph element to the reporting area.

3. To edit the properties, right-click Line graph and click Properties.

4. In the Properties dialog box, configure the properties.

5. Click OK.

Inserting and editing Bar chart
Procedure

1. Click the Bar chart element icon .

2. Use the mouse to drag and drop the Bar chart element to the reporting area.

3. To edit the properties, right-click Bar chart and click Properties.

4. In the Properties dialog box, configure the properties.

5. Click OK.
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Deleting an element
Procedure

1. Right-click an element in the reporting area.

2. Click Delete.

3. Click Yes.

The system deletes the selected element.
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Chapter 9: Agent Status Reports module
overview

Agent Status Reports is a statistical evaluation of agent activities that are not related to calls or
emails. You can use Agent Status Reports to track when and how often the agents sign on, sign off,
and take breaks. In counter-based reports, you can only evaluate the presence and break times.

You can use Agent Status Reports to display a table of presence and break times for one or all
agents. This feature is called agent reporting in the IP Office Contact Center system.

Related links
Opening the Agent Status Reports module on page 211
Creating agent status reports on page 211
Paging through Agent Status Reports on page 214

Opening the Agent Status Reports module
Procedure
Do one of the following:

• On the task bar, click Supervision and select the Agent Status Reports icon ( ).

• On the Go to menu, select Agent Status Reports.

The system displays the user interface of the Agent Status Reports module.

Related links
Agent Status Reports module overview on page 211

Creating agent status reports
About this task
To generate an agent status report, you must set the start date, end date, agent, and activities in the
Agent Status Reports module.
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Procedure
1. Click the calendar icon and click a date to change the dates in the following fields:

a. Start

b. Stop

2. In the Agents field, click an agent.

3. In the Activities field, click an activity.

4. Click Search.

The system gets the data from the database and displays a table with the Agent Status
Reports. Depending on the amount of data, the system might take a few minutes to generate
the report.

Related links
Agent Status Reports module overview on page 211
Agent Status Reports field descriptions on page 212
Records field descriptions on page 213

Agent Status Reports field descriptions
Name Description
Start Displays the start time for the Agent Status Report.
Stop Displays the stop time for the Agent Status Report.
Agent Displays the agent or agents to include in the agent status report. You can select

one agent or all agents.
Activity Displays the actions to select for the Agent Status Report.

The options are:

• all

• Login/logout

• Sign on/sign off

• Break Time

• Wrap up time without call

Related links
Creating agent status reports on page 211

Agent Status Reports module overview
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Records field descriptions
Name Description
Agent name Displays the name of the agent.
Time stamp Displays the time stamp with the date and time. The system records each agent

activity with a time stamp.
Login/logout Specifies whether the agent is logged in or logged out of the system regardless of the

task type. The options are:

• Login

• Logout
Sign on/sign off Specifies whether an agent is signed in or signed off of the system. The options are:

• Sign on

• Sign off
Break Time Specifies whether the agent is on a break. If the agent takes a break and signs off

from the system, the system displays the status as Pause on. If the agent signs on to
the system after the break, the system displays the status as Pause off.

Wrap Up without
call

Specifies the status of the wrap-up time. If an agent for the Telephony enters the
wrap-up time without an active call, the system displays the status as Wrap Up. When
the wrap-up time ends, the system displays the status as off. The wrap-up time can
be ended manually or by the system after 2 hours.

Additional info Displays additional information when an activity starts.

If the agent is logged off automatically, the Additional info field displays the following
information for the activities:

• Login/logout: Displays the device number that the agent uses to log in to the
system. This field does not display any information for other activities.

• Sign on/off: Displays the name of the agent group to which the agent has signed on
or from which the agent has signed out. This field does not display any information
for other activities.

• Break Time: Displays the break code. This field does not display any information for
other activities.

For example, if the agent logs off from the system automatically, the Additional info
field displays the login number, and agent group. For Wrap Up without call, the
Additional info field does not display any information.

Task type Displays the task type. The options are:

• Voice: Telephony tasks.

• Email: Email tasks.

Related links
Creating agent status reports on page 211
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Paging through Agent Status Reports
About this task
If the search results of an agent status report consist of more than 15 lines of information, you can
page through the information. The system displays the number of pages with the search results.

Procedure
1. To page through the search results, click one of the following:

• The next icon : To go to the next page.

• The previous icon : To go to the previous page.

• The last icon : To go the last page.

• The first icon : To go the first page.

2. To go to a particular page, enter the page number and click Go to.

The system displays the report in the selected page.

Related links
Agent Status Reports module overview on page 211

Agent Status Reports module overview
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Chapter 10: Contact Detail Reports module
overview

Contact Detail Reports module is a statistical evaluation that provides information about all task
types including calls and emails. This module provides information about callers, dialed topics,
conversation lengths, and agents involved in each task type, such as Telephony and Email.
Counter-based reports provide only summary values such as number of calls, number of
conversations, total conversation times, and average conversation times.

You can use the Contact Detail Reports module to create an advanced report of your customer
contacts:

Name Description
Invoicing for customers
(inbound)

Specifies that invoicing is based on services rendered and documents.

Reporting user
processes

• Displays how customers communicate with the IP Office Contact Center
system.

• Displays the topics and agents that are involved.

• Displays how long the customers communicate and with whom.
Detailed task type
processes

Displays the processes broken down by the task type for each IP Office Contact
Center agent.

Related links
Opening the Contact Detail Reports module on page 215
Creating Contact Detail Reports on page 216
Viewing the report details on page 219
Paging through Contact Detail Reports on page 222
Exporting Contact Detail Reports on page 223

Opening the Contact Detail Reports module
Procedure
Do one of the following:

• On the task bar, click Supervision and select the Contact Detail Reports icon .

February 2016 Using Avaya IP Office Contact Center for Windows 215
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


• On the Go to menu, select Contact Detail Reports.

The system displays the user interface of the Contact Detail Reports module.

Related links
Contact Detail Reports module overview on page 215

Creating Contact Detail Reports
Procedure

1. Click the calendar icon and click a date to change the dates in the following fields:

a. Start

b. Stop

2. In the Topic field, click a topic.

3. In the Task type field, select one of the following:

• All

• Telephone

• Email

• Chat

4. (Optional) In the Caller/Sender field, enter one of the following details:

• Caller

• Sender

5. (Optional) In the Selected address field, enter one of the following details:

• Dialed number

• Destination address

6. Click Search.

The system gets the data from the database and displays a table with the Agent Status
Reports. Depending on the amount of data, the system might take a few minutes to generate
the report.

Related links
Contact Detail Reports module overview on page 215
Contact Detail Reports field descriptions on page 217
Records field descriptions on page 217

Contact Detail Reports module overview
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Contact Detail Reports field descriptions
Name Description
Start Displays the start time for the Contact Detail Reports.
Stop Displays the stop time for the Contact Detail Reports.
Topic Displays the topic to include in the Contact Detail Reports. You can select one topic

or all topics.
Task Type Displays the task type for the Contact Detail Reports.

The options are:

• All: All task types.

• Telephone: Only telephone task types.

• Email: Only email task types.

• Chat: Only chat task types.
Caller/Sender Displays the telephone number for the Contact Detail Reports. You can use an

asterisk * as a placeholder. The system generates a list of callers and senders from
the database.

Selected address Displays the numbers or destination email addresses to include in the contact detail
reports.

Related links
Creating Contact Detail Reports on page 216

Records field descriptions
Name Description
Details Specifies that the connection level details are available for the contact.
Time stamp Displays the start time of the contact.
Task type Displays the task type.
Caller/Sender Displays the number or email address of the caller.
Selected address Displays the first number that the contact called.
Original topic Displays the name of the first topic during the call.
Connection status Displays the initial contact connection status with the following details:

• ConnectedDirect: Connected without a queue.

• ConnectedQueued: Connected with a queue without an announcement.

• ConnectedQueuedAnnounce: Connected with a queue and an announcement.

• DroppedOverload: Disconnected by the system due to overload.

• DroppedBusy: Disconnected by the system because the system is busy.
Table continues…
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Name Description
• DroppedCanceled: Disconnected by the system by the call flow.

• AbandonedAlerting: Disconnected by the caller during a call.

• AbandonedQueued: Disconnected by a caller in queue without an
announcement.

• AbandonedQueuedAnnouncement: Disconnected by a caller in queue with an
announcement.

Number of customer
records

Displays the number of customer records.

Number of customer
connections

Displays the number of customer connections.

Chargeable time Displays the total chargeable caller connection time by the agent for the contact.
Customer ring time Displays the total caller call time by the agent for the contact.
Customer
conversation time

Displays the total caller conversation time by the agent for the contact.

Customer time on
hold

Displays the total caller hold time by the agent for the contact.

Customer wait time Displays the total caller wait time by the agent for the contact.
Number of
consultations

Displays the number of attempted consultations by the agent for the contact.

Number of
consultation calls

Displays the number of consultations with a connection for the contact.

Consultation speech
time

Displays the total conversation time in consultation for the contact.

Total Wrap Up Displays the total wrap-up time for the entire contact.
Direct topic dial in Specifies whether the subscriber selects the topic. The options are:

• Yes

• No
External contact Specifies whether the contact is an external contact. The options are:

• Yes

• No
Inbound contact Specifies whether the contact is an inbound contact. The options are:

• Yes

• No
OutCC contact Specifies whether the contact is an outgoing call center call. The options are:

• Yes

• No
Table continues…
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Name Description
Dialer contact Specifies whether the contact is established using the dialer. The options are:

• Yes

• No
Voice mail is
recorded

Specifies whether the contact begins with recording a voice mail message. The
options are:

• Yes

• No
Network overflow Displays the total number of network overflows for the contact.

Related links
Creating Contact Detail Reports on page 216

Viewing the report details
About this task
You can view additional details for each contact list in the Contact Detail Report table.

Before you begin
Generate a contact detail report.

Procedure

In the Contact Detail Report table, click the Details icon .

The system displays the details for a contact in the table.

Related links
Contact Detail Reports module overview on page 215
Connections details field descriptions on page 219

Connections details field descriptions
Name Description
Details Specifies whether additional information is available. This field is blank if

additional topic or destination information is unavailable.
Time stamp Specifies the time at which the connection started.
Caller/Sender Specifies the number or email address of the caller. This field is blank if

information is unavailable.

Table continues…
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Name Description
Caller/Sender Name Specifies the caller name from the IP Office Contact Center customer

recognition. This field is blank if information is unavailable.
Customer number Specifies the customer number from the IP Office Contact Center

customer recognition. This field is blank if information is unavailable.
Customer priority Specifies the customer priority from the IP Office Contact Center

customer recognition. This field is blank if information is unavailable.
Selected address Specifies the number called for this connection even if the call was routed.
First topic Specifies the routing topic. If the system makes a consultation with a call

center topic, the transferred call also contains the name of the routing
topic.

Last topic Specifies the last topic used. For example, for topic overflow.
Task type Specifies the task type. The options are:

• Telephone

• Email
Connection status Specifies the initial contact connection status with the following details:

• ConnectedDirect: Connected without a queue.

• ConnectedQueued: Connected with a queue without an
announcement.

• ConnectedQueuedAnnounce: Connected with a queue and an
announcement.

• DroppedOverload: Disconnected by the system due to overload.

• DroppedBusy: Disconnected by the system because the system is
busy.

• DroppedCanceled: Disconnected by the system by the call flow.

• AbandonedAlerting: Disconnected by the caller during a call.

• AbandonedQueued: Disconnected by a caller in queue without an
announcement.

• AbandonedQueuedAnnouncement: Disconnected by a caller in
queue with an announcement.

Call time Specifies the total call times for all B-subscribers or the time that an email
remains unread.

Speech or active time Specifies the total conversation times of all B-subscribers for conferences
greater than the chargeable connection time or the email processing time.

Wait time Specifies the total wait time for all B-subscribers. The wait time is the time
between the start of the connection and contact with the agent. The total
includes all times in the queue and call times with the agent. The total
equals the total of all wait times for the associated agent records.

Time on hold Specifies the total hold time for all B-subscribers.

Table continues…
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Name Description
Chargeable time of
connection

Specifies the chargeable connection time, ISDN.

Wrap Up Specifies the total Wrap-Up times for all B-subscribers.
Consultation Specifies whether the contact was a consultation. The options are:

• Yes

• No
Routed Specifies whether the contact was an ACD call. The options are:

• Yes

• No
Voice mail is recorded Specifies whether a voice mail message was recorded. The options are:

• Yes

• No
Dialer contact Specifies whether the call was from the outbound dialer. The options are:

• Yes

• No
Network overflow Displays the number of network overflows in this connection.

Topic Information
Name Description
Time stamp Displays the time when the call was placed to the routing topic.
Topic Displays the routing topic. In case of a topic overflow, the topic can vary

from the dialed topic.
Destination name Displays the agent name or name of the external destination when the call

is routed to an agent. This field is blank if information is unavailable.
Wait time Displays the wait time in the topic queue.
Announcement Displays the wait time in the topic queue with DSPF, VEA, VU, and MHX

announcements.
Announcement script Displays the wait time in the topic queue with a VEA or DSPF

announcement.
VU script Displays the wait time in the topic queue with a VU announcement.
Welcome announcement Displays the wait time in the topic queue with a welcome announcement

such as VEA, DSPF, or VU.

Destination Information
Name Description
Time stamp Displays the time when the call was routed to the agent.

Table continues…
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Name Description
Destination name Displays the destination name. The options are:

• Agent

• External destination
Destination Displays the destination number. The options are:

• Agent

• External destination
Destination type Displays the destination type. The options are:

• Agent

• External destination
Agent group Displays the agent group used to route the call to the agent.
Topic Displays the name of the routing topic used to route the call to the agent.
Wait time Displays the total wait time of the caller until the call was connected to the

agent. The total includes all time in the queue and the call time. The
agent-specific wait time restarts from zero following a conversation with
an agent.

Ring time Displays the call time on the agent telephone for an active connection.
Speech-/active time Displays the conversation time of the agent in the active connection.
Time on hold Displays the hold time of the agent in the active connection.
Wrap Up Displays the wrap-up time of the agent in the active connections.
Job code Displays the job code. If the call has more than one job code, the system

saves only the last value.

Related links
Viewing the report details on page 219

Paging through Contact Detail Reports
About this task
If the search results of a Contact Detail Report consists of more than 15 lines of information, you
can page through the information. The system displays the number of pages with the search results.

Procedure
1. To page through the search results, click one of the following:

• The next icon : To go to the next page.

• The previous icon : To go to the previous page.

• The last icon : To go the last page.

Contact Detail Reports module overview
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• The first icon : To go the first page.

2. To go to a particular page, enter the page number and click Go to.

The system displays the report in the selected page.

Related links
Contact Detail Reports module overview on page 215

Exporting Contact Detail Reports
Before you begin
Generate a Microsoft® Excel file or a .csv file for the active Contact Detail Report data.

Procedure
Click one of the following:

• Create Excel.

• Create CSV.

The system generates a file with details such as the date and hour at which the report is created,
and copies this information to the following location:

C:\Documents and settings\All Users\Documents\reporting data.

Example
The following are examples of export files:

• CR-20090114–1005.xls
• CR-Details-20090115–0954.xls

Related links
Contact Detail Reports module overview on page 215

Exporting Contact Detail Reports
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Part 3: Administration
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Chapter 11: Interface configuration module

User Interface Configuration overview
You can use the User Interface Configuration module to configure the contact bar for a profile or an
agent. You can also assign the configured Home and Telephony real time view to a profile or an
agent.

Opening the User Interface Configuration module
Procedure
Do one of the following:

• On the Go to menu, click UI Config.

• In the left pane, click Administration, and then click the UI Config icon. .

The system displays the user interface of the User Interface Configuration module.

UI configuration user interface overview
The UI Config user interface has a left pane and a right pane. The folders in the left pane are:

Name Description
System Displays the configured systems.
Profile Displays a list of configured profiles.
Agent Displays a list of configured agents.

Opening the agent interface configuration
Procedure

1. On the UI Configuration tab, click Agent.

February 2016 Using Avaya IP Office Contact Center for Windows 225
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


2. From the list of configured agents in the right pane, double-click an agent name.

The system displays the UI configuration for agent dialog box.

You can change the configurations for the agent in the UI configuration for agent dialog box.

Updating the view
About this task
The system loads data only when you log in to the User Interface Configuration module. However, if
you make changes to a profile, the system does not display the changes. To see the changes, you
must refresh the page.

Procedure
1. On the UI Configuration tab, select Profile.

2. From the list of configured profiles, right-click a profile.

3. In the pop-up menu, click Refresh.

The system displays the profile with the recent changes.

UI configuration settings
You can set the following interfaces for a system, profile, or an agent:

• Contact bar

• Home

• Telephony

• Application

• Realtime information

• Web UI agent

• Web UI

You can set the Autostart RT Information interface only for a profile or an agent. When Autostart
RT Information interface configuration is unavailable for an agent, the system loads the real time
information interface of the profile. If the agent stores the window position of the monitor, the system
uses the window position of the agent or the profile.

You can configure an image in Configuration > General agent configuration tab. The image
displays an image for the agent. You can select an image in the .jpg, .bmp, .gif or .png format.
Note that large image files delays the display. You can configure the image to view the agent picture
in Avaya Agent for Chrome – IP Office Contact Center User Interface application.

Interface configuration module

February 2016 Using Avaya IP Office Contact Center for Windows 226
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Using Avaya IP Office Contact Center for Windows


UI configuration privileges
If you have the UI Configuration privilege, you can specify the settings in the UI Configuration tab.
However, to configure the interfaces on the UI Configuration tab, you must get the required
privilege for each interface. You can specify the settings in the UI Configuration tab if you get the
required privilege for each interface.

The interfaces and the privileges required for the interfaces are:

Tab Privilege Description
Contact bar Contact bar

configuration
You can configure the telephony elements on the Contact
bar tab. For example, you can configure the telephone
elements for an agent.

Home Home
configuration

You can configure the home real time view on the Home
tab. For example, you can configure the home real time
view for an agent.

Telephony Telephony
configuration

You can configure the telephony elements on the
Telephony tab.

Autostart RT
Information

UI configuration You can select the RT Information to autostart real time
monitoring after logging in to the system. For example, for
a supervisor you can set the RT Information to autostart
real time monitoring after logging in to the system.

Application UI config
Application

You can select an active view when you start an
application.

Realtime view Configuration grid
colors

You can define the colors for the grid elements on the
Realtime information tab.

Task bar flashing You can turn on or turn off the flashing of the task bar on
the real time view alarms. The system display displays a
change only when an agent logs in to the system again.

Web UI agent UI config Customer
data

You can configure the customer data up to 6 call details.
You can view the details of the customer in an incoming
call in Avaya Agent for Chrome – IP Office Contact Center
User Interface application.

UI config Web
access

You can configure websites to access web-based
information in Avaya Agent for Chrome – IP Office Contact
Center User Interface application.

Web UI UI config
Threshold

You can configure the threshold setting to affect the colors
used to display various elements in Avaya Agent for
Chrome – IP Office Contact Center User Interface
application.

UI config Variables You can configure variables that the Supervisors can
control in Avaya Agent for Chrome – IP Office Contact
Center User Interface application.

UI configuration privileges
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Configuring the contact bar
About this task
You can configure the contact bar for a system, profile, or agent.

Procedure
1. On the UI Configuration tab, select one of the following:

• System

• Profile

• Agent

2. From the list of configured systems, agents, or profiles in the right pane, double-click an item
in the list.

3. In the UI Configuration dialog box, in the Contact bar > Available elements field, select the
required elements and click Add.

The system adds the selected elements to the Selected elements field.

4. Click OK.

Configuring the Home module
Procedure

1. On the UI Configuration tab, select one of the following:

• System

• Profile

• Agent

2. From the list of configured systems, agents, or profiles in the right pane, double-click an item
in the list.

3. In the UI Configuration dialog box, click the Home tab.

4. In Current home area field, click the select ( ) icon.

The system displays the File Selection dialog box.

5. In the Home areas files field, select the real time view.

6. Click Select.

7. Click OK.

Interface configuration module
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Configuring the Telephony module
Procedure

1. On the UI Configuration tab, select one of the following:

• System
• Profile
• Agent

2. From the list of configured systems, agents, or profiles in the right pane, double-click an item
in the list.

3. In the UI Configuration dialog box, click the Telephony tab.

4. To select the current telephony module, do one of the following:

• Select the Default check box.
• In the Current Telephony field, click a quick bar file.
• Select the in the foreground with dialer calls check box.

5. (Optional) To select a quick bar file, in the Current Telephony field, click the select icon .

a. In the File Selection dialog box, click a quick bar file.
b. Click Select.

6. To select the current quick bar, do one of the following:

• Select the Default check box.
• In the Current quick bar field, click a telephony file.

7. (Optional) To select a telephony file, in the Current quick bar field, click the select icon .

a. In the File Selection dialog box, click a telephony file.
b. Click Select.

8. Click OK.

Adding Autostart RT Information
Procedure

1. On the UI Configuration tab, click one of the following:

• System
• Profile
• Agent

2. From the list of configured systems, agents, or profiles in the right pane, double-click an item
in the list.

Configuring the Telephony module
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3. In the UI Configuration dialog box, click the Autostart RT Information tab.

4. To add the autostart real time view, do one of the following:

• Select the Default check box.

• Clear the Default check box, and select a monitor file.

5. (Optional) To select a monitor file, click Add, and do the following:

a. In the File Selection dialog box, click a file.

b. Click Select.

6. Click OK.

Key and pie chart color
You can change the default colors and the key text color of certain real time views of system,
profiles, and agents. However, you cannot change the color of the Absent state.

Color change affects the following real time views:

• Pie chart

• Agent status for AG (grid)

• Agent status for team (grid)

• Workplace status

You can change the default colors of the following states:

Agent Status Background Text
Present

Break Time

Non ACD active

Free

ACD active

Changing the grid element color of system
Procedure

1. In the UI Configuration window, click System.

2. In the right pane, double-click Default interface.

3. In the UI configuration Default interface dialog box, click the Realtime information tab.

Interface configuration module
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4. To change the color in Color configuration for grid elements, click one of the following:

• Background.
• Text.

5. In the Select Colors dialog box, select a color, and click OK.

The system changes the color and displays a cross  next to the color box.

6. (Optional) To restore the default setting, click the cross icon .

7. Click OK.

Changing the grid element color of an agent
Procedure

1. In the UI Configuration window, click Agent.

2. In the right pane, double-click an agent in the list.

3. In the UI Configuration for Agent dialog box, click the Realtime information tab.

4. Clear the Default check box.

5. To change the color in Color configuration for grid elements, click one of the following:

• Background.
• Text.

6. In the Select Colors dialog box, select a color, and click OK.

The system changes the color and displays a cross  next to the color box.

7. (Optional) To restore the default setting, do one of the following:

• Click the cross icon .
• Select the Default check box.

8. Click OK.

Changing the grid element color of a profile
Procedure

1. In the UI Configuration window, click Profile.

2. In the right pane, double-click a profile in the list.

3. In the UI Configuration for profile dialog box, click the Realtime information tab.

4. Clear the Default check box.

Changing the grid element color of an agent
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5. To change the color in Color configuration for grid elements, click one of the following:

• Background.

• Text.

6. In the Select Colors dialog box, select a color, and click OK.

The system changes the color and displays a cross  next to the color box.

7. (Optional) To restore the default setting, do one of the following:

• Click the cross icon .

• Select the Default check box.

8. Click OK.

Configuring virtual agent groups
About this task
You can configure virtual agent groups in the Configuration module. You can also map agent groups
to a virtual agent group.

Before you begin
Log in to IP Office Contact Center User Interface for Windows with administrator privileges.

Procedure
1. On the Agent group tab, click Create virtual AG.

The system displays the Virtual agent group – Create dialog box.

2. In the Name field, type a name.

For example, ChromeAppAG.

3. Click OK.

The system adds the virtual agent group to the list of agent groups.

Next steps
Map agent groups to the virtual agent group.

Configuring customer details
About this task
The administrator can configure up to six information fields that you can see on incoming calls. You
can configure the customer data at the agent, system, or profile level. Use this procedure to
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configure customer data in IP Office Contact Center User Interface for Windows application and
view the customer details in Avaya Agent for Chrome – IP Office Contact Center User Interface
application.

Before you begin
Log in to the application with administrator privileges.

Procedure
1. In UI Configuration, click Agent.

2. In the right pane, double-click an agent in the list.

3. In UI Configuration for Agent, click Web UI agent.

4. Clear the Default check box.

5. In the Web UI agent menu bar, click Add.

6. In the Tag selection dialog box, click a tag as required.

7. Click OK.

8. Type a name for the selected tag.

9. (Optional) To rename the tag, click Rename.

10. (Optional) To delete a tag, click Remove.

11. Click OK.

12. Log in with agent credentials to Avaya Agent for Chrome – IP Office Contact Center User
Interface application.

The system displays the customer details added to the Call Details tab.

Configuring web access
About this task
Use this procedure to configure web access in IP Office Contact Center User Interface for Windows
application and use the web browser in Avaya Agent for Chrome – IP Office Contact Center User
Interface application. You can configure web access at the agent, system, or profile level. You can
configure up to three URLs.

Before you begin
Log in to the application with administrator privileges.

Procedure
1. In UI Configuration, click Agent.

2. In the right pane, double-click an agent in the list.

3. In UI Configuration for Agent, click Web UI agent.
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4. Clear the Default check box.

The list in the web access window is the default list set by the administrator at the system or
profile level. When you clear the default check box, the system deletes all the lists from the
Web Access window of that agent.

5. In the Web UI agent menu bar, click Add.

6. In the URL dialog box, do the following:

a. In the Address field, enter the URL of a website.

b. Select the option where you want to display this website.

c. Click OK.

7. Type a name for the website.

8. (Optional) To delete a website, click Remove.

9. (Optional) To rename the website, click Rename.

10. (Optional) To modify the URL address or the display of the website, click Edit.

11. Click OK.

12. Log in with agent credentials to Avaya Agent for Chrome – IP Office Contact Center User
Interface application.

The system displays the configured websites in the Call Details tab.

Configuring the threshold
About this task
You can configure the threshold at the agent, system, or profile level. You can define the following
values:

• Min
• Max
• Warning
• Alarm

Before you begin
Log in to the application with administrator privileges.

Procedure
1. In UI Configuration, click Agent.

2. In the right pane, double-click an agent in the list.

3. In UI Configuration for Agent, click Web UI.

4. Clear the Default check box.
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5. Click a real time value, and click Edit.

6. In the Threshold dialog box, configure the values.

7. Click OK.

The system displays the configured values.

8. To save the settings, click OK.

9. Log in with agent credentials to Avaya Agent for Chrome – IP Office Contact Center User
Interface application.

The system displays the configured threshold values in the Groups tab.

Configuring variables
About this task
If the Variable tag type is a number, you can assign a minimum and a maximum value. You can
configure the threshold at the agent, system, or profile level.

Before you begin
Log in to the application with administrator privileges.

Procedure
1. In UI Configuration, click Agent.

2. In the right pane, double-click an agent in the list.

3. In UI Configuration for Agent, click Web UI.

4. Clear the Default check box.

5. In the Variables menu bar, click Add.

6. In the Variables dialog box, click a variable.

7. Click OK.

8. Type a name for the variable.

9. (Optional) To delete a variable, click Remove.

10. (Optional) To rename the variable, click Rename.

11. To change the values, click Edit.
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Chapter 12: Additional administration
modules

Administration task bar
The Administration area lists the modules in the IP Office Contact Center system. You can select
and work with different modules.

Note:

You must have the necessary privileges to view and use the modules in the Administration
area. Each module has a number of privileges that defines the functions that you can use in the
module.

The Administration area displays the modules in the task bar with the following icons:

Icon Name Description
Configuration Configures all objects of the IP Office Contact Center

system and the system settings.
UI Configuration Configures the contact bar and selects a real time view

for the Home and Telephony modules.
Task Flow Editor Creates a task flow set. A task flow set is a graphical

representation of message distribution within the IP
Office Contact Center system.

IVR Editor Creates IVR scripts.

Dialer Works in the outbound area.

Email Configuration Configures email settings.

Textblock Administration Creates and updates the textblocks and templates that
the agents use in the Email module.

Address Book Administration Configures the address books.

Configuration module
The Configuration module is the central module for configuring objects in the IP Office Contact
Center system.
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You can also use the Configuration module to configure the system settings, change the
configurations, and delete objects in IP Office Contact Center.

Task Flow Editor module
The Task Flow Editor module controls the configuration of the routing of voice, email, and chat tasks
within the IP Office Contact Center system. A task flow set is a graphical representation of the
message distribution within IP Office Contact Center. The messages can be phone calls, voice
mails, or emails. The message distribution determines how IP Office Contact Center handles the
messages within the system, and the processes that the system starts. You can use the module to
create a task flow set. The Task Flow Editor module uses icons to display a task flow.

A task flow set has two groups:

• Macro

• Task flows

You must use a macro to use the same process in more than one task flow without creating the
sequence of processes again in each task flow. After creating a task flow, you can do the following:

• Start

• Set as the default

• Print

• Export

IVR Editor module
The IP Office solution includes voice control or Interactive Voice Response (IVR) to provide
customer services such as automatic announcements, Text To Speech(TTS), and speech
recognition. The IVR function includes the following:

• DTMF tone recognition for evaluating subscriber entries.

• Text to speech to enable the read out loud feature for text.

Microsoft TTS (Speech Platform 11) that is integrated into the system to enable TTS.

• Announcement creation with .WAV files or TTS. You can write TTS text in a script element, a
text file, or a CallTag.

• Voice mail recording and distribution. You can also forward the voice mails to an agent through
email.

• Read and write access to content stored in external databases.

• Script features, such as create scripts and add or edit elements.
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• Telephony functions with querying elements, such as call, refer back, and transfer.

In IP Office Contact Center, you can install the IVR editor module together with the UI. The IVR
Editor module is an optional application. You can use the Configuration module to configure the
Voice Control environment.

When using a Voice Control standalone system, you have to install the IVR Editor module on a
client application or the server. For a Voice Control standalone system, you can also configure the
IVR settings with the IVR Editor module.

You can use the Interactive Voice Response (IVR) Editor tool to create and edit the Voice Control
IVR scripts for IP Office Contact Center. You can access IVR Editor in the user interface of the
Administration menu.

IVR scripts contain the following information:

• Description of a requested process

• Specification of what to do with a connection

• Announcements played to callers

• Options for callers

• Specification of how to handle caller entries, such as voice mails and database entries

Dialer module
Outbound dialer is the IP Office Contact Center function that starts automatic outbound calls. In an
outbound call, an agent need not call a subscriber of the public network. For example, If you
conduct a phone survey within a company, then the survey can be an outbound function.

Depending on the dialer mode, the IP Office Contact Center outbound dialer does one of the
following tasks on connection:

• Starts the call from IP Office Contact Center, and then distributes the call to an available agent.

• Presents the call to an agent for preview, and then the agent starts the call.

In IP Office Contact Center, the basis of the call distribution process is jobs. The system starts a job
for a topic.

Similar to the inbound function the programmable call distribution, task flow set, controls the
outbound function. You can monitor the status of an outbound call, but you cannot change the call
distribution process.

Apart from increasing the productivity of the agents, the system uses the IP Office Contact Center
outbound functionality for the following:

• Informational campaigns

• Advertising campaigns

• Callback requests
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Error list module
The Error list module displays IP Office Contact Center system messages. Only system
administrator need the error list messages.

Related links
Opening the Error list module on page 239

Opening the Error list module
Before you begin
Get minimum one of the following privileges:

• Real time information
• Configuration
• Task Flow editor
• Dialer
• IVR editor
• Wallboard

Procedure
Do one of the following:

• On the task bar, below Administration, click Error list icon ( ).

• On the Go to menu, select Error list.

The system displays the error list with the following information:

• Date/Time: The date and time at which the event occurred.

• Code: A message code.

• Description: A description of the message code.

Note:

To interpret the messages, contact your system administrator.

Related links
Error list module on page 239

Email and chat configuration module
IP Office Contact Center agents and supervisors can communicate with their call center customers
using email and instant messaging (IM).

Error list module
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Important:

Email and IM are not currently supported in Avaya Agent for Chrome – IP Office Contact Center
User Interface.

Administrators must configure email and IM capabilities in the IP Office Contact Center interface.
You require multichannel agent licenses for the agents and agent groups that will be using the email
and IM features.

In IP Office Contact Center, you must do the following:

• Ensure appropriate access privileges are assigned to agents. These privileges determine the
types of email and chat features that agents can access.

• From the Configuration module, create email and chat topics.

• Create email and chat flows in Task Flow Editor.

• Add required email and chat scripts to topics.

For detailed instructions on email and chat configuration, see Avaya IP Office Contact Center Email
and Chat Services.

Related links
Creating keyword-based email routing task flow on page 240

Creating keyword-based email routing task flow
About this task
You can create a task flow that distributes emails based on the words in the email. You must
configure a script and create an email flow to create this task flow. The script can contain up to 10
keyword patterns with each containing 200 keywords. The system evaluates each keyword pattern
separately. The system executes the script checking the text of the email for designated keywords.
If the system finds a match, then the system sets the special task tag to true.

Before you begin
• Get the required privileges.
• Start the IP Office Contact Center user interface.
• Get the email keyword search privilege.

Procedure
1. To create a script, do the following:

a. On the Go to menu, click E-mail configuration.

b. Click the E-Mail textsearch tab.

c. Click Add.

d. In the Configuration name field, enter a name for the script.
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Note:

The script name can contain up to 29 alphanumeric characters.

e. To add a keyword pattern, click Add.

Note:

The patterns can include special characters.

The system displays the Edit configuration dialog box.

f. To edit a keyword pattern, click the Edit icon ( ).

The system displays the Keyword pattern dialog box.

g. In the Keyword field, enter the keyword.

h. Click Apply.

The system updates the selected keyword pattern.

i. Click Apply.

The system displays the script in the Configurations field.

j. Click Save.

2. To test the keyword pattern, do the following:

a. Select a script, and then click Edit icon ( ).

b. In the Edit configuration dialog box, click Test.

The system displays the Test configuration dialog box.

c. In the Enter text field, enter a text message.

d. Click Test.

If matches are found, the system displays the corresponding keyword pattern with Task
Tags. If no matches are found, the system displays the following message:

No match found!
e. Click Close.

f. Click Apply.

3. To create an email task flow, do the following actions:

a. On the Go to menu, click Task Flow Editor.

b. Click Edit > New > Email Flow.

The system displays the New E-mail flow dialog box.

c. Enter the required details and click OK.

d. On the List of symbols,no do the following:

a. Drag Destinations > E-mail script to the script, and select an email script.
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b. Drag Task conditions > Task Tag to the script, and select a task tag.

The system creates an email task flow with an email script and a task tag.

e. Click Task flow set > Save.

The system saves the email task flow.

f. Click Task flow set > Activate.

The system activates the email task flow.

Note:

The system sets the task tags UM_ScanResult to true or false. For example, the system
sets UM_ScanResult1. The system can evaluate these task tags in the taskflow. A
TaskTrap element after the email script element is unnecessary.

Related links
Email and chat configuration module on page 239

Textblock Administration module
The Textblock Administration module is a web user interface. You can use the Textblock
Administration module to create and update the text blocks that agents use in the email module.
You can also create an autoreply template and assign it to topics.

• Create, change, and delete textblocks.

• Create textblocks in international languages.

• Rename textblocks.

• Arrange the textblocks in a category.

• Format textblocks.

• Assign textblocks to topics.

• Create, change, and delete autoreply templates.

• Assign an autoreply template to a topic.

• Use placeholders in textblocks and autoreply templates.

Limitations
The limitations of the Textblock administration module are:

• Perform drag-and-drop operations.
• Integrate graphics in the textblocks or autoreply templates.
• Add attachments to the textblocks or autoreply templates.
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Address book administration module
An address book consists of customer details. You can configure an address book with details such
as the name, phone number, or fax number. In IP Office Contact Center, the email module
integrates with the address book functionality. The address book server provides the address books
that the system displays in the email module.

In the email module, an agent can use the address book that the address book server configures for
the agent. You can use the Address Book administrator module, which is a web user interface, to
change the configuration of the address book server.

• Add, change, and delete address books.

• Add, change, and delete address book profiles.

• Edit the settings of the address book server.

• View the import log.

You cannot use the drag-and-drop function in the Address Book administrator module.
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